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Introduction to the guide
This guide introduces you to QuickBooks—Intuit’s easy-to-use, powerful accounting 
systems for small businesses. The guide contains 16 lessons in addition to this chapter.

This guide is designed to teach you how to use many of the features available in 
QuickBooks Financial Software for Windows. The main focus of this guide is on how to 
use the features in QuickBooks Pro, but it also contains exercises for features available 
only in QuickBooks Premier and higher editions. This guide does not cover how to use 
the features in QuickBooks Online Edition, QuickBooks Simple Start, 
or QuickBooks Pro for Mac.

While this guide does not specifically address how to use QuickBooks Enterprise 
Solutions, many of the procedures described in the guide will work with Enterprise 
Solutions editions. If you restore the exercise file using a QuickBooks Enterprise 
Solutions Version 10 product, QuickBooks walks you through the file update process 
that is necessary for Enterprise Solutions to be able to read the file.

Most of the step-by-step instructions and screen captures in this guide were created with 
QuickBooks Pro and QuickBooks Premier 2011. Your screens may differ, and some 
instructions may vary slightly, if you are using a different edition.
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Objectives
After completing the QuickBooks Learning Guide, you should be able to:

 Create a new QuickBooks company.

 Modify the preset chart of accounts to suit your needs.

 Add information to company lists, or edit information in company lists.

 Open and use registers for any QuickBooks balance sheet accounts.

 Reconcile a QuickBooks checking account.

 Track credit card transactions.

 Invoice customers.

 Create sales orders.

 Generate customer statements.

 Receive payments from customers and make bank deposits.

 Write QuickBooks checks and assign amounts to specific expense accounts.

 Work with asset and liability accounts in QuickBooks.

 Enter bills into QuickBooks accounts payable.

 Pay bills.

 Create and customize QuickBooks reports and graphs.

 Save reports and forms as Portable Document Format (PDF) files.

 Export QuickBooks reports to Microsoft® Excel.

 Set up inventory and build finished goods.

 Convert units of measure.

 Track and pay sales tax.

 Understand QuickBooks payroll features.

 Create estimates and do progress invoicing.

 Track time and mileage.

 Pay nonemployees for time worked.

 Customize QuickBooks sales forms.

 Write letters in Microsoft® Word using QuickBooks data.
3



Toggling between QuickBooks editions

We’ve provided you with this edition of the software because QuickBooks: Premier 
Accountant Edition gives you the ability to toggle among different QuickBooks 
editions. QuickBooks Premier Accountant edition allows you to switch to each of the 
QuickBooks Premier industry-specific editions—as well as to QuickBooks Pro. This may 
be useful to teach students about features available to support different industries, such 
as construction, non-profit, or retail.

Toggling between QuickBooks editions offers the following benefits:

 If you are teaching a class for a specific audience (such as non-profits or contractors), 
you can toggle to that edition and use the appropriate edition for the students.

 When working with students or clients, toggling can help you evaluate which 
edition is right for them.

You can toggle to any of the QuickBooks: Premier industry-specific editions as well as 
QuickBooks: Pro. You don’t need to be logged in as Administrator, nor does QuickBooks 
need to be in single-user mode.

Note: QuickBooks does not support integrated applications while in toggle mode. Close 
any applications that share data with QuickBooks before toggling.

To switch to a different edition:
1 From the File menu, choose Toggle to Another Edition.

2 When prompted, choose the edition of QuickBooks you want to use. Then click 
Next.
4



                                                                                                
3 Confirm the edition of QuickBooks to switch to and click Toggle.

4 Read any messages and click OK. 

QuickBooks will notify you if there are changes in feature availability in a different 
edition.

QuickBooks now closes and reopens as the edition you selected. Once reopened, the 
application title bar shows that you are running QuickBooks Accountant Edition 
configured as the current open edition, for example: “QuickBooks Premier: 
Professional Services (via Accountant Edition).”

5 When you are done, go to the File menu and choose Toggle to Another Edition to 
return to QuickBooks Premier Accountant Edition. 

Integrating QuickBooks with other 
products
The following are required if you plan to use the integration features available in 
QuickBooks.

 Microsoft® Word 2000, 2002, 2003, 2007, or 2010 if you plan to use the QuickBooks 
Letters and Envelopes feature.

 Microsoft® Excel 2000, 2002, 2003, 2007, or 2010 if you plan to use the features in  
QuickBooks that integrate with Microsoft Excel.

Intuit Statement Writer (not used in this class) integrates QuickBooks Accountant 
Edition with Microsoft Outlook 2003, and 2007.

 Microsoft® Outlook 2000, 2002, 2003, 2007, or 2010 if you want to synchronize 
with contact management software. Contact synchronization with Outlook 
requires QuickBooks Contact Sync for Outlook (can be downloaded for free from 
http://support.quickbooks.intuit.com/support/tools/contact_sync/).
5



Using QuickBooks Pro Student Trial 
Edition

QuickBooks Pro Student Trial Edition is provided for use by your students.

QuickBooks Pro Student Trial Edition is a full-featured version of QuickBooks that is 
included with this guide. You can install it on your computer and use it to complete the 
exercises in this guide and to practice using QuickBooks. 

To install QuickBooks Pro Student Trial Edition, insert the software into your computer 
and follow the on-screen instructions. You will be required to register this copy of 
QuickBooks using the Product Number and License Number printed on the yellow 
sticker that is adhered to the software sleeve.

You can use this product for 140 days after installation.

About the exercise file
An exercise file is included with this training guide. Install the file on the CD-ROM to 
your computer’s hard disk as described below. You’ll use a copy of this file to complete 
the lessons in this guide. We recommend that you make a copy of the exercise file and 
store it in a safe place in case the original becomes damaged.

Using the exercise file in each lesson

For each lesson in this guide, except for lessons 1 and 2, you’ll restore a copy of the 
exercise file qblesson.qbb, and use that file to complete the lesson. The qblesson.qbb 
file you copy into the QBtrain directory on your hard disk is a QuickBooks backup copy. 
This means that at the start of each lesson, you’ll be restoring a new qblesson file. 
Instructions on how to restore the file are given at the beginning of each lesson.

Installing the exercise file

To install the exercise file on your hard disk:
1 Insert the CD-ROM in the CD-ROM drive.

2 From the Windows Start menu, choose Run.

3 Type Explorer, and then click OK.

4 From Windows Explorer, select your hard disk (usually c:).

5 From the File menu, choose New, and then choose Folder.

6 Type QBtrain, and then press Enter.

7 Select your CD-ROM drive containing the exercise file (usually d: or e:).

8 Select qblesson.qbb.

9 Drag qblesson.qbb to the QBtrain folder on your hard disk.

10 Remove the CD-ROM from your CD-ROM drive.

Your exercise file is now installed in the QBtrain folder on your hard drive.
6



                                                                                                
Exercise transaction dates

The exercise file for use with this training guide was created in QuickBooks Pro and 
QuickBooks Premier 2011 with the date set to 12/15/2015. When you open the exercise 
file in QuickBooks, QuickBooks automatically sets the sample data file date to 
12/15/2015. When you close the exercise file, use your own QuickBooks company file, 
or exit QuickBooks, your system and QuickBooks dates will return to the current date.

QuickStart Tips
Many of the lessons in the QuickBooks Learning Guide include sections called QuickStart 
Tips. QuickStart Tips provide information that you may find helpful when you finish 
this self-study course and are ready to set up your own company data file in QuickBooks.

Teaching methodology and methods

This course is divided into 16 lessons and combines lectures with hands-on student 
participation. We encourage you to pick and choose lessons to fit the needs of your 
students, or to fit your own teaching objectives.

Each lesson begins with a list of student objectives, supporting materials available, and 
instructor preparation. Appendix A includes a brief demonstration of QuickBooks to be 
presented by the instructor. The demo introduces students to QuickBooks and provides 
them with a road map of what they will learn in the course.

Some lessons in this course include one or more handouts. We encourage you to use the 
handouts provided with a lesson; they summarize or illustrate the main points of your 
lecture, and are helpful for students to refer to later. If you choose not to distribute a 
copy of each handout to all your students, you can display the handouts on an overhead 
projector as you explain the basic concepts.

A copy of each handout is included in Appendix B of this guide. In addition, we’ve made 
the handouts available for download in Portable Document Format (PDF) from the 
Instructor’s Resource Center web site, which allows you to print the handouts as desired.

QuickBooks contains a number of interactive video tutorials that you may want to use 
to introduce or expand upon the content provided in the exercises. You access the video 
tutorials by choosing Learning Center Tutorials from the QuickBooks Help menu. To 
help you with your lesson plans, the running time for each video is listed next to the 
video title. The titles for videos related to each lesson are included at the beginning of 
each lesson.

Note: If you’ll have several students playing the videos on multiple computers 
simultaneously, you can have them mute the sound on their computers and use the 
audio transcript option available with each tutorial. This option allows them to read the 
transcript for the video on screen.
7



To maximize hands-on practice with QuickBooks, a computer lab with one computer 
per student is ideal. If this is unavailable, you can teach the course with up to three 
students sharing a computer. However, sharing computers lengthens the course and 
reduces the effectiveness of student learning.

Each lesson contains special notes that help you present the material. These notes are 
printed in italics and appear at key places in the lessons.

On the Instructor’s Resource Center  web site, you’ll find Microsoft® PowerPoint 
presentations available for your use in the classroom lecture. 

Instructor preparation

If you are new to the latest version of QuickBooks and want to see a list of new features, 
go to the QuickBooks Learning Center (from the Help menu, choose Learning Center 
Tutorials), then click the “What’s New” tab. Another way to get information about 
what’s new in this version is to visit www.quickbooks.com, which describes the new 
features in each edition. 

To gain a quick overview of what will be presented in the course, you may want to run 
through the QuickBooks demonstration in Appendix A.

An important supplement to this instructor’s manual is the QuickBooks Installation and 

Setup Guide, which provides information about technical requirements and installation. 
We suggest you have the guide available for reference during the course.

Student prerequisites

No knowledge of finances or accounting is needed to use QuickBooks. Students should, 
however, have a basic knowledge of the computer operating system and know how to 
move files around, create folders or directories, copy files to and from disks, and run 
applications.
8
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L E S S O N  1
Lesson objectives
 To gain an overview of the course and the topics to be covered

 To know how QuickBooks works and how you can get around in QuickBooks

 To learn common business terms used by QuickBooks

 To practice using the QuickBooks Help tools

 To see how to exit QuickBooks
11



G e t t i n g  s t a r t e d
Lesson objectives
 To gain an overview of the course and the topics to be covered

 To know how QuickBooks works and how you can get around in QuickBooks

 To learn common business terms used by QuickBooks

 To practice using the QuickBooks Help tools

 To see how to exit QuickBooks

Supporting materials
 PowerPoint file: Lesson 1

 Video tutorial: Getting around in QuickBooks

 Video tutorial: What QuickBooks can do for you

 Video tutorial: Introducing the Customer Center

 Video tutorial: Introducing the Vendor Center

Instructor preparation
 Make sure you’ve read the sections called “Teaching methodology and methods” 

and “Instructor preparation” in the introduction to this guide.

 Install QuickBooks on your computer’s hard disk.

 Copy the qblesson.qbb file from the QuickBooks in the Classroom CD-ROM onto 
your computer’s hard disk. (See “Installing the exercise file” on page 6.)

 Run through the content in the instructor demonstration available in Appendix A 
to make sure you’re familiar with the material.

Course introduction

This course is an introduction to QuickBooks. Its main objective is to introduce you to 
the basic features in QuickBooks and give you an opportunity for hands-on practice. 
You’ll learn about the types of information you need to track in your business, and 
you’ll see how to enter that information and track it in QuickBooks. By the time you 
complete the course, you’ll have a good idea of all that QuickBooks offers, you’ll be 
familiar with the most common tasks, and you’ll know where to find information about 
more advanced features.

Depending on the size of your class, you may want to spend a little time inquiring about 
your students’ backgrounds—whether they own a business or are the bookkeeper for a 
small business, for example, or whether any of them have experience with accounting. 
This information can help you gear the course towards your students’ particular needs.
12



                                                                                                
L E S S O N  1
Introducing QuickBooks

Before you begin your demonstration of QuickBooks (see Appendix A), students may 
find it helpful to hear an introduction to the basic features in QuickBooks.

Although most small business owners are worried about revenue, running a business 
involves a lot of other tasks. Depending on the type of business, you need to invoice 
customers, record payments from customers, pay your own bills to outside vendors, 
manage inventory, and analyze your financial data to see where you need to focus your 
next efforts. QuickBooks is a tool you can use to automate the tasks you’re already 
performing as a business owner or to set up a new business.

Tell your students that they will see a demonstration of how QuickBooks works in a few 
minutes so they can get an overall view of the program. But first, here’s an overview of 
some of the basic features they’ll be seeing in the demo.

When you’re working in QuickBooks, you’ll spend most of your time using a form, a list, 
or a register. Since these are so basic to QuickBooks, we’re going to spend a few minutes 
introducing them.
13



G e t t i n g  s t a r t e d
Using forms

You record most of your daily business transactions on a QuickBooks form, which looks 
just like a paper form. Here’s an example of the form you use when you want to record 
a bill from and write a check to one of your vendors.

The form is intuitive—you already know how to fill out a form. But after you provide the 
information on a QuickBooks form, QuickBooks does the accounting for you in the 
background. For example, when you record a bill and then write a check (using the Pay 
Bills window) to pay for the business expense, QuickBooks enters transactions in your 
accounts payable register to show the expense you incurred and the payment you made. 
(Accounts payable is the money owed by your business to vendors.) It also records the 
check in your checking account, keeping your records up to date, and providing a 
running balance of what you owe at any time.

The History section on the right side of the form gives you a summary of recent activity 
related to this customer or vendor. This gives you insight into all your business dealings 
with this customer or vendor. You can use this information to make sure that you are 
devoting your attention to your most valuable customers and to help you negotiate 
better terms with your largest vendors. You can click the arrow next to the name to close 
the History section of the window.

Account Title Debit Credit

Accounts Payable $175

Checking $175
14



                                                                                                
L E S S O N  1
Using lists

The list is another basic QuickBooks feature. You fill out most QuickBooks forms by 
selecting entries from a list.

You may want to point out that in the Enter Bills window above, the information in the 
Vendor, Terms, Account, and Customer:Job fields is pulled from lists.

QuickBooks has lists where you can store information about customers, vendors, 
employees, items or services you sell, and so on. Lists save you time and help you enter 
information consistently and correctly.

When you’re filling out an invoice form and you select a customer name from the 
Customer:Job list, QuickBooks not only fills in the name but also fills in the address, the 
payment terms, and the customer’s sales tax, based on the information previously 
entered about that customer.

Here’s an example of the Customers & Jobs list in the Customer Center. 

QuickBooks lets you complete a variety of activities from lists by using the menu 
buttons located at the top of each list. For example, to fill out an invoice for a customer, 
first select the customer from the Customers & Jobs list, and then choose Invoices from 
the New Transactions menu button.
15



G e t t i n g  s t a r t e d
Using registers

In addition to forms and lists, you’ll also work with registers in QuickBooks. Just as you 
use your paper checkbook register to see a record of all the transactions in your checking 
account—checks you’ve written, other withdrawals you’ve made from your account, 
and deposits—a QuickBooks register contains a record of all the activity in one account. 
Almost every QuickBooks account has its own register.

You may want to explain to students that accounts receivable is the record of money 
owed to a business, that is, the outstanding invoices for which a business has not 
received payment.

Here’s an example of the register for an accounts receivable account.

The register shows information about invoices written to customers—the date of the 
invoice, the date it’s due, the name of the customer, and the amount. It also shows 
payments you’ve received against your invoices. The right column of the register gives 
you a running balance of all your accounts receivable, so you always know how much 
you’re owed.

Getting around in QuickBooks

QuickBooks maximizes your work space and gives you quick access to the features and 
reports that you use most. In this section you’ll learn how to do the following:

 Find information to help you get started using QuickBooks

 Manage your open windows

 Compare windows side by side

 Customize navigation features

 Use Customer, Vendor, and Employee Centers

 Use the Company Snapshot to see how your company is doing
16



                                                                                                
L E S S O N  1
Finding information to help you get started

If you’re new to QuickBooks, the QuickBooks Learning Center window displays when 
you open a company file. This window guides you through the steps you need to 
complete after you’ve set up your company file. To display the QuickBooks Learning 
Center window, choose Learning Center Tutorials from the Help menu. For more 
information about using Help, see “Using onscreen Help” on page 36.

If you’re upgrading from a previous version, QuickBooks displays the What’s New 
window. This window contains information about new features and explains how to 
find what you need to start working with the latest version.

Managing your open windows

To give you more room to work on the task at hand, QuickBooks displays one window 
at a time. When you open a window, it appears in front of other windows that you 
previously opened.

The Open Window list keeps track of the windows that are open. Use the Open Window 
list to switch between windows while you work. To switch to another open window, 
just click the title of the window that you want to display.

To show or hide the Open Window list:
 From the View menu, choose Open Window List.

If the list is currently displayed, a checkmark appears to the left of the menu item.

For comparison purposes, you may wish to display more than one window at a time. 
You can easily switch between viewing one window at a time and viewing multiple 
windows. When you choose Multiple Windows from the View menu, QuickBooks 
displays the windows in the main area. You can then move and resize the windows as 
needed.

To view multiple windows:
 From the View menu, choose Multiple Windows.

If the list is currently selected, a checkmark appears to the left of the menu item.
17



G e t t i n g  s t a r t e d
Using the menu bar

You can find all of the QuickBooks commands on the menu bar.

Many commands available on the menu bar can be added to the icon bar.

You can go to the Favorites menu and choose Customize Favorites to select your most 
frequently used menu commands and then access them from a single list in the 
Favorites menu.

Using the icon bar

Another feature that makes it easy to get around in QuickBooks is the icon bar. The icon 
bar gives you easy access to QuickBooks Centers and onscreen Help. The icon bar also 
comes preset with shortcuts to several windows, such as Create Invoices and Enter Bills. 

By including the features and reports you use most, you can manage your business more 
quickly than ever.

In addition to deciding which features to add to the icon bar, you can add or remove 
icons, change the order in which the icons display, insert spaces between icons, and edit 
icons by changing the icon text, graphic, or tooltip.

For instructions on how to customize the icon bar, search the onscreen Help for 
icon bar, and then choose “Using the Icon Bar” from the list of topics that displays.

Using QuickBooks Connected Services

The Icon bar includes links to several optional connected services that you can 
subscribe to help you in your business. (Internet access is required. Additional fees, 
terms, and conditions apply.) The connected services available include:

 Doc Center is a service you can use to stay organized by attaching PDFs, scanned 
receipts and other documents to your QuickBooks entries. The attached documents 
are available by clicking the paperclip icon at the top of the corresponding 
QuickBooks form.

 Statement Writer combines the best of QuickBooks with the best of Excel to give 
you financial statements faster than ever before with zero data translation errors. 
Requires Microsoft Office 2003 or 2007. Does not work with Microsoft Office 
Student Edition, or Standard Edition.

 Client Review (Accountant Edition only) allows you to work in a client’s company 
file and check it for problems.
18



                                                                                                
L E S S O N  1
 Intuit Workplace App Center provides a centralized location where you can see 
additional applications available from Intuit to help you manage your company.

 Accountant's Copy File Transfer (Accountant Edition only) to use Intuit's secure 
servers to exchange your Accountant's Copy company files.

 QuickBooks Data Connect to access basic QuickBooks customer and transaction 
data online from your PC, iPhone, or BlackBerry. 

 Intuit Data Protect makes it easy for you to back up company data, or your entire PC, 
online.

Using QuickBooks Centers

QuickBooks Centers give you quick access to common tasks. Each Center gathers in a 
single place all of the relevant transactions as well as other information, such as names 
and addresses of customers, vendors, or employees.

The Customer, Vendor, and Employee Centers have two tabs (the Employee Center also 
contains the Payroll Center in a separate tab if your company has payroll turned on). 

The first tab contains the list of your Customers, Vendors, or Employees. Use this tab to 
view and edit information for a single customer, vendor, or employee.

The Transactions tab lists the relevant transaction types for that Center. Use this tab to 
view transactions across all Customers, Vendors, or Employees.
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You can customize how your information is displayed in the Customer, Vendor, or 
Employee Center. For example, you might choose to view only open invoices for this 
fiscal year, or you may want to view only the Open Balance column for all of your 
customers.

 The Customer Center gives you access to all of your customers and jobs, contact and 
billing information for each customer, and customer transactions. Here you can 
quickly find and print customer contact information, what your customers bought 
in the past, what invoices they've paid, the balance they owe, notes you want to 
keep about a customer, and more. You can also access transactions for all your 
customers in one place, such as sales receipts, received payments, and statement 
charges.
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 The Vendor Center gives you quick access to all of your vendors, their contact and 
billing information, and vendor transactions. The Vendor Center displays 
information about all of your vendors and their transactions in a single place. Here 
you can add a new vendor, add a transaction to an existing vendor, or print the 
vendor list or transaction list. You can also edit a vendor's information or edit a note 
for the vendor. 
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 The Employee Center gathers information for each of your employees, including 
contact information, social security number, and payroll transactions. Here you 
can add a new employee, add a transaction to an existing employee, or print 
employee and transaction information. You can also edit an employee's 
information or edit a note for the employee. If you have a QuickBooks Payroll 
subscription, you can perform payroll-related tasks such as paying your employees 
and payroll tax liabilities. The Employee Center also contains a separate Payroll 
Center where you can manage your payroll and tax information.
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 Online Banking Center provides a location where you can see a summary of your 
online banking transactions and send and receive payments between QuickBooks 
and your accounts.

 Report Center provides a centralized location to view and run reports. You can also 
run some common reports from the Customer, Vendor, and Employee Centers. 
Lesson 9 describes the Report Center.

Locating information with QuickBooks Search

There are several ways to locate information in QuickBooks. You can:

 Go to the Edit menu and choose Find to locate a transaction that matches specific 
filters that you enter. This is useful if you know some information about what you 
are looking for. For example, if you want to verify the amount of a check that you 
entered previously. For information, see “Locating specific transactions” on 
page 133.

 Click the Find button at the top of a transaction, such as a purchase order or bill to 
locate a transaction of that type.

 Use the Find field in the Vendor Center or Customer Center to locate a person of 
that type.

 Use QuickBooks Search to locate information that is entered anywhere in your 
company file. This is similar to performing an internet browser search. It may return 
more results than the find command, and is useful if you do not know exactly what 
you are looking for or how it is classified.
23



G e t t i n g  s t a r t e d
To use QuickBooks Search:
1 Click the Search button on the Icon bar or go to the Edit menu and choose Search.

For this example, you are looking for a plumber in Bayshore that you have worked 
with before, but you cannot remember whether you worked with them as a vendor 
or a customer or both.

2 Type plumbing Bayshore and click Search.

3 Review the list of search results. You have used Lew Plumbing as both a customer 
and a vendor.
24



                                                                                                
L E S S O N  1
4 Click Advanced Search.

5 Review the filters available. When you check a box, Search looks for the search term 
in that type of information. The results of a search will appear more quickly if you 
select fewer information types.

6 Click Settings.

7 In the Settings window, review the information about how often QuickBooks 
creates an internal index of information that it will search. 
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8 Click Cancel to close the Preferences screen. You can view or change this 
information any time by going to the Edit menu, choosing Preferences, and then 
clicking Search.

9 Hold your mouse over the first entry for Lew Plumbing (Customer) in the list. 
Notice that the icons for Open, Edit, and Create Invoice appear. 

10 Hold your mouse over the second entry for Lew Plumbing (Vendor) in the list. 
Notice that the icons available are now Open, Edit, and Enter Bills.

11 Close the Search window.

Making the Home page your starting point

The QuickBooks Home page provides a big picture of how your essential business tasks 
fit together. Tasks are organized into logical groups (Customers, Vendors, Employees, 
Company, and Banking) with workflow arrows to help you learn how tasks relate to 
each other and to help you decide what to do next.

The workflow arrows indicate a logical progression of business tasks in QuickBooks. 
However, these arrows do not restrict you from doing tasks in a different order, or an 
order that works better for your business needs.

As you use QuickBooks, you can always return to the Home page by clicking Home. The 
Home page looks like the following. (The icons that appear on the Home page vary 
depending on how your company was set up in the EasyStep Interview or which 
preferences are set in the file.)
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Using the workflow diagram

To start a task, click the icon for the task you want to do. For example, to create an 
invoice, click the Create Invoices icon. Each icon includes a ToolTip so you can learn 
about the QuickBooks task associated with that icon. To open a ToolTip, place your 
mouse pointer over the icon.

Clicking most of the icons on the Home page takes you directly to the window for that 
task. Some icons also include a drop-down arrow. Clicking an arrow opens a menu with 
choices for different business tasks. Click the task you want to do.

Making the Home page work for you

In addition to the workflow diagram, the Home page provides other company 
information and access to other tasks in the right-hand pane. From the right-hand 
pane, you can:

 Get more information about getting started using QuickBooks.

The Getting Started section provides a link to the Quick Start Center where you can 
learn about important features of QuickBooks and a link to the Get Started Right 
website where you can learn from a QuickBooks expert. For information, see “Using 
the Getting Started Center” on page 38.

 Review the current balances of your bank accounts.

The Account Balances list provides quick access to all of your bank and credit card 
accounts. To open the register for an account, double-click anywhere in the row of 
the account you want to view. To hide the list of accounts and balances, click the 
close button in the top-left corner of the Account Balances list.

Account Balances are shown or hidden automatically based on individual user 
permissions.

 Learn about and purchase additional services.

You can click a link in the “Learn About Services” section to learn about add-on 
services you can purchase from Intuit by going to the Business Services page. If you 
choose to sign-up for these services, appropriate icons will be added to the workflow 
on your Home page.

 Review information about your latest backup of your QuickBooks information.

 View reminders and important messages.

The Reminders & Alerts list provides information about tasks awaiting your action. 
To hide the list, click the close button in the top-left corner of the list.
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Getting an overview of how your company is doing

At any time, you can see a graphic representation of the overall financial status of your 
company in the Company Snapshot screen. The information is organized into tabs 
summarizing information about your Company, Payments, and Customers.

To view your company snapshot:
1 Click the Company Snapshot icon in the icon bar.

2 Review the information in the Company Snapshot.

You can customize the information that appears on this screen by clicking Add 
Content or deleting one of the default graphics.
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3 Click Payments and review information about money you owe and money that you 
are owed.
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4 Click Customer to see a summary of information about each customer. You can use 
this to make sure that you are focusing your business efforts on your most 
important customers. To see information about a different customer, choose a 
name from the Customer menu near the top of the Customer Snapshot tab.

5 When you are done, close the window.

All the accounting you need to know

QuickBooks doesn’t require users to learn or understand accounting jargon. However, 
it does use some common business terms.

Your chart of accounts

When you keep books for a company, you want to track where your income comes 
from, where you put it, what your expenses are for, and what you use to pay them. You 
track this flow of money through a list of accounts called the chart of accounts. 

There are two types of accounts: 

 Balance sheet accounts, such as checking and savings

 Accounts used to group transactions for reporting purposes, such as income and 
expense accounts
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The chart of accounts is a complete list of your business’ accounts and their balances.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction Company.

2 Scroll through the Rock Castle Construction chart of accounts. Notice that the list 
displays balance sheet accounts first, followed by income accounts and expense 
accounts.

About assets, liabilities, and equity

Assets

Assets include both what you have and what other people owe you. The money people 
owe you is called your accounts receivable, or A/R for short. QuickBooks uses an 
accounts receivable account to track the money owed you.

The rest of your company’s assets may include checking accounts, savings accounts, 
petty cash, fixed assets (such as equipment or trucks), inventory, and undeposited funds 
(money you’ve received from customers but haven’t yet deposited in the bank).

When setting up your company file in QuickBooks, please note that even though 
checking, savings, and petty cash are all company assets, you’ll set them up as “bank” 
type accounts in QuickBooks.

Liabilities

Liabilities are what your company owes to other people. The money you owe for unpaid 
bills is your accounts payable, or A/P for short. QuickBooks uses an accounts payable 
account to track the money you owe different people for bills.

A liability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to the 
government. When setting up your company file in QuickBooks, note that even though 
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unpaid bills are liabilities, you’ll set them up as accounts payable type accounts in 
QuickBooks.

Equity

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities):

Equity = Assets – Liabilities

If you sold all your assets today, and you paid off your liabilities using the money 
received from the sale of your assets, the leftover money would be your equity.

Your equity reflects the health of your business, since it is the amount of money left 
after you satisfy all your debts. Equity comes from three sources:

 Money invested in the company by its owners

 Net profit from operating the business during the current accounting period

 Retained earnings, or net profits from earlier periods that haven’t been distributed 
to the owners

Of course, you as the owner can also take money out of the business. Such withdrawals, 
called owner’s draws, reduce the business equity. If you have a sole proprietorship 
(where the existence of the business depends solely on your efforts), you can check the 
value of your owner’s equity by creating a QuickBooks balance sheet.

Cash versus accrual bookkeeping

When you begin your business, you should decide which bookkeeping method to use. 
The bookkeeping method determines how you report income and expenses on your tax 
forms. Check with your tax advisor or the Internal Revenue Service (IRS) before 
choosing a bookkeeping method for tax purposes.

Cash basis

Many small businesses record income when they receive the money and expenses when 
they pay the bills. This method is known as bookkeeping on a cash basis. If you’ve been 
recording deposits of your customers’ payments but haven’t been including the money 
customers owe you as part of your income, you’ve been using cash basis. Similarly, if 
you’ve been tracking expenses at the time you pay them, rather than at the time you 
first receive the bills, you’ve been using cash basis.
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Accrual basis

In accrual-basis bookkeeping, you record income at the time of the sale, not at the time 
you receive the payment. Similarly, you enter expenses when you receive the bill, not 
when you pay it.

Most accountants feel that the accrual method gives you a truer picture of your business 
finances.

How your bookkeeping method affects QuickBooks

Whether you use the cash or accrual method, you enter transactions the same way in 
QuickBooks.

QuickBooks is set up to do your reports on an accrual basis. For example, it shows 
income on a profit and loss statement for invoices as soon as you record them, even if 
you haven’t yet received payment. It shows expenses as soon as you record bills, even if 
they’re unpaid.

You can see any report (except transaction reports) on a cash basis by changing the 
Summary Reports Basis preference. (From the Edit menu, choose Preferences. In the 
Preferences window, click Reports & Graphs in the left panel, and then click the 
Company Preferences tab.)

Note: When you create reports in QuickBooks, you can switch between cash and accrual 
reports at any time, regardless of which bookkeeping method you have chosen for tax 
purposes.

Measuring business profitability

Two of the most important reports for measuring the profitability of your business are 
the balance sheet and the profit and loss statement (also called an income statement). 
These are the reports most often requested by CPAs and financial officers. (For example, 
banks request both documents when you apply for a loan.)

The balance sheet

A balance sheet is a financial snapshot of your company on one date. It shows:

 What you have (assets)

 What people owe you (accounts receivable)

 What your business owes to other people (liabilities and accounts payable)

 The net worth of your business (equity)
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To see an example of a balance sheet:
1 From the Reports menu, choose Company & Financial.

2 From the submenu, choose Balance Sheet Standard.

3 Scroll the report window to see all parts of the report.

The profit and loss statement

A profit and loss statement, also called an income statement, shows your income, 
expenses, and net profit or loss (equal to income minus expenses). The QuickBooks 
profit and loss statement summarizes the revenue and expenses of your business by 
category (first income, then expenses).

To see a profit and loss report:
1 Click Report Center on the icon bar.

2 In the list on the left, make sure Company & Financial is selected.

3 In the “Profit & Loss (income statement)” section, click to select the sample Profit & 
Loss Standard report, and then click the Display Report icon.

4 Scroll the report window to see all parts of the report.

The statement of cash flows

Another report that your accountant may be interested in is the statement of cash flows 
report. A statement of cash flows shows your receipts and payments during a specific 
accounting period.

To see a sample statement of cash flows report:
1 Click Report Center on the icon bar.

2 In the list on the left, make sure Company & Financial is selected.

3 Scroll to view the “Cash Flow” section.

4 Click to select the sample Statement of Cash Flows report, and then click the 
Display Report icon.

5 Scroll the report window to see all parts of the report.

6 Close all the reports and close the Report Center.

Looking at the journal entries for transactions

In traditional accounting, transactions are entered into a general journal in which the 
total amount in the Debit column equals the total amount in the Credit column, and 
each amount is assigned to an account on the chart of accounts. This accounting 
method is known as double-entry accounting. For day-to-day transaction entry, 
QuickBooks uses familiar forms (invoices, bills, checks).
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QuickBooks also has a General Journal Entry window that you can use for special 
transactions (such as selling a depreciated asset) or for all transactions if you prefer the 
traditional system.

When you enter a transaction directly into an asset, liability, or equity account register, 
QuickBooks automatically labels the transaction “GENJRNL” in the register and 
“General Journal” on reports that list transactions.

To see the general journal entry for a transaction:
1 In any sales form, type the keyboard shortcut Ctrl-Y (or press the Journal button).

The Journal button only displays in Accountant Edition.

2 Click Modify Report and in the Columns field, select Debit and Credit. Then click 
OK.

3 In the transaction journal that appears, check the Debit and Credit columns to see 
the accounting.

In the Customer and Vendor Centers, you can also view a journal entry for a 
transaction. Click the Transactions tab, then locate the customer or vendor transaction. 
Right-click the transaction and choose View Transaction Journal. 
35



G e t t i n g  s t a r t e d
Getting help while using QuickBooks

QuickBooks provides extensive help in various formats. When you have questions, 
QuickBooks provides:

 Onscreen Help to provide conceptual information and step-by-step instructions.

 Tutorials on key tasks. These are available by choosing Learning Center Tutorials 
from the Help menu.

 Live Community. Instant access to frequently asked questions and experts who can 
answer your own questions.

Using onscreen Help

The onscreen Help provides several different types of information:

 Conceptual explanations of how to apply QuickBooks to your particular business 
situation.

 Step-by-step instructions.

 A search engine that provides you with a list of topics related to the word or phrase 
you enter.

 Topics relevant to the task you are currently performing.

 Access to Live Community where you can exchange information with QuickBooks 
experts.

To view onscreen help:

When you launch QuickBooks help, it displays information about the task you are 
currently performing along with a list of topics relevant to what you are doing. There are 
several ways to access QuickBooks help:

 Press the F1 key on your keyboard.

 Click the Help icon in the icon bar at the top of the screen.

 From the Help menu, choose QuickBooks Help.

Finding a topic in the onscreen Help

Suppose you want to find out how to change information about a customer. You can 
type what you’re looking for in the Help Search field, and QuickBooks displays a list of 
topics.

To find a topic in onscreen Help:
1 From the Help menu, choose QuickBooks Help.

The Relevant Topics tab displays a list of topics related to the QuickBooks screen you 
are using.

2 Click the Search tab.
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3 Type customers and click the arrow button.

QuickBooks Help displays a list of topics related to customers.

4 Click “Edit or change customer information.”

QuickBooks displays the topic in the lower portion of the help window.

5 Close the Help window.
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Using the Getting Started Center

As you are learning to use QuickBooks, you can display the Getting Started Center on 
your home page to give you quick access to information that can help you set up your 
company.

To see the Getting Started section on your home page:
1 Open the Edit menu and choose Preferences. 

2 Click Desktop View.

3 Click My Preferences.

4 Check the box next to “Show Getting Started window.”

5 Click OK to close the Preferences window.

The Getting Started Center links appear on the left side of your home page.
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Exiting QuickBooks

Unlike most other Windows programs, QuickBooks doesn’t require you to save your 
data before exiting. It does an automatic save while you’re working with QuickBooks 
and every time you leave the program.

To exit QuickBooks
 From the File menu, choose Exit.

If no other applications are open, QuickBooks returns you to the Windows desktop.

To prevent or minimize data loss, you should make regular backup copies of your 
QuickBooks company data. In the event of a data loss you can restore your data from the 
backup copy. To make a backup copy, from the File menu, choose “Create Backup.”

Moving between company files

If you work with several companies, you’ll be working with multiple QuickBooks 
company files. You can change from one company file to another at any time, but you 
can have only one company file open at a time.

QuickBooks provides an easy way to find and open a company file that you’ve worked 
with before.

To open a previously opened file:
1 From the File menu, choose Open Previous Company.

2 From the submenu, choose the company file you want to open.

You can increase or decrease the number of company files that QuickBooks will display 
in the submenu.

To change the number of company files displayed in the submenu:
1 From the File menu, choose Open Previous Company.

2 Choose “Set number of previous companies.”

3 Enter the number of company files you want QuickBooks to display (up to 20).

4 Click OK.
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Using QuickBooks File Manager

If you are using QuickBooks Accountant Edition, you can use File Manager to organize 
your company files to make them easier to locate and manage from one location. 

QuickBooks File Manager allows you to: 

 Build a client list that creates a virtual view of your hard drive, groups clients’ 
QuickBooks files by type, and contains the locations of clients’ QuickBooks 
company files. 

 Save login information for your clients’ QuickBooks files in the Password Vault that 
allows you to open a client’s QuickBooks file from the client list with the correct 
version of QuickBooks without looking up the login information. 

 Upgrade multiple clients’ files to the latest version of QuickBooks in a batch. 

 Create Groups of clients that you define. 

You will not use QuickBooks File Manger to organize your files for this class, but you can 
use this information to manage information for your clients.

To use QuickBooks File Manager:
1 From the Accountant menu, choose QuickBooks File Manager.

2 If this is your first time using File Manager, use the Setup Wizard to organize your 
company files.

3 From the Help menu, choose Help or Video Tutorial to learn how to manage files 
with File Manager.
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Lesson objectives
 To discuss some of the decisions you need to make before using QuickBooks, such 

as your QuickBooks start date and the number of QuickBooks companies you 
should create

 To create a new QuickBooks company using the EasyStep Interview

 To set QuickBooks preferences in the Interview

 To record the opening balance for a checking account

 To create customers, jobs, vendors, accounts, and items for a QuickBooks company

Supporting materials
 PowerPoint file: Lesson 2

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

Creating a QuickBooks company
A QuickBooks company contains all the financial records for a single business. Before 
you can use QuickBooks, you need to tell QuickBooks about your business so that it can 
set up your company file. Setting up your company file properly is the most important 
thing you can do to help yourself manage your business efficiently and with 
confidence.

Explain to students that if they’ve been using Quicken or an older version of Quick-

Books to keep their company’s financial records, they don’t need to create a new com-
pany; QuickBooks can convert their data for them. However, in this lesson, you’ll be 
showing them how to create a new QuickBooks company.

How many companies should you set up?

If you operate a business enterprise, the IRS expects you to clearly show all sources of 
income and to document any business expenses you claim as deductions. For tax 
purposes, therefore, it’s usually best to set up a separate QuickBooks company for each 
business enterprise you report on your tax forms.

QuickStart Tip

If you’ve been using Quicken or an earlier version of QuickBooks to keep your company’s 
financial records, you don’t need to create a new company; QuickBooks can convert the 
data for you. See the QuickBooks Installation and Setup Guide for detailed instructions, or 
search the onscreen Help index for “Quicken.”
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About the EasyStep Interview

The EasyStep Interview walks you through the process of setting up your business on 
QuickBooks. The setup process is easy; the EasyStep Interview should take you only 
about 30 minutes to complete. When you set up your company file, QuickBooks will ask 
you for a number of details about your company.

Navigating through the Interview

Use the navigation buttons in each screen to move through the interview.

 Click Next to display the next window in the Interview.

 Click Prev to display the previous window in the Interview.

 Click Leave to leave the Interview and return to QuickBooks. The next time you 
open the company file, QuickBooks remembers the information you have already 
entered and returns you to the EasyStep Interview where you left off.

QuickStart Tip

Most small business owners do better with QuickBooks setup if they break the job into 
manageable chunks. Here’s a suggested schedule for completion:

1 Choose the QuickBooks start date.

2 Gather the necessary business information and documents.

3 Set up the company file using the EasyStep Interview.

4 Fine-tune the chart of accounts.

5 Enter any historical transactions.

6 Complete customer and vendor information.

7 Complete the Item list.

8 Enter any optional adjustments.

QuickStart Tip

Set aside a block of uninterrupted time to work on setting up your QuickBooks file. Don’t 
try to complete the setup while you’re in the middle of a busy workday. If you schedule 
your time before or after work hours, or on the weekend, setup should take a few hours.

Your goal while setting up is to provide as much information as necessary to get going, but 
not to provide all the details at once. For example, you could enter data for only your big-
gest customers and vendors. Later, you can enter customer and vendor data as you begin 
working in QuickBooks. (Or, if you have an especially large customer base, you may wish 
to hire a data entry clerk to complete this task for you.)
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Starting the EasyStep Interview

To begin adding a new company:
1 Start QuickBooks.

2 Click the “Start your new company file now” button, or choose New Company from 
the File menu.

3 Click Yes if you are prompted to confirm.

QuickBooks displays the EasyStep Interview window.

Entering company info
When you use the EasyStep Interview to create a new QuickBooks company, 
QuickBooks asks you questions about the type of business you own. It uses your answers 
to get you started quickly, by setting up the appropriate accounts and lists.

In this lesson, you’ll create a new QuickBooks company for a business named Lockhart 
Design. Margaret Lockhart is the sole proprietor of this interior design firm. Most of her 
income comes from consulting services, but she also sells products such as fabrics and 
room accessories to clients.

To create a new QuickBooks company file:
1 At the first Welcome window for the EasyStep Interview, click Start Interview.

The “Enter Your Company Information” window appears.

2 In the Company Name field, type Lockhart Design and press Tab.

When you press Tab, QuickBooks automatically enters the same name you typed 
into the Legal Name field. QuickBooks uses the company name on all reports.

3 Press Tab and enter 94-1234567 as the Tax ID number.
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4 Type the following information in the street address, city, state, and zip fields.

1239 Bayshore Road
Middlefield, CA 94432

QuickBooks prints this company address on checks, invoices, and other forms.

5 Now enter the following information in the Phone number and Fax number fields:

Phone: 650-555-1234

Fax: 650-555-5678

6 Next enter the email and Web addresses for Lockhart Design.

Email: margaret@samplename.com

Web Site: www.lockhart_design.com

Your screen should resemble the following.

7 Click Next.
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Choosing your company industry

When you create a new QuickBooks company, you can select a company type that most 
closely matches your type of business, and QuickBooks sets up accounts and lists that 
are appropriate for your type of company.

Your industry selection is used by the interview to ask questions and recommend 
features that work best for your business.

QuickBooks will recommend features that can best meet your business needs, such as:

 Enabling sales tax for retail businesses

 Using estimates in QuickBooks for some service-based businesses

 Managing inventory in QuickBooks for wholesalers and manufacturers

 Creating income and expense categories 

Even if you own a type of company that isn’t specifically listed, you should select the 
one that’s closest. Margaret Lockhart does consulting as well as retail sales, so we’ll select 
a Retail company type.

To choose the company industry:
1 On the “Select your industry” window, scroll down the list until you find Retail 

Shop or Online Commerce and select it.

Although Lockhart Design receives most of its income from consulting, not from 
retail sales, the Retail company type will give us most of the accounts we need. She’ll 
need to modify the chart of accounts later to include an income account for 
Consulting Income.

2 Click Next.

The “How is your company organized” window appears. 
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Selecting how your company is organized

Selecting how your company is organized tells QuickBooks which tax forms to use for 
your business. You also indicate the start of your fiscal year.

Lockhart Design is a sole proprietorship: an unincorporated business with one owner.

To select your company organization:
1 Click Sole Proprietorship to select it.

This tells QuickBooks to use the 1040 tax form. When you create a new account, you 
can associate a tax line on which you would report the income or expenses tracked 
by the account. 

An account's tax line associates each income and expense account with the 
appropriate tax form and line on your company income tax return. You'll see tax 
lines for the tax form you choose and for schedules and other forms typically filed 
with that tax form. This makes preparing income taxes easier and quicker, because 
it enables you to create tax reports to assist your accountant or to export and import 
your tax data into TurboTax, TurboTax Business, ProSeries, or Lacerte tax programs.
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2 Click Next.

QuickBooks needs to know the starting month of your fiscal year.

3 Since Lockhart Design’s fiscal year started in January, leave January selected and 
click Next.

The “Set up your administrator password” window appears. For this exercise, you 
don’t need to set up a password.

4 Click Next.

The “Create your company file” window appears.

5 Click Next to save the company file.

6 In the “Filename for New Company” window, make sure that QuickBooks is set to 
save the file in the QBtrain folder you set up in the introduction to this guide.

7 Click Save to accept the default filename of “Lockhart Design.”

QuickBooks creates the company file.
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Customizing QuickBooks for your 
business
The customization section of the EasyStep Interview is where you indicate:

 What you sell

 How and when your customers pay you

 How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The 
preferences enable certain features of the QuickBooks program.
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Indicating what you sell

You need to indicate what your business sells. In general, businesses either sell products 
or services, or both. Margaret Lockhart provides consulting services as well as selling 
products, such as fabrics. 

To indicate what you sell:
1 Click Next to move to the “What do you sell?” window.

2 Click “Both services and products” to select it.

3 Click Next.
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Entering sales information

For retail companies, you need to indicate how you want to enter sales. QuickBooks uses 
this information to set recommendations for a retail-type business. Margaret Lockhart 
does not do retail sales on a daily basis, so she will record her sales as they occur. 

To indicate how you enter sales:
1 In the “How will you enter your sales in QuickBooks?” window, click “Record each 

sale individually.”

Your screen should look like this:

2 Click Next.
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Entering sales tax information

This part of the EasyStep Interview asks whether you charge sales tax. You should turn 
the sales tax setting off only if you never charge sales tax. Margaret Lockhart typically 
charges sales tax, so we’ll turn on sales tax in her company file.

To set up QuickBooks to track sales tax:
1 Click Yes in the “Do you charge sales tax?” window.

QuickBooks sets up three sales tax items you can use on sales forms to track your 
sales tax: Local Tax, Out of State, and State Tax. In your own business company file, 
you would edit these tax items to enter the current tax rates.

2 Click Next.

QuickBooks automatically creates a current liability account, called Sales Tax 
Payable, that keeps track of the sales tax you collect in your business.
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Creating estimates

If you provide any type of estimate or bid—even a verbal quote—there are many reasons 
to use estimates in QuickBooks.

 You can use the QuickBooks estimate form to prepare professional-looking 
itemized estimates, bids, quotes, or proposals for your customers. You can 
customize a QuickBooks estimate to look and say exactly what you want it to.

 When it's time to bill your customer, you can easily create an invoice from the 
estimate with just one click. QuickBooks then creates an invoice using information 
from your estimate. You can also associate price levels with your customers and use 
those price levels on estimates.

 When you need to know how accurate your estimates are, you can create reports 
that compare your estimated costs and revenue against your actual costs and 
revenue.

 Creating estimates in QuickBooks will allow you to easily compare your actual costs 
against what you estimated. This will let you see how accurate your estimates are.

 You can track which estimates are still active and easily update each estimate as you 
continue to negotiate with your customers.

For this exercise, Margaret Lockhart creates proposals for her customers for their interior 
design projects, so she needs to enable estimates for her company.

To create estimates for your business:
1 On the “Do you want to create estimates in QuickBooks?” window, click Yes.

2 Click Next.
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Using sales orders

If your customers sometimes place orders for items that you don't have in stock or are 
not yet ready to invoice for, use a sales order in QuickBooks to track the sale.

Note: On the next window, if you are using a QuickBooks Premier Edition product, 
QuickBooks asks if you want to track sales orders. 

To set up sales orders:
1 On the “Tracking customer orders in QuickBooks” screen click Yes.

2 Click Next.
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Choosing remaining preferences

The next series of windows ask “yes or no” questions that enable or disable different 
QuickBooks features, based on your company needs. Simply click Yes or No, then click 
Next to move forward in the Interview. For Lockhart Design, complete the preferences 
by giving the following responses:

Answering the series of questions about your business helps customize QuickBooks to 
meet your specific business needs. Next, you’ll set up your accounts.

Note: You can always change preference settings later, after the EasyStep Interview. 
From the Edit menu, choose Preferences, and then select the preference type in the left 
panel.

Setting up your business accounting
Next, QuickBooks helps you set up the basic accounting you’ll use to track your 
business, referred to as your chart of accounts. To set up the chart of accounts, you need 
to:

 Determine the start date of your business

 Enter account balances

 Decide how you want to categorize your income and expenses

The chart of accounts is the framework used to categorize the information and 
transactions used to create reports. By using a chart of accounts and creating reports, 
you’ll always know the current state of your business.

The chart of accounts is made up of five types of accounts common to all businesses and 
you categorize transactions into one of these five account types.

For this item... Select...

Billing statements No

Progress invoicing Yes

Bill tracking Yes

Inventory No

Track time Yes

Employees No
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Choosing a start date

Before you start entering your company’s financial data, you need to choose a 
QuickBooks start date. This is the starting point you want to use for all your QuickBooks 
accounts. The start date is the date for which you give QuickBooks a financial snapshot 
of your company assets and liabilities.

Once you decide on a start date, you enter all your company’s transactions since that 
date. That’s why you should choose a start date that’s not too far back in the past for you 
to handle. Many business owners like to use the last day of a financial period as their 
start date, such as the end of last fiscal year, last quarter, or last month. You need to enter 
all historical transactions from the day after your start date up through today. For 
example, if you decide on a start date of March 31, you’d enter your historical 
transactions from April 1 up through today.

To choose a start date:
1 On the “Using accounts in QuickBooks” window, click Next.

The “Select a date to start tracking your finances” window appears.

2 Select “Use today’s date or the first day of the quarter or month,” and then enter 
12/31/2010.

3 Click Next.

QuickStart Tip

When choosing the start date you want to use for your own QuickBooks company file, 
consider this question: Is having a lot of historical data important to you? If it is, you’ll 
want to choose a start date as close to the beginning of your fiscal year as possible.

If historical data is not very important to you, you can make setup easier by choosing a 
start date as close to today as possible. (You only have to enter historical data between 
your start date and today.)
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Reviewing the chart of accounts

As you learned in Lesson 1 of this guide, the chart of accounts lists balance sheet 
accounts, income accounts, and expense accounts. When you create a new QuickBooks 
company, you select a company type that most closely matches your type of business, 
and QuickBooks sets up a chart of accounts for you.

The chart of accounts is made up of five types of accounts common to all businesses—
the income and expense accounts used by the Profit and Loss Statement, and the asset, 
liability, and equity accounts used by the Balance Sheet. Each time you enter a 
transaction, QuickBooks will prompt you to categorize it into one of these five types of 
accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has 
already created income and expense accounts for your company. Next, you’ll view the 
preset income and expense accounts.

To review the chart of accounts:
1 In the “Review income and expense accounts” window, scroll through the preset 

accounts to get an idea of what is included.

Note that from the list of accounts in this window you can remove or add accounts. 
If you see accounts you do not need, you can clear the checkmark for the account 
and QuickBooks removes it from the chart of accounts. To add an account, click in 
the checkmark column.

2 Click Next to go to the next window.
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3 Click Go to Setup.

The QuickBooks setup screen appears.

After you have completed the EasyStep Interview, use the information in the help 
options described later in this chapter to help you make changes and adjustments to 
your company file.

Entering bank accounts and opening balances

The bank accounts sections of QuickBooks Setup is where you enter any bank accounts 
you want to track and enter opening balances.

The balance sheet accounts in the QuickBooks chart of accounts start with an opening 
balance of zero. Before you begin working in QuickBooks, you need to enter an opening 
balance for each balance sheet account as of your start date.

The opening balance is important because QuickBooks can’t give you an accurate 
balance sheet (what your company owns and what it owes) without it. An accurate 
balance sheet gives you a true picture of your company’s finances. Also, if you start with 
an accurate balance as of a specific date, you can reconcile your QuickBooks bank 
accounts with your bank statements, and your QuickBooks checking accounts will 
show the actual amount of money you have in the bank.

The easiest way to determine an account’s opening balance is to work from an accurate 
balance sheet. If you have a balance sheet as of your start date, you can take the opening 
balance from there. During the EasyStep Interview, you can enter opening balances for 
bank accounts only. You’ll learn later how to enter opening balances for other types of 
accounts after you’ve completed the EasyStep Interview.
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Let’s assume Margaret Lockhart wants to enter an opening balance for her checking 
account. The opening balance for a QuickBooks bank account is the dollar amount in 
the bank on the start date. This amount can be determined two ways: using the ending 
balance on the last bank statement on or immediately prior to the start date, or using 
the bank account balance from a balance sheet prepared by an accountant. Margaret 
has a recent bank statement for this account, so we’ll use that method.

To enter bank account information:
1 On the “Add your bank account” section of QuickBooks Setup, click Add. 

2 Type Checking as the Account Name.

3 For Opening Balance, type 8359.00.

4 For Opening Balance Date enter 12/28/2010.

As you enter transactions between the start date and today, you’ll record any 
outstanding checks or deposits, which will allow you to reconcile your bank 
account against the next statement.

Your screen should look like this:

5 Click Continue.

6 In the Order Checks screen, select No Thanks and click Continue.

7 Click Start Working.
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Completing company file setup
After you have created your company file using the EasyStep Interview and QuickBooks 
Setup, you can begin using QuickBooks to run your business. However, there are some 
additional tasks you might need to do to make sure the company file is properly set up 
and that the data is complete.

QuickBooks is based on four key concepts: Customers, Vendors, Accounts, and Items. If 
you take a few minutes now to understand these basic concepts, you'll be able to get 
started quickly and correctly with your company information.

 Customer: A customer is anyone who pays you. This can mean patients, donors, 
members, legal or consulting clients, or your typical retail customer.

 Vendor: A vendor is anyone you pay, except for employees. This can mean 
subcontractors, utility companies, your landlord, tax agencies, or suppliers.

 Account: There are two types of accounts—real world accounts, such as checking 
accounts, and income and expense accounts that you use to group transactions for 
reporting purposes. For example, you may want to create expense accounts to track 
office supply purchases separately from advertising costs. All accounts are listed on 
your chart of accounts. If you choose a tax form, you can associate accounts with tax 
lines, which would make preparing for tax time easier.

 Item: An item is anything you want to put on an invoice. This includes parts, 
services, labor, discounts, and taxes.

This section covers how to set up customers, vendors, and items, and how to add an 
income account.

Adding customers

In order to bill customers with QuickBooks, you need to add your customers.

By entering details about the people and companies you do business with, you can 
personalize their bills, send invoices easily, and quickly view the status of their 
accounts. You can add new customers at any time.

Note: You can also add customers and vendors as you perform everyday tasks. For 
example, if you enter the name of a new customer when filling out an invoice, 
QuickBooks will prompt you to enter information about this customer. You can choose 
from two quick setup options: Quick Add and Set Up. Quick Add adds the name to the 
list and you add details later. Set Up lets you enter the details right away.
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To add a customer:
1 Click Customer Center in the icon bar.

2 Click the New Customer & Job menu button, and then choose New Customer.

3 If the New Feature screen for Add/Edit Multiple List Entries appears, click the box for 
“Do not display this message in the future” and click OK.

4 In the Customer Name field, enter the name of the customer as you'd like it to 
appear on your Customers & Jobs list. For this exercise, type Smith, Lee, and then 
press Tab.

You want the list to show last names first.

5 Press Tab in the Opening Balance field to leave this field blank.

The Opening Balance field tells you how much each customer owes you on your 
start date so that when you enter the rest of your transactions from your start date 
to today, all balances since your start date will be accurate.

For now, leave this field blank. Lockhart Design is planning to set up one or more 
jobs for this customer. QuickBooks will calculate and track the overall balance for 
this customer from the balances you enter for the individual jobs.

6 In Address Info tab, click in the First Name field and type Lee.

7 Press tab and type M. as the middle initial and in the Last Name field, type Smith.

8 Press Tab to go to the Address field, and then press Enter after Lee M. Smith.

9 Type 43 Hampshire Blvd and press Enter.

10 Type East Bayshore, CA 94327.

11 Click the Copy button to copy the address to the Ship To field. Click OK in the Add 
Shipping Address Information window.

You can have and use more than one Ship To address per customer or job, but Lee 
Smith uses only one address. 
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Your screen should resemble the following graphic.

12 Click OK to add this customer.

The Customer Center appears, with the Customers & Jobs list along the left side.

Note: The Customers & Jobs list is the same list as the Customer:Job list. It is called 
Customers & Jobs on the Customer Center, and it is called Customer:Job on forms. 
It is sometimes also referred to as simply the Customer list.

Adding a job

If you often perform multiple jobs for the same customer, you can use jobs in 
QuickBooks to track the activity for each job separately. That way, you can create 
reports that show the income and expenses for each job. Jobs in QuickBooks are 
optional. You do not need to add jobs to the Customers & Jobs list if your company 
never does more than one job or project per customer.

Lockhart Design wants to track jobs for Lee Smith.

To add a job for a customer:
1 In the Customers & Jobs list, right-click Smith, Lee and choose Add Job.

The New Job window looks similar to the Customer window. QuickBooks has 
already filled in several fields for you for Lee Smith.

2 In the Job Name field, type Patio, and press Tab.
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3 In the Opening Balance field, type 862 and press Tab.

You want to keep track of the balances for each job. QuickBooks calculates and 
tracks the overall balance for this customer from the balances you enter for the 
individual jobs.You want to keep track of the balances for each job. 

Note: The information QuickBooks fills in comes from your customer's record. If 
you make any changes here, the changes affect only this job. For example, if your 
customer's billing address is different for this job, you can enter the job address 
without affecting the customer's main address.

4 Enter 12/31/2010 in the As Of field to indicate that this was the balance outstanding 
for this job as of the QuickBooks start date.

5 Click the Job Info tab and choose “In Progress” from the Job Status drop-down list.

Job status information is for your records—it gives you a way to keep track of each 
job. When you create a customer list report, QuickBooks includes the status of each 
job on the report. You can also see the status of a job by clicking a job in the 
Customers & Jobs list and looking in the Job Information area.

6 For the Start Date, type 12/15/10 and press Tab.

7 In the Projected End date, type 3/15/11 and press Tab.

The dates help you track how long each job takes and how well you are able to 
estimate the length of a job. When you create a customer:job list report, you can add 
columns that show the start date, your projected end date, and the actual end date 
for each job.

Your screen should resemble the following graphic:
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8 Click OK.

9 If you see a message about a past or future transaction, click Yes to save the 
transaction.

The job now appears under Smith, Lee in the Customers & Jobs list.

10 Close the Customer Center.

Adding vendors

In order to pay your bills with QuickBooks, you need to add your vendors. Nearly 
everyone you pay, other than employees, is a vendor.

You can add new vendors at any time. QuickBooks uses the Vendors list to hold 
information about the people and companies you do business with; for example, this 
list could include the phone company, your office supplies vendor, and your tax board.

To add a vendor:
1 Click Vendor Center in the icon bar.

2 Click the New Vendor menu button, then choose New Vendor.

3 In the Vendor Name field, enter the name of the vendor as you'd like it to appear on 
your Vendor list. For this exercise, type Fay, Maureen Lynn, CPA, and then press Tab.

4 In the Opening Balance field, type 350, which is the amount you owed this vendor 
as of the start date. Press Tab.

5 In the As Of field, enter 12/31/10. 

6 In the Address Info tab, click in the First Name field and type Maureen.

7 Press tab and type L. as the middle initial and in the Last Name field, type Fay.

8 Press Tab to go to the Address field, and then press Enter after Maureen L. Fay.

9 Type 200 Royal Rd. and press Enter.

10 Type Bayshore, CA 94326.
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11 Click in the “Print on Checks As” field, and type Maureen Fay.

Your screen should resemble the following graphic.

12 Click OK to add this vendor.

13 If you see a message about a past or future transaction, click Yes to save the 
transaction.

The new vendor appears on the Vendor list.

14 Close the Vendor Center.
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About customer and vendor types

Customer and vendor types let you categorize your customers and vendors in ways that 
are meaningful to your business. For example, you could set up your customer types so 
that they indicate which industry a customer represents, a customer's geographic 
location, or how a customer first heard about your business. You could set up your 
vendor types so that they indicate a vendor's industry or geographic location. For 
example, you might create the type Painters with the subtypes Exterior and Interior. 

 Commercial photographers might use customer types to record a customer's 
primary interest: graduation, portraiture, weddings, and so on.

 Building contractors might use vendor types to classify their subcontractors by 
geographical location so they can use the ones closest to each job. 

You can create reports and do special mailings that are based on your customer and 
vendor types. For example, if you use customer types to categorize your customers by 
location, you could print mailing labels for all the customers in a particular region.

Setting up additional accounts

You added one checking account for Lockhart Design. There are two basic types of 
accounts: balance sheet accounts, such as savings or checking, and accounts used to 
group transactions for reporting purposes, such as income and expense accounts. 
Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions, you usually assign the amount of the 
transaction to one or more income or expense accounts.

In the EasyStep Interview, you selected “Retail Shop or Online Commerce” as the 
industry for Lockhart Design. QuickBooks created a chart of accounts based on the retail 
industry. However, Margaret Lockhart also receives income from design consulting. She 
needs to modify the chart of accounts to add an income account for consulting.

Adding a new account

You may need to add one or more of the following accounts:

 Income accounts to track new sources of income.

 Expense accounts to track new types of expenses.

 Bank accounts when you open new checking, savings, or money market accounts 
at your bank.

 Credit card accounts when you acquire new credit cards.

 Other kinds of balance sheet accounts to track specific assets, liabilities, or equity.

For example, you may need to add a fixed asset account to track the depreciation of 
a new equipment purchase, a long term liability account to track a business loan, or 
an equity account to track the investment from a new business partner.

A complete list of your business’ accounts and their balances appear in the chart of 
accounts. You use a chart of accounts to track how much money your company has, 
how much money it owes, how much money is coming in, and how much is going out.
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For Lockhart Design, you’ll add an income account for her consulting income.

To add an income account:
1 From the Lists menu, choose Chart of Accounts.

2 Click the Account menu button and choose New.

3 In the Add New Account window, choose Income, and then click Continue.

4 Click in the Account Name field, and type Consulting.

5 From the Tax-Line Mapping drop-down list, choose “Schedule C: Other business 
income.”

Your screen should resemble the following graphic.

6 Click Save & Close, and then close the chart of accounts.

Adding items

In QuickBooks, an item is anything that your company buys, sells, or resells in the 
course of business, such as products, shipping and handling charges, discounts, and 
sales tax (if applicable). You can think of an item as something that shows up as a line 
on an invoice or other sales or purchase form.

Items help you fill out the line item area of a sales or purchase form quickly. When you 
choose an item from your Item list, QuickBooks fills in a description of the line item and 
calculates its amount for you.
67



S e t t i n g  u p  Q u i c k B o o k s
While they provide a quick means of data entry, a much more important role for items 
is to handle the behind-the-scenes accounting. When you create an item, you link it to 
an account; when the item is used on a form, it posts an entry to that account and 
another entry to the appropriate accounts receivable, accounts payable, checking, fixed 
asset, or other account.

When creating items, consider how much detail you want on your invoices or 
statements and set up items with that level of detail in mind. For example, if you are a 
seamstress who creates and sells home accessories, you can set up a single item and 
charge a flat rate for a certain size of couch pillow, or you can break that pillow down 
further into labor and materials.

QuickBooks provides several different types of items. Some—such as the service item or 
the inventory part item—help you record the services and products your business sells. 
Others—such as the subtotal item or discount item—are used to perform calculations 
on the amounts in a sale.

For Lockhart Design, you’ll set up a service item for billing the time used for initial 
consultation for a design project. You’ll assign it to the new Consulting income 
account.

To add an item:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item List.

2 Click the Item menu button, and choose New.

3 In the New Item window, choose Service from the Type drop-down list.

4 Click in the Item Name/Number field and type Initial Design Consultation.

5 In the Description field, type Initial design consulting.

The description will appear on sales forms when you use the item.

6 Click in the Rate field, and type 40. 

7 In the Tax Code field, choose “Non-Taxable Sales” from the drop-down list.
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8 In the Account field, choose Consulting.

Your screen should resemble the following graphic.

9 Click OK to add the new item to the Item List.

The item now appears in the Item List.

10 Close the Item List.
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Entering historical transactions

If your QuickBooks start date is before today’s date, you also need to enter past 
transactions so that you have complete financial records from the start date forward. It 
is important to enter historical transactions in this order:

1 All sales (sales receipts, invoices, or statement charges)

2 Customer payments received for outstanding invoices after the start date

3 Bills received since the start date

4 Bills paid since the start date

5 Deposits made to any of the accounts since the start date

6 Any other checks written (other than bills) since the start date

Learning more about the company setup process

When you are setting up your own company in QuickBooks, you may want to view the 
tutorials available in the Learning Center to help you finish setting up your own 
company file. The information provided in the videos gives you an overview of the 
program and more detailed information about using specific parts of the product.

To open the Learning Center:
 From the Help menu, choose Learning Center Tutorials.

For more information, choose Support from the Help menu.

Closing the company file
As you enter information in your company file, QuickBooks saves what you enter. 
When you are finished working on a file, you can close the file.

To close the company file you just created:
 From the File menu, choose Close Company.
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Lesson objectives
 To edit the company chart of accounts

 To add a new customer to the Customers & Jobs list

 To add a new vendor to the Vendor list

 To learn about custom fields, and to practice adding custom fields

 To see how to manage lists in QuickBooks

Supporting materials
 Handout 1: Balance sheet accounts

 Handout 2: Accounts created automatically

 PowerPoint file: Lesson 3

 Video tutorial: Adding and using QuickBooks accounts

 Video tutorial: Introducing the Customer Center

 Video tutorial: Introducing the Vendor Center

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handouts 1 and 2 ready for distribution.
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To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 3 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Using QuickBooks lists
QuickBooks lists organize a wide variety of information, including data on customers, 
vendors, inventory items, and more. Lists save you time by helping you enter 
information consistently and correctly. When you store information on a list, you enter 
it once and never need to retype it. Think about how much information you use more 
than once in your business:

 Names, addresses, and other information about customers who purchase from you 
on a regular basis

 Contact information for vendors from whom you purchase your supplies

 Descriptions and prices for products or services you sell again and again

Simply enter repetitive information into a list once, and then use it over and over on 
checks, on invoice forms, and other daily transactions. You don’t have to enter all the 
information for your company lists before you begin working with QuickBooks. You 
can add information to lists as you go along.
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Editing the chart of accounts
The chart of accounts is your most important list because it shows how much your 
business has, how much it owes, how much money you have coming in, and how much 
you’re spending. When you set up your own company in QuickBooks, the EasyStep 
Interview lets you choose a chart of accounts designed especially for your type of 
business. However, not every business has the same needs; you’ll want to make a few 
changes to the list.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.

2 Scroll through the list. The chart of accounts displays balance sheet accounts first, 
followed by income and expense accounts.

Refer to Handout 1, “Balance sheet accounts” as you explain each account type and the 
kinds of transactions you use each type for.

QuickStart Tip
Before you modify the preset chart of accounts, we recommend that you have your 
accountant or QuickBooks Professional Advisor review the chart of accounts that 
QuickBooks has set up for you. You may need to add income and expense accounts, add 
subaccounts, delete accounts, or move accounts. It is important to decide on an account 
structure before you begin entering transactions.
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Editing an account

If any of the accounts don’t suit your needs, you can edit or delete them. In the next 
exercise, you’ll edit Rock Castle Construction’s Checking account to provide the 
account number.

To edit an account:
1 In the chart of accounts, select Checking.

2 Click the Account menu button (at the bottom of the window), and then select Edit 
Account.

QuickBooks displays the Edit Account window.

3 In the Description field, type Great Statewide Bank.

Your window should look like this.

4 Click Save & Close.
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Adding subaccounts

The Dues and Subscriptions expense account has one subaccount called Union Dues. 
Rock Castle Construction wants to add a second subaccount for trade publications.

To add a subaccount:
1 In the chart of accounts, click the Account menu button and then choose New.

QuickBooks displays the Add New Account: Choose Account Type window.

2 Select Expense.

3 Click Continue.

4 In the Account Name field, type Trade Pubs.

5 Select the “Subaccount of” checkbox, and then select Dues and Subscriptions in the 
drop-down list.
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6 In the Description field, type Trade Publications.

7 Click Save & Close.

QuickBooks displays the new subaccount in the chart of accounts list.

8 Close the chart of accounts.

Explain to students that in addition to the accounts that QuickBooks sets up by default 
based on the industry they select during the EasyStep Interview, QuickBooks also creates 
certain accounts as needed based on the features used in the program. For a list of these 
accounts, refer to Handout 2, “Accounts created automatically.”
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Working with the Customers & Jobs list
The Customer Center stores names, addresses, and other information about your 
customers. It also holds information about the jobs or projects you may want to track 
for each customer.

Adding new customers

In this exercise, you’ll add a new customer to the Customers & Jobs list.

To add a new customer:
1 Click Customer Center in the icon bar.

QuickBooks displays the Customer Center, which includes the Customers & Jobs 
list.

The Customer Center lets you add, edit, and get reports on your customers. Each 
customer in the list can have multiple jobs (you may call them projects or accounts). 
Notice that this Customers & Jobs list already has quite a few entries.

2 Click the New Customer & Job menu button (at the top of the Customer Center), 
and select New Customer.
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QuickBooks displays the New Customer window.

The New Customer window is where you enter all the information about a new 
customer, including billing and shipping addresses, contacts, credit limit, and 
payment terms. QuickBooks uses the information you enter to complete invoices, 
bills, and receipts. When you’re setting up your company file, you use this window 
to record customers’ opening balances.

3 In the Customer Name field type Godwin Manufacturing.

4 In the Company Name field on the Address Info tab, type Godwin Manufacturing, and 
then press Tab.

Notice that QuickBooks fills in the Customer Name field and the first line of the Bill 
To field with the information you typed in the Company Name field.

QuickBooks displays the name listed in the Customer Name field in the Customers 
& Jobs list. By default, QuickBooks sorts the list alphabetically. 

Note: If you are entering individual names, you may want to use last name, first name 
in the Customer Name field so that your Customers & Jobs list displays the names with 
the last name first. This is useful for alphabetical sorting of lists and reports.

5 In the Bill To field, click at the end of the company name line and press Enter.

6 Type 376 Pine Street, and then press Enter.

Notice that you press Tab to move between fields, but you press Enter to move from 
one line to the next within a field.

7 On the next line of the Bill To field, type Bayside, OR 64326.
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8 Click Copy to have QuickBooks copy the billing address to the Ship To field.

Each of your customers can have multiple shipping addresses. You can also set 
which address to use as the default address. The default address for each customer is 
used on sales forms, letters, labels, and in Shipping Manager.

9 Click OK to use this address as the Godwin Manufacturing ship to address.
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10 Continue filling out the customer information by providing the following 
information:

 Contact: John Godwin

 Phone: 325-555-9841

 Fax: 325-555-0012

 Alt Contact: Tracy Heldt

Note: If you plan to e-mail invoices or statements to customers using the Send Forms 
feature, use this window to enter your customers’ e-mail addresses.
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Providing additional customer information

You’ve just completed the Address Info tab for a new customer. The Additional Info tab 
is where you can provide other important information, such as customer type (if you 
want to categorize your customers in some way), payment terms, and sales tax 
information.

To add additional information to a customer record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Customer window.

2 In the Type field, type Industrial.

The Type field lets you track customers in any way that is meaningful for your 
business. For example, if you run ads on television, radio, and in print, and you 
want to know which advertising method brings you the most customers, you can 
assign customers a “type” (TV, Radio, or Print) and run reports that tell you which 
referral source is most effective. Rock Castle Construction uses the Type field to 
categorize customers by the type of service provided.

3 Press Tab.

QuickBooks tells you that Industrial is not currently on the Customer Type list and 
asks if you wish to add it.

4 Click the Quick Add button to add the customer type to the list.

Quick Add lets you set up the item with a minimum amount of data. If you click Set 
Up, you can enter more detailed information, but that interrupts the process of 
creating a new customer.
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5 In the Terms field, type Net 30.

6 In the Tax Code field, select Non from the drop-down list.

7 In the Tax Item drop-down list, select Out of State.

Your screen should now look like this.

Providing customer payment information

The Payment Info tab is where you enter customer account numbers and credit limits. 
QuickBooks remembers each customer’s credit limit and warns you when a customer is 
about to exceed it. You can also record information about each customer’s preferred 
payment method. For customers who pay by credit card, you can enter credit card 
numbers and expiration dates.

To add payment and credit information to a customer record:
1 Click the Payment Info tab.

2 In the Credit Limit field, type 2000.

3 In the Preferred Payment Method drop-down list, choose Check.
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When you finish, your window should look like this.

4 Click OK to add the customer and close the New Customer window.

QuickBooks displays the Customers & Jobs list with Godwin Manufacturing added 
at the top of the list. You’ll learn how to sort the list later.

5 Close the Customer Center.

Working with the Employee Center
The Employee Center stores information about your employees such as name, address, 
and social security number. It also stores information QuickBooks needs to calculate 
your employee paychecks (if you are using QuickBooks for payroll). You’ll learn how to 
enter employee payroll information later in this course. For now, enter only the basic 
employee information.

QuickBooks uses the information you enter in the Employee list to track sales and fill in 
information on checks and other forms.

QuickStart Tip
QuickBooks has several preset reports related to customers. Some reports you may find 
useful are the sales by customer summary and the sales by customer detail reports (under 
the Sales submenu in the Reports menu).

You may also find the A/R aging summary, A/R aging detail, customer balance summary, 
customer balance detail, and open invoices reports useful. You’ll find them under the Cus-
tomers & Receivables submenu in the Reports menu.
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Adding new employees

Suppose that Rock Castle Construction has hired a new employee and you want to add 
her information to the Employee list.

To add a new employee:
1 Click Employee Center in the icon bar.

QuickBooks displays the Employee Center, including the Employee list.

The Employee Center is where you add a new employee, edit information for an 
existing employee, or delete an employee name (as long as you have not used the 
employee name in any transactions).

2 Click the New Employee at the top of the Employee Center.
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QuickBooks displays the New Employee window.

The Personal tab is where you enter basic information about the employee, such as 
name, Social Security Number, and date of birth.

3 In the First Name field, type Marlene.

4 In the Last Name field, type Duncalf, and then press Tab.

Notice that QuickBooks fills in the “Print on Check as” field with the information 
you entered in the name fields. You can enter a different name if you wish.

5 In the SS No. field, type 123-45-6789.

6 In the Gender field, select Female from the drop-down list.
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7 In the Date of Birth field, type 7/18/82.

The Personal tab should look like this.

8 Click the Address and Contact tab.

9 In the Address field, type 195 Spruce Avenue, #202.

10 For the City, State, and Zip fields, type Bayshore, CA 94326.
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11 In the Phone field, type 415-555-1111.

When you finish, the window should look like this.

12 In the Change tabs field, select Employment Info from the drop-down list.

13 In the Hire Date, type 11/26/2000.

14 Click OK.

15 When QuickBooks asks if you want to set up payroll information, click Leave As Is.

You learn how to set up payroll in Lesson 12.

QuickBooks updates and displays the Employee list with the new employee’s name 
added.

16 Close the Employee Center.
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Working with the Vendor Center
The Vendor Center is where you record information about the companies or people 
from whom you buy goods or services. QuickBooks uses the data in the Vendor Center 
to fill in purchase orders, receipts, bills, and checks as you receive and pay for goods and 
services.

Adding new vendors

In this exercise, you’ll add a new vendor to the Vendor Center. Suppose Rock Castle 
Construction is working with a new subcontractor, and it needs to add information 
about the new vendor to its QuickBooks Vendor list.

To add a new vendor:
1 Click Vendor Center in the icon bar.

QuickBooks displays the Vendor Center.

2 Click the New Vendor menu at the top of the Vendor Center and choose New 
Vendor.

QuickBooks displays the New Vendor window.

The New Vendor window is where you enter all of the information regarding a new 
vendor, such as name, phone, contact, address, and opening balance. Just as when 
you add a new customer, you start by providing basic information on the Address 
Info tab.

3 In the Vendor Name field, type Hughes Electric.

This is the name QuickBooks displays for this vendor in the Vendor list. If the 
vendor is an individual, you may wish to enter the last name first, then the first 
name.
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4 In the Company Name field, type Hughes Electric, and then press Tab.

5 Click in the Name and Address field, after the company name displayed on the first 
line, and press Enter.

Notice that QuickBooks displays the company name on the first line of the Billed 
From Address field.

6 On the second line of the Billed From Address field, type P.O. Box 2316.

7 Press Enter to move to the next line.

8 Type Middlefield, CA 94432.

9 Click Copy to use the Billed From Address as the Ship From Address.

10 Click OK in the Add Shipping Address Information window.

11 In the Contact field, type David Hughes.

12 In the Phone field, type 510-555-6666.

13 In the FAX field, type 510-555-6667.

When you finish, your window should look like this.

Providing additional vendor information

The Additional Info tab in the New Vendor window is where you can enter a vendor 
type (if you want to categorize your vendors), payment terms, your credit limit, the 
vendor’s tax identification number, whether this vendor is eligible for a 1099 form, and 
your opening balance. You’ll add this information now for Hughes Electric.
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To add information to a vendor record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Vendor window.

2 In the Account No. field, type 123-445.

3 In the Type field, type Subcontractors.

Notice that when you type “sub,” QuickBooks fills in the rest of the word.

4 In the Terms field, choose “2% 10 Net 30” from the drop-down list.

5 In the Credit Limit field, type 2000 and press Tab.

Your New Vendor window should resemble the figure below.
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6 Click OK.

QuickBooks adds the vendor and displays the updated Vendor list.

Notice that Hughes Electric has been added to the list.

7 Close the Vendor Center.

QuickStart Tip
QuickBooks has several preset reports related to vendors. Some reports you may find 
useful are the purchases by vendor summary and purchases by vendor detail reports 
(under the Purchases submenu in the Reports menu).

You may also find the A/P aging summary, A/P aging detail, unpaid bills detail, vendor 
balance summary, and vendor balance detail reports useful. You’ll find them under the 
Vendors & Payables submenu in the Reports menu.
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Adding custom fields
QuickBooks lets you add custom fields to the Customers & Jobs, Vendor, Employee, and 
Item lists. Custom fields give you a way to track additional information specific to your 
business. For example, you can add a field for pager numbers to your Vendor and 
Employee lists, a field for customers’ birthdays to your Customers & Jobs list, and fields 
for units of measurement, color, and size to your Item list.

When you add the custom fields to your sales forms or purchase orders, the fields are 
prefilled with the information for that specific customer, employee, vendor, or item (if 
you specified a value for the custom field when you added the customer, for example). 
You don’t have to add the custom fields to your forms, however; you can also use 
custom fields as a way to record information just for your use, such as a credit rating for 
each customer. QuickBooks remembers the information you entered in the custom 
fields when you import and export data and when you memorize transactions.

You can add up to seven custom fields to each Customers list, Vendors list, or 
Employees list. Overlapping fields count as one field on each list. For example, if you 
add a custom “Birthday” field for customers and vendors, you can still add six 
additional fields to each list. For each of the names lists (customer, vendor, and 
employee), you can add up to seven custom fields, including fields that are on more 
than one list. You can add up to five custom fields for the Item list. (Custom fields for 
the Item list are tracked separately from custom fields for the customer, vendor, and 
employee lists.)

After you add custom fields, you can use them on invoices, credit memos, sales receipts, 
purchase orders, estimates, and sales orders (QuickBooks Premier and higher only).

Adding custom fields for customers, vendors, and 
employees

You can enter information in the custom fields only through the New or Edit windows 
(for example, the New Customer or Edit Customer windows). You can display 
information from the custom fields on forms as well as add custom fields to reports.

First, look at the custom fields that Rock Castle Construction has already added to its 
Customers & Jobs, Vendor, and Employee lists. Then, you’ll add two new custom fields.

To add custom fields:
1 Click Customer Center in the icon bar.

QuickBooks displays the Customer Center.

2 In the Customers & Jobs list, select Cook, Brian.
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3 Click the Edit Customer button.

QuickBooks displays the Edit Customer window.

4 Click the Additional Info tab.

QuickBooks displays the Additional Info tab in the Edit Customer window.
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5 Click Define Fields.

QuickBooks displays the Set up Custom Fields for Names window.

Notice that Rock Castle Construction has already set up custom fields in the 
Customers & Jobs list for contract number, birthday, and spouse’s name. In the 
Vendor list, they have set up a custom field for discount available. In the Employee 
list, they have set up custom fields for the date of last raise and spouse’s name.

Now, you’ll add a custom field for pager numbers to the Customers & Jobs and 
Vendor lists. You’ll also add a custom field to the Employee list that tracks the date 
of each employee’s last review.

6 Click below Spouse’s name in the Label column and type Pager Number.

7 Click the Cust column.

8 Click the Vend column.

9 In the next line of the Label column, type Date of last review.
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10 Click the Emp column.

Your Define Fields window should now look like this.

11 Click OK.

12 If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.

QuickBooks has added the Pager Number field to the Edit Customer window.
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13 In the Pager Number field, type 415-555-9876.

If you customize your sales forms to display the Pager Number field, this number 
displays whenever you create a form for this customer. It also displays on reports 
modified to display the Pager Number column.

14 Click OK to close the Edit Customer window.

15 Close the Customer Center.

Adding custom fields for items

Now suppose that Rock Castle Construction wants to add another custom field to its 
Item list. The company purchases several types of locking doorknobs. The Item list 
already has custom fields for Color and Material, but now Rock Castle wants to add an 
additional field to track Style.

To add custom fields for items:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item list, as shown below.

2 In the Item list, select Lk Doorknobs (a sub item of Hardware).
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3 Click the Item menu button, and then choose Edit Item.

QuickBooks displays the Edit Item window.

Note: Notice the Manufacturer’s Part Number field. This part number is a unique 
number or code assigned by the manufacturer to each of their items. Since purchase 
orders are usually sent to the manufacturer, using the 
manufacturer’s part number will ensure that your vendor knows exactly what is 
being ordered.

4 Click Custom Fields.

QuickBooks displays the custom fields already defined for this item.

5 Click Define Fields.

QuickBooks displays the Set up Custom Fields for Items window.

6 Click the Label field below Material and type Style, then click the Use column.

7 Click OK to close the window.

If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.
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8 In the “Custom Fields for Lk Doorknobs” window, type Round in the Style field.

9 Click OK to close the Custom Fields for Lk Doorknobs window, and then click OK 
to close the Edit Item window.

10 Close the Item list.

Managing lists
Lists are easy to manage in QuickBooks. You can sort lists, combine (merge) list items, 
rename list items, delete list items, make list items inactive, and print lists.

Sorting lists

You can sort many QuickBooks lists manually or alphabetically. To sort a list manually, 
simply use the mouse to drag a list item to its new location. Lists that you can sort this 
way are the Chart of Accounts, Customers & Jobs, Class, Customer Type, Vendor Type, 
Job Type, and Memorized Transaction lists.

If you have changed the order of a list by dragging items and then decide you’d rather 
have an alphabetically sorted list, QuickBooks has a Re-sort List command. In the chart 
of accounts, the Re-sort List command sorts alphabetically within account type; in the 
Item list, the Re-sort List command sorts alphabetically within item type.

QuickStart Tip
You can add custom fields you’ve set up for customers or items to any sales form. 
Similarly, you can add customer fields you’ve set up for vendors or items to the purchase 
order form. If you want to filter a report based on text in custom fields, you must add the 
fields to the form used to generate the report. For example, if you want to filter the open 
purchase orders report by style, you need to add the Style field to the purchase order 
template you use.
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Sorting lists manually

In this exercise, you’ll sort a list manually, and then re-sort it to put it back in 
alphabetical order.

To sort a list manually:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.

2 Click the diamond to the left of the Owner’s Draw subaccount of Owner’s Equity. 
(You may need to scroll or resize the window to see it.)

3 Click and hold the left mouse button, and drag the pointer upward until you see a 
dotted line directly below Owner’s Equity.

4 Release the left mouse button to drop the account in the new position.

The Owner’s Draw account is now directly under the Owner’s Equity account.

Now you can use the Re-sort List command to return the list to alphabetical order.

5 To re-sort the list alphabetically, click the Account menu button, and select 
Re-sort List.

QuickBooks asks you to confirm that you want to return the list to its original order.

6 Click OK.

QuickBooks re-sorts the chart of accounts alphabetically by account type.

7 Close the chart of accounts.
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Sorting lists in ascending or descending order

Depending on the type of business you have, you may want to order your list entries in 
a certain way. For example, perhaps you’d like to see people who owe you money at the 
top of your Customers & Jobs list. In this exercise, you’ll learn how to sort the Customers 
& Jobs list in descending order by customer balance.

To sort a list in descending order:
1 Click Customer Center on the icon bar to display the Customer Center and 

Customers & Jobs List.

Click this button to expand (or collapse) the 
Customers & Jobs list.
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2 Click the arrow to the right of the View drop-down list to expand the Customers & 
Jobs list.

The Customers & Jobs list now shows details about the customers and jobs.

3 Click the Balance Total column heading.

Notice that an arrow pointing up appears on the heading and the list is sorted in 
ascending order by customer balance.

4 Click the column heading again.
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Notice that the arrow now points down and the list is sorted in descending order 
with the customers with the highest balances at the top of the list.

5 To return to the order you started with, click the large diamond to the left of the 
Name column heading.

6 Click the Collapse arrow to collapse the Customers & Jobs list.

If you don’t collapse the Customers & Jobs list, the next time you open the 
Customer Center, the center opens with the expanded Customers & Jobs list.

7 Close the Customer Center.

Merging list items

In most lists, you can combine two list items into one. For example, you may find that 
you’ve been using two customers (because of different spellings) when you really need 
only one on your Customers & Jobs list. You can merge list items in the Chart of 
Accounts, Item, Customers & Jobs, Vendor, Employee, and Other Names lists.

Note: After you merge list items, you cannot separate them. When working in your own 
company file, we recommend that you back up your data before merging list items.

In this exercise, suppose you want to merge Hughes Electric (the vendor you added 
earlier in the lesson) with C.U. Electric. To merge them, you edit the incorrect name to 
match the spelling of the correct name.
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To merge items on a list:
1 From the Vendors menu, choose Vendor Center.

QuickBooks displays the Vendor Center.

2 Double-click the entry for Hughes Electric.

QuickBooks displays the Edit Vendor window.

3 In the Vendor Name field, type C.U. Electric. (This is the vendor name you want to 
merge with.)

4 Click OK.

QuickBooks asks if you would like to merge the names.

5 Click Yes.

QuickBooks merges the two names, and you now have only C.U. Electric in the 
Vendor list.

6 Close the Vendor Center.

Note: You cannot merge items on the Fixed Asset Item list. In addition, if you use 
assembly items in QuickBooks Premier Edition products, you cannot merge them with 
other assembly items or with any other type of item.
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Renaming list items

You can rename any list item. When you make the change, QuickBooks automatically 
modifies all existing transactions containing the item.

Note: If you don’t want to change existing transactions, add a new name or item 
instead.

To rename a list item in the chart of accounts:
1 From the Lists menu, choose Chart of Accounts to display the chart of accounts for 

Rock Castle Construction.

2 In the chart of accounts, select Checking.

3 Click the Account menu button, and choose Edit Account.

QuickBooks displays the Edit Account window.

4 In the Account Name field, type Master Checking Account.

5 Click Save & Close.
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QuickBooks changes the account name in the chart of accounts.

6 Close the chart of accounts.

Deleting items and making list items inactive

You can delete list items only if you have not used them in any transactions. If you try 
to delete a list item that is used in a transaction, QuickBooks displays a warning that the 
item can’t be deleted. If you don’t want to use a list item but you can’t delete it, you can 
make it inactive.

To make a list item inactive:
1 On the Home page, click the Customers button (along the left side of the Home 

page).

QuickBooks displays the Customers Center, including the Customers & Jobs list.

2 Select Milner, Eloyse in the list. (Select her name, not the job.)

3 Right-click the name and choose Make Customer:Job Inactive. (You can also click 
Edit Customer and then select the “Customer is inactive” checkbox.)
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Notice that Eloyse Milner (and the job for her room addition) no longer appears on 
the Customers & Jobs list. (The customer and job item is only removed from the 
list—transactions associated with this customer and job will still show in reports.)
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4 To see inactive list items, choose “All Customers” from the View drop-down list.

QuickBooks displays all the list items again, but the Xs signify that this customer is 
still inactive. (You make the customer active again by right-clicking the name and 
choosing Make Customer:Job Active.)

5 Leave the Customer Center open to use in the next exercise.
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Printing a list

You can print a QuickBooks list for reference, or you may print a list to a file to use in 
your word processor or spreadsheet. QuickBooks prints the Customers & Jobs list as it 
appears on the screen. For example, if the Customers & Jobs list is expanded and sorted 
by balance total, QuickBooks prints the expanded list sorted by balance total; if the list 
is collapsed, QuickBooks prints just the customer name, the balance total, and active 
status.

To print the Customers & Jobs list:
1 In the Customer Center, click the Print menu button, and then choose Customer & 

Job List.

QuickBooks displays a message telling you that you can also print list information 
from the Reports menu.

2 Click OK to close the List Reports message.

QuickBooks displays the Print Reports window, which displays the name of your 
printer and printer port.

You can select to print to a printer or to a file.

3 Click Print.

Note: This is a fairly long list, so if you don’t want to print it now, click Cancel.

To print information on one customer:
1 In the Customers & Jobs list, select the customer whose details you want to print.

2 Click the Print menu button, and then choose Customer & Job Information.

QuickBooks displays the Print Customer Information window, which displays the 
name of your printer and printer port.

You can select to print to a printer or to a file.

3 Click Print or Cancel.

If you want to print information for selected customers only, you can generate and filter 
the Customer Contact report for those customers. You can also modify the report to 
include the columns that you want.

To print information for selected customers:
1 From the Reports menu, choose List, and then choose Customer Contact List from 

the submenu.

2 Click Modify Report.

3 Click the Filters tab.

4 Select Customer in the Filter list.

5 In the Customer field, choose Multiple customers/jobs.

6 Make sure Manual is selected and then click to put a checkmark next to those 
customers for which you want to print contact information.

7 Click OK to close the Select Customer:Job window.

8 Click OK to close the Modify Report window.
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9 Print the report.

10 Close the report window. Click No if you are asked whether you want to memorize 
the changed report.

11 Close the Customer Center.

Let students know that if they want to print the list to a file (so they can use it in their 
word processing, spreadsheet, or database program), they can select File and choose the 
appropriate file format from the drop-down list.

QuickStart Tip
QuickBooks has preset reports that let you report on the information in your 
QuickBooks lists. For example, you can create a phone list and a contact list for your 
customers, employees, and vendors. You can also create a price list for the items stored on 
your QuickBooks Item list.

To create a list report, from the Reports menu, choose List, and then choose the list report 
you want to generate.
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Adding or editing multiple items at one time

If you have existing information in Microsoft Excel that you want to add to 
QuickBooks, or if you want to make changes to multiple items, you can do so for items 
in the following lists: Customers, Vendors, Service Items, and Non-inventory Parts.

In this exercise, you will change the zip code for East Bayshore for all your customers 
and vendors in that city.

To change the zip code for multiple items:
1 Go to the Lists menu and choose Add/Edit Multiple List Entries.

2 Use the slider bar at the bottom of the window to move to the right to see the Bill To 
address columns.

3 Make sure that Customers is selected for the List drop-down.

4 For the View drop-down, select All Customers.
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5 In the Find field, type East Bayshore.

6 Click the magnifying glass icon.

7 Use the slider bar at the bottom of the screen to view the Bill To 3 field.

8 Click in the first line to select 94327 and change it to 94329.

9 Repeat to change every item in the list.

10 Click Save Changes.

11 In the List drop-down, select Vendors.

12 In the View drop-down, select All Vendors.
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13 Type East Bayshore in the Find field and click the magnifying glass icon.

14 Use the slider bar at the bottom of the window to move to the right to see the Bill To 
address columns.

15 Since none of the vendors use the 94327 zip code, click Close without making any 
changes.
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Lesson objectives
 To learn how to work with the registers for QuickBooks bank accounts

 To demonstrate how to open a register

 To learn the features common to all registers

 To learn when and how to make entries directly in the register

 To demonstrate how to reconcile a QuickBooks bank account

Supporting materials
 Handout 3: Registers associated with QuickBooks windows

 PowerPoint file: Lesson 4

 Video tutorial: Overview of QuickBooks accounts

Instructor preparation
 Review this lesson, including examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handout 3 ready for distribution.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 4 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Writing a QuickBooks check
You can enter checks directly into the check register by using the QuickBooks Write 
Checks window. When you enter a check at the Write Checks window, you can see the 
address information and easily allocate the check between multiple accounts.

Suppose that you need to write a check to pay Rock Castle Construction’s telephone bill.

To write a check:
1 In the Banking area of the Home page, click Write Checks.

QuickBooks displays the Write Checks window.

The Bank Account field shows the account from which you are writing this check. 
QuickBooks displays the current date in the Date field. (The sample data is set to 
display December 15, 2015 as the current date.) You can change either of these 
values if you wish, but they are fine for our example.
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2 Select the “To be printed” checkbox.

QuickBooks displays a checkmark in the checkbox.

3 In the Pay to the Order of field, type Cal Telephone.

4 Press Tab to move to the Amount field.

QuickBooks has an AutoRecall feature that pre-fills new transactions based on 
previous transactions. You can have QuickBooks pre-fill the expense account for a 
vendor transaction based on previous transactions for that vendor. You can change 
this preference to have QuickBooks fill in the amount as well as other information 
from the last transaction with a payee. This is convenient when you have recurring 
payments of the same amount. To change this preference, choose Preferences from 
the Edit menu. Click General, and then select “Automatically recall last transaction 
for this name” on the My Preferences tab.

5 Type 156.91 (the amount of the telephone bill), and then press Tab.

Notice that QuickBooks spells out the amount of the check for you on the line 
below the payee.
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6 Click in the Account column on the Expenses tab, and then choose 
Utilities:Telephone from the drop-down list.

Your screen should resemble the following figure.

The Expenses tab is where you assign the amount of the check to one of the expense 
accounts on your company’s chart of accounts. In this case, Rock Castle 
Construction assigns the check to its Utilities account and the Telephone 
subaccount. You use the Items tab only when purchasing items you plan to stock in 
inventory. 

If you select the “Pre-fill accounts for vendor based on past transactions” 
preference, QuickBooks remembers all your recent transactions for a vendor, not 
just the most recent one. If you consistently use the same account for a vendor, 
QuickBooks will automatically pre-fill that information any time you select the 
vendor in a bill, check, or credit card transaction.

7 Click Save & Close.
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8 From the Banking menu, choose Use Register.

Rock Castle Construction has more than one type of bank account, so QuickBooks 
displays the Use Register window and asks you to specify the account you want.

9 Click OK to accept Checking as the account whose register you want to see.

QuickBooks opens the Checking register.

Notice that the check you just wrote is listed in the register as a check that needs to 
be printed.

10 Close the Checking account register.

Refer to Handout 3, “Registers associated with QuickBooks windows”

QuickStart Tip
Do NOT use the Write Checks window if you are paying sales tax, paying payroll taxes and 
liabilities, or paying bills that you have entered previously (that is, you are using A/P to 
track them). Instead, use the Pay Sales Tax window for a sales tax payment, the Pay 
Liabilities window for payroll taxes, and the Enter Bills and Pay Bills windows for paying 
A/P bills.
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Using bank account registers
When you work in QuickBooks, you often use forms—such as a check or an invoice—to 
enter information. But behind the scenes, QuickBooks records your entries in the 
appropriate account register. Each balance sheet account listed on the chart of accounts 
has a register associated with it (except the Retained Earnings account).

Opening a register

When you have a QuickBooks form displayed on your screen, you can view its account 
register by choosing Use Register from the Banking menu, or by double-clicking the 
account name in the chart of accounts.

To open a register (when no form is open):
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, double-click the Savings account.

QuickBooks opens the register for Rock Castle Construction’s Savings account.

To complete the exercise:
1 Close the Savings register window.

2 Close the chart of accounts.
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Common features of QuickBooks registers

All QuickBooks registers work the same way, regardless of the accounts with which they 
are associated. Here are some common features of all QuickBooks registers:

 The register shows every transaction that affects an account’s balance and lists them 
in chronological order (though you can change the order by choosing a different 
option from the Sort by drop-down list). For example, in a checking account, the 
register shows checks you’ve written (either with QuickBooks or by hand), deposits 
to the account, and withdrawals from the account.

 The columns in the register give specific information about the transaction. The 
first column is the date. The second column shows a reference number (a check 
number or a vendor’s P.O. number) and a type (to tell you whether the transaction 
represents a check or a bill payment, for example). The next column lists the payee, 
the account to which you’ve assigned the transaction, and any descriptive memo 
you choose to type. The final columns for a bank account show the transaction 
amount (either in the Payment or Deposit column) and whether the transaction has 
cleared the bank (indicated by a checkmark in the column).

 On every transaction line, QuickBooks shows the account’s running balance. The 
bottom of the register window shows the account’s ending balance—the balance 
takes into account all the transactions entered in the register, including checks you 
haven’t yet printed.

Entering a handwritten check
Sometimes you need to write a check on the spot for items you did not plan to purchase. 
QuickBooks lets you write the check, and then enter it later in the checking account 
register or on the check form.

Suppose that while picking up supplies one day, you stop at Bayshore Office Supply and 
find a new office chair on sale for $99.95. The sale ends today, so you write a check on 
the spot. You’ll have to enter it in QuickBooks later.

QuickStart Tip
You can edit transactions in registers with some restrictions: You cannot edit a sales tax 
payment. You can edit split amounts for checks (CHK), deposits (DEP), credit card charges 
(CC), credit card credits (CC CRED), bills (BILL), and vendor credits (BILLCRED) if all the 
amounts are assigned to expense (or other) accounts. (If any amount is assigned to an 
item, you must select the transaction and click Splits to edit the split amounts.)

For all other kinds of transactions, only certain fields can be edited directly in the register. 
To edit one of the transactions without restrictions, select the transaction and click Edit 
Transaction to display the transaction in its complete form.
122



                                                                                                
L E S S O N  4
To enter a handwritten check in the checking account register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Checking.

QuickBooks displays the register for the Checking account.

3 Click in the Number field in the blank transaction at the bottom of the register, then 
double-click to highlight the number that QuickBooks prefills.

4 Type 1204, and then press Tab.

5 In the Payee field, type Bayshore Office Supply, and then press Tab.

QuickBooks displays a message telling you that Bayshore Office Supply is not on the 
Name list.

6 Click Quick Add.

QuickBooks displays the Select Name Type window.

Bayshore Office Supply is a vendor, so you can accept the displayed choice.

7 Click OK.

QuickBooks adds the new vendor to the Vendor list.

8 In the Payment field, type 99.95, and then press Tab.

9 In the Account field, type Of, and then press Tab.

QuickBooks fills in Office Supplies.
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10 In the Memo field, type Office Chair.

The Checking account register on your screen should resemble the following figure.

11 Click Record.

12 Close the Checking account register.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the handwritten check to Bayshore Office Supply. 

Account Title Debit Credit

Checking $99.95

Office Supplies $99.95
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Transferring money between accounts
You can easily transfer money to different accounts using the QuickBooks Transfer 
Funds Between Accounts window. Rock Castle Construction wants to record a transfer 
of $5,000.00 from checking to savings made earlier in the day.

To transfer money:
1 From the Banking menu, choose Transfer Funds.

QuickBooks displays the Transfer Funds Between Accounts window.

Notice that QuickBooks displays the current balance for the Savings account.

2 In the Transfer Funds From field, choose Checking from the drop-down list.

3 In the Transfer Funds To field, choose Savings from the drop-down list.
125



W o r k i n g  w i t h  b a n k  a c c o u n t s
4 In the Transfer Amount field, type 5000.

Your screen should resemble the following figure.

5 Click Save & Close.

6 Click OK at the message because the money has already been transferred in person.

QuickBooks decreases the balance in the checking account by $5,000 and increases the 
balance in the savings account by $5,000.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the funds transfer. 

Account Title Debit Credit

Checking $5,000.00

Savings $5,000.00
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Reconciling checking accounts
Reconciling is the process of making sure that your checking account record matches 
the bank’s record.

An overview of reconciliation

When you keep your records with QuickBooks, you don’t have to worry about addition 
or subtraction errors like you do when you’re using a paper check register. Even so, it is 
important to get in the habit of reconciling your QuickBooks bank accounts on a 
monthly basis. This helps you avoid overdraft charges for bad checks, gives you a 
chance to spot possible bank errors, and helps you keep more accurate financial records.

Your bank sends you a statement for each of your accounts each month. The statement 
shows all the activity in your account since the previous statement:

 The opening balance for your bank account (amount in your account as of the 
previous statement)

 The ending balance for your bank account (amount in your account as of the 
closing date for the statement)

 The amount of interest, if any, you’ve received for this statement period

 Any service charges assessed by the bank for this statement period

 Checks that have cleared the bank

 Deposits you’ve made to the account

 Any other transactions that affect the balance of your account (for example, 
automatic payments or deposits or ATM withdrawals or deposits)

When you receive a statement from your bank or from a credit card company, you need 
to reconcile the statement with your QuickBooks records. You can reconcile any 
QuickBooks bank account, including accounts for savings and money market funds. 
The goal of reconciling is to make sure that your QuickBooks records and the bank’s 
statement agree about your account balance.
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Marking cleared transactions

To begin reconciling an account, you need to tell QuickBooks which account you want 
to reconcile. Then you can provide information from the top part of your bank 
statement.

To reconcile your account:
1 From the Banking menu, choose Reconcile.

QuickBooks displays the Begin Reconciliation window.

2 In the Account field, make sure Checking is selected.

3 In the Statement Date field, type 12/15/2015.

4 In the Ending Balance field, type 34592.98.

5 In the Service Charge field, type 14.00.

6 In the Service Charge Date field, type 12/15/2015.

Your screen should resemble the following.
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7 Click Continue.

QuickBooks displays the Reconcile - Checking window.

You can select which columns you want to display by clicking Columns to Display.

8 Select Mark All.

QuickBooks places a checkmark to the left of all items.

If you need to make a correction to a transaction before you reconcile the account, 
highlight the transaction, and click Go To. QuickBooks takes you to the transaction 
and allows you to return to the reconciliation without losing your work.

9 In the Checks and Payments section, click to clear the checkmark for Wheeler’s 
Tires on 12/12/2008 as well as all transactions after 12/12/2015.
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10 In the Deposits and Other Credits section—click to clear the checkmarks for the 
$500 transfer on 12/17/2007 and all transactions after 12/12/2015.

Your screen should resemble the following figure.

11 Click Reconcile Now.

QuickBooks displays the Select Reconciliation Report window.

Note: If you see the Reconcile Adjustment window instead, click Return to 
Reconcile and make sure that you have cleared all the checkmarks for all items with 
dates later than 12/12/15. Use the scroll bars to see all the items.

12 In the Select Reconciliation Report window, make sure “Both” is selected, and then 
click Display.

13 Click OK at the message that QuickBooks displays.

QuickBooks displays both the reconciliation summary and reconciliation detail 
reports. It’s a good idea to save each reconciliation report, but for the purposes of 
this lesson viewing the reports is sufficient.
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14 Examine the reports to learn what they show and then close the report windows.

Note: QuickBooks Pro overwrites the previous reconciliation report with data from 
the latest reconciliation. If you are using QuickBooks Pro, you may want to print a 
copy of the report, print the report to a file, or save the report in PDF format in case 
you need to reference it again. (To save a report in PDF format, with the report 
displayed, choose Save as PDF from the File menu.) 

If you are using QuickBooks Premier, you can print the reconciliation reports for all 
previous reconciliations.

In addition to the summary and detail reports (which you can view as PDF files), there 
is an additional report option: the Reconcile Discrepancy report. The Reconcile 
Discrepancy report shows changes and deletions made to previously reconciled 
transactions, making it easier to find discrepancies. This report is useful when the 
beginning balance that QuickBooks shows is different than the ending balance from 
the bank statement for the previous period. (To generate the report, choose Reconcile 
from the Banking menu, click Locate Discrepancies, and then click Discrepancy 
Report.)

If the last reconciliation was in error, you can undo it without having to identify and 
manually clear each affected transaction by clicking Undo Last Reconciliation in the 
Locate Discrepancies window.
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Viewing cleared checks in the register

Now you know that the balance in your QuickBooks check register is accurate as of the 
latest bank statement. The next time you look at the check register, you’ll see a 
checkmark in the Cleared column next to each reconciled transaction.

Open the Checking account register to see the cleared checks.

To viewed cleared checks in the register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Checking.

3 Scroll through the register to view the cleared items.

Your register should resemble the figure below.

Notice that QuickBooks displays a checkmark next to all cleared items.

4 Close the Checking account register.
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Locating specific transactions

You can use the QuickBooks Find command to search for specific checks you’ve written. 
For example, suppose you want to find all checks greater than or equal to $500.00 that 
you’ve written during the current year.

To use the Find feature:
1 From the Edit menu, choose Find and then select the Advanced tab.

2 From the Choose Filter list, select Transaction Type.

3 Select Check from the list of transaction types.

4 From the Choose Filter list, select Date, and then choose “This Calendar Year-to-
date.”

5 From the Choose Filter list, select Amount, and then click >= (greater than or equal 
to).

6 Enter 500.00 and click Find.

Your window should resemble the figure below.

7 Close the Find window.
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Lesson objectives
 To introduce the other account types available in QuickBooks

 To learn how to track credit card transactions in QuickBooks

 To reconcile a credit card account

 To see how to make a credit card payment

 To discuss the different types of asset and liability accounts you can create and see 
how to track assets and liabilities in QuickBooks

 To introduce the subject of equity and QuickBooks equity accounts

Supporting materials
 PowerPoint file: Lesson 5

 Video tutorial: Overview of QuickBooks accounts

Instructor preparation
 Review this lesson and the examples, to make sure you’re familiar with the material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 5 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
136



                                                                                                
L E S S O N  5
Other account types in QuickBooks
In this lesson, you’ll learn about these types of QuickBooks accounts:

 Credit card accounts—Used to track transactions you pay for with a credit card.

 Asset accounts—Used to track both current assets (those assets you’re likely to 
convert to cash or use up within one year, such as inventory on hand) and fixed 
assets (such as long-term notes receivable and depreciable assets your business owns 
that aren’t liquid, such as equipment, furniture, or a building).

 Liability accounts—Used to track both current liabilities (those liabilities 
scheduled to be paid within one year, such as sales tax, payroll taxes, and 
short-term loans) and long-term liabilities (such as loans or mortgages scheduled to 
be paid over terms longer than one year).

 Equity accounts—Used to track owner’s equity, including capital investment, 
draws, and retained earnings.

Tracking credit card transactions
Many businesses pay for expenses with a credit card rather than a check. For travel 
expenses especially, a credit card is invaluable because it gives a detailed listing of each 
charge. You can track credit card transactions in QuickBooks just as easily as you track 
expenses you pay for by check.

You should set up a QuickBooks credit card account for each credit card you use in your 
business. Like any QuickBooks account, a credit card account has its own register. The 
register lists all the charges and credits you've recorded, as well as payments you've 
made.

The way you open and scroll through a credit card register is the same way you open and 
scroll through any QuickBooks account register.

Entering credit card charges

QuickBooks lets you choose when you enter your credit card charges. You can enter 
credit card charges when you charge an item or when you receive the bill. Your choice 
depends on whether you like to enter information into QuickBooks incrementally or all 
at once. The advantage to entering charges when you charge an item is that you can 
keep close track of how much you owe. In addition, if the charge is for a particular job, 
you can keep track of how much you’re spending on that job.

Suppose you have a $30 gasoline charge you want to enter into QuickBooks. The form 
you use is the Enter Credit Card Charges form.
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To enter a credit card charge:
1 From the Banking menu, choose Enter Credit Card Charges.

QuickBooks displays the Enter Credit Card Charges window. 

2 In the Credit Card field, select CalOil Card from the drop-down list (if it’s not 
already selected).

3 In the Purchased From field, select Bayshore CalOil Service from the drop-down list.

Notice the Ref No. field. Most credit card receipts have some sort of 
transaction number near the top, which exists for identification and tracking 
purposes. Entering this number from a credit card receipt gives you additional 
information for the credit card charge, but you don't have to use it. You don’t need 
to enter one for this example.

4 Click in the Amount field, and then double-click to select the entire amount.

5 Type 30 and then press Tab.

6 Click the Expenses tab (if it’s not already selected).
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7 In the detail area, click in the Account column and assign the charge to the 
Automobile:Fuel expense account, as shown in the figure below. (Automobile is the 
account; Fuel is the subaccount.)

8 Click Save & Close to record the transaction and close the window.

After you record this credit card charge, QuickBooks adds a $30 transaction to the credit 
card account register (increasing the liability by $30). It also adds $30 to the 
Automobile:Fuel expense account. (You will see the increase when you create reports on 
their expense accounts.)

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the credit card charge. 

Account Title Debit Credit

CalOil Card $30.00

Fuel $30.00

QuickStart Tip
If you used your credit card to purchase a reimbursable expense (you want to pass along 
the expense to a particular customer), you need to indicate this in the Enter Credit Card 
Charges window.
For each expense or item you enter on the bottom part of the form, select the 
appropriate customer in the Customer:Job column. To indicate that this expense should 
be passed along to the customer, make sure the Billable column has a checkmark in it. This 
will allow the expense to be passed along when you invoice the customer.
139



U s i n g  o t h e r  a c c o u n t s  i n  Q u i c k B o o k s
Reconciling a credit card statement

Just as we reconciled a bank account in the previous lesson, you should compare your 
credit card receipts with your statement and reconcile your credit card statement. 
Reconciling a credit card account is almost identical to reconciling a bank account.

To reconcile a credit card statement:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Click CalOil Card in the list once to select it.

3 Click the Activities menu button, and then choose Reconcile Credit Card.

QuickBooks displays the Begin Reconciliation window.

In the Beginning Balance field, QuickBooks displays the balance of all cleared 
transactions in the credit card register. To reconcile a credit card statement, all you 
have to do is enter the ending balance and check off each transaction listed on your 
statement.

4 In the Statement Date field, enter 12/15/2015.

5 In the Ending Balance field, type 101.02.

Note: When the ending balance is different from the previous month’s ending 
balance, check for cleared transactions that are now showing as uncleared.
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6 Click Continue.

QuickBooks displays the Reconcile Credit Card window.

The Reconcile Credit Card window shows all the transactions for the credit card 
account that have not yet cleared. You’ll use this window to check off the 
transactions listed on your statement.

Marking cleared transactions

To mark the transactions as cleared:
1 In the “Charges and Cash Advances” section of the window, select all three charges.

2 In the “Payments and Credits” section of the window, select the 12/02/15 payment 
for $135.80.
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QuickBooks places a checkmark in the column to the left of each transaction you 
select. Your Reconcile Credit Card window should resemble the following figure.

3 Click Reconcile Now.

QuickBooks displays the Make Payment window.

When you’ve finished reconciling a credit card account, QuickBooks gives you a 
chance to pay part or all of the balance due on your credit card.
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4 For this exercise, you want to write a check for payment now, so leave that option 
selected and click OK.

QuickBooks displays the Select Reconciliation Report window.

5 In the Select Reconciliation Report window, select Detail and then click Display.

You don’t need to do so in this exercise, but to keep a record of the reconciliation 
report, you could choose Save as PDF from the File menu and save the report as a 
PDF file.

You could also click Print to print a hard copy of the report. You don’t need to print 
the report for this lesson.

6 Click OK at the message that QuickBooks displays.

7 Review the report and then close it.
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Paying a credit card bill

To write a check for the bill now:
1 In the Write Checks window, make sure Checking is listed as the bank account.

Notice that QuickBooks has already filled in the amount of the payment for you, 
and has assigned the expense to the CalOil Card account. (If you change your mind 
and decide you only want to make a partial payment, you can change the amount 
here.)

2 Click in the Pay to the Order of field and select CalOil Company as the name of the 
credit card company from the drop-down list.
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3 Click the “To be printed” checkbox to select it.

4 Click Save & Close to record the transaction.

QuickBooks subtracts $101.02 from your checking account and also subtracts that 
amount from your credit card account.

5 Close the chart of accounts.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the check to CalOil Company.

Account Title Debit Credit

Checking $101.02

CalOil Card $101.02
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Working with asset accounts
QuickBooks has two account types for tracking the value of your short- and long-term 
assets:

 An Other Current Asset account tracks assets that are likely to be converted to cash 
or used up within one year. If you buy and sell inventory, the value of all your 
inventory on hand is usually shown in an Other Current Asset account called 
something like “Inventory Asset.” Other current assets might include treasury bills, 
certificates of deposit, prepaid expenses (amounts already paid for services your 
business has yet to receive), prepaid deposits (which will be returned to you at a later 
date), reimbursable expenses, and notes receivable (if due within one year).

 A Fixed Asset account tracks assets your business owns that are not likely to be 
converted into cash within a year. A fixed asset is usually something necessary for 
the operation of your business, like a truck, cash register, computer, or 
photocopier.

Discuss with students that some additional examples of other current assets are 
accounts receivable, bank accounts, and cash. QuickBooks provides three types of 
current asset accounts for you to use as you create asset accounts for your company: 
bank account (to track each bank account as well as petty cash), accounts receivable 
(to track money owed to your business), and other current asset.

QuickStart Tip
Some additional examples of other current assets are accounts receivable, bank accounts, 
and cash. QuickBooks provides three types of current asset accounts for you to use as you 
create asset accounts for your company: bank account (to track each bank account as well 
as petty cash), accounts receivable (to track money owed to your business), and other cur-
rent asset.
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Setting up an Other Current Asset account

Suppose you need an Other Current Asset account to track a prepaid expense for rent. 
(The landlord requires a six-month advance payment.)

1 On the Home page, click Chart of Accounts.

2 Click the Account menu button, and then choose New.

QuickBooks displays the Add New Account: Choose Account Type window.

3 Click Other Account Types and choose Other Current Asset from the drop-down 
list.

4 Click Continue.

QuickBooks displays the Add New Account window.
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5 In the Account Name field, type Prepaid rent.

6 Click Enter Opening Balance.

7 In the Opening Balance field, type 6000 and then select the date 12/14/2015.

You should enter the balance of this account had on the day before your 
QuickBooks start date.

8 Click OK.
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9 Click Save & Close.

QuickBooks displays the new account in the chart of accounts.

As each month goes by and you use part of that prepaid expense, you can enter each 
month’s rent as a decrease in the value of the current asset and assign it to the rent 
expense account. You would enter those transactions directly in the register for the 
Prepaid rent asset account.

If you have time, you can have students open the register for the current asset account, 
and show them how to enter a transaction that decreases the value of the asset. If you 
don’t feel you have time to do this, don’t worry: the next section gives students an 
opportunity to enter transactions in a fixed asset account, and the procedure for a 
current asset account is very similar.

Setting up asset accounts to track depreciation

There is more than one way to keep track of depreciation; this is just one suggested 
method. If you have students who are keeping track of asset depreciation in other ways, 
assure them that they can continue using their own method.

Fixed assets are equipment or property your business owns that are not for sale. Since 
they last a long time, you don’t completely charge their cost to the year in which you 
buy them. Instead, you spread their cost over several years. But because fixed assets wear 
out or become obsolete, their value declines constantly from the day you purchase 
them. The amount of this decline in value is called depreciation.

To determine the estimated value of a fixed asset at any point in time, you need to 
subtract its accumulated depreciation (total amount of depreciation since the asset’s 
purchase) from its original cost.

Usually, you’ll want your balance sheet to show the original cost of an asset (plus any 
subsequent improvements) on one line, with the accumulated depreciation subtracted 
from the original cost on a second line, and the current value (net) on a third line. The 
method you’ll learn in this lesson lets you see each asset’s cost and its accumulated 
depreciation separately on your balance sheet. You set up a separate fixed asset account 
for each asset, and two subaccounts under each fixed asset account: one for cost and one 
for accumulated depreciation.
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To set up asset accounts to track depreciation on a new trailer 
purchased by Rock Castle Construction:
1 In the chart of accounts window, click the Account menu button, and then choose 

New.

QuickBooks displays the Add New Account: Choose Account Type window.

2 Select Fixed Asset (major purpose) and click Continue.

3 In the Account Name field, type Trailer.

Do not enter an opening balance.

4 Click Save & Close.

QuickBooks displays the new fixed asset account in the chart of accounts.

Now you need to add two subaccounts: one for the asset’s cost, and the other for 
depreciation.

To add subaccounts:
1 In the chart of accounts window, click the Account menu button, and then choose 

New.

2 Select Fixed Asset (major purposes) and click Continue.

3 In the Account Name field, type Cost.

4 Select the “Subaccount of” checkbox, and then select Trailer as the parent account.
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5 Leave the opening balance blank.

The opening balance is the original cost of the asset, if you purchased the asset 
before your QuickBooks start date. If you’re buying the asset now, as the owner of 
Rock Castle Construction is, you leave the opening balance for the Cost account 
blank. When you enter information about the loan Rock Castle Construction takes 
out to pay for the truck (later in this lesson), you’ll update the Cost account with the 
truck’s original cost.

Your screen should resemble the following figure.

6 Click Save & New.
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7 Repeat steps 3, 4, and 5 to add a second subaccount to the Trailer fixed asset 
account. Call the subaccount “Depreciation,” and do not enter an opening balance.

The Add New Account window should look like this.

8 Click Save & Close to save the Depreciation subaccount.

When you complete these steps, your chart of accounts should look like this.

If you wish, you can change the order in which the accounts are listed by dragging the 
Cost account to the position just above the Depreciation account (the same way the 
accounts are displayed under the Trucks parent account).

Note: The amount you enter as the opening balance depends on whether you acquired 
the asset after or before your QuickBooks start date. If you acquired the asset after your 
QuickBooks start date, you don’t enter an opening balance. If you acquired the asset 
before your QuickBooks start date, you enter the accumulated depreciation of the asset 
as of the start date—entered as a negative number.
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Entering depreciation transactions

When it's time to enter depreciation for an asset, you can use the register for the asset's 
accumulated depreciation account.

Determining the amount of depreciation to deduct can be a complex process, and the IRS 
rules on the subject change often. Students should ask a competent advisor for help in 
figuring actual depreciation amounts for tax purposes.

To enter a transaction for depreciation:
1 In the chart of accounts, select the Depreciation subaccount for the trailer.

2 Click the Activities menu button, and then choose Use Register.

QuickBooks displays the register for the Trailer:Depreciation asset account.

3 In the Decrease column, type 1300 and press Tab. This is the depreciation amount.

4 In the Account field, select Depreciation Expense from the drop-down list.

Your register should resemble the following figure.

5 Click Record.

6 Close the register window.

When you record the transaction, QuickBooks does the following:

 Subtracts the depreciation amount from the current value of the asset in the asset's 
fixed asset account.

 Enters the depreciation amount as an increase to your company's depreciation 
expense in the expense account that tracks depreciation.

QuickStart Tip
When you purchase an asset and pay for it with a company check or credit card, you 
should enter the purchase in the Write Checks or Enter Credit Card Charges window. 
Then, in the Account field, choose the account for the asset.
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Working with liability accounts
QuickBooks has two account types for tracking the value of your short- and long-term 
liabilities:

 An Other Current Liability account tracks liabilities that your company expects to 
pay within a year. Other current liabilities might include short-term loans or a line 
of credit.

 A Long-term Liability account tracks debts that your business is not likely to pay off 
within a year. The most common long-term liabilities are loans that you expect to 
pay off in more than one year.

Tracking a loan with a long-term liability account

You’ve already added an asset account to track the value of the new trailer. Because the 
trailer loan is not going to be paid off in a year or less, you need to add a long-term 
liability account.

To add a long-term liability account:
1 In the chart of accounts, click the Account menu button, and then choose New.

2 In the Add New Account window, select Other Account Types, and then choose 
Long Term Liability from the drop-down list.

3 Click Continue.

4 In the Account Name field, type Trailer Loan.

QuickStart Tip
Some additional examples of other current liabilities are accounts payable, credit card 
accounts, accrued sales tax, and accrued payroll. QuickBooks provides three types of 
current liability accounts for you to use as you create liability accounts for your company: 
credit card (to track credit card charges and payments), accounts payable (to track money 
owed by your business), and other current liability.
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5 Do not enter an opening balance.

Your screen should resemble the figure below.

6 Click Save & Close.

QuickBooks displays the new liability account in the chart of accounts.

Because this is a new loan, you are either receiving money to deposit in your bank 
account or receiving a new asset. In this example, you received an asset (the new trailer), 
so you need to show an increase in the asset’s Cost account.
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To record an increase in the asset’s Cost account:
1 In the chart of accounts, double-click the Trailer:Cost subaccount.

QuickBooks displays the Trailer:Cost register.

2 In the Increase field, type 30,000.

3 In the Account field, select the Trailer Loan long-term liability account from the 
drop-down list.

Make sure that you select the Trailer Loan long-term liability account, not the 
Trailer fixed asset account.

Your screen should resemble the following.

4 Click Record.

5 Close the register window.

6 Close the chart of accounts.

When you complete these steps, QuickBooks increases the value of your Cost asset 
account to 30,000. (This effectively sets the opening balance.) It also enters a liability of 
30,000 in the liability account you use to track the loan. (Again, this sets the opening 
balance.)
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Tracking fixed assets

You can enter the Trailer on the Fixed Asset Item list. Tracking fixed assets using the 
Fixed Asset Item list enables you to record information about an asset such as purchase 
date and price, whether the asset was new or used when purchased, and the asset's sale 
price if you decide to sell it. You can also generate customizable reports listing all your 
fixed assets.

The information you enter in the Fixed Asset Item list does not transfer to the chart of 
accounts.

To create a fixed asset item:
1 From the Lists menu, choose Fixed Asset Item List.

QuickBooks displays the Fixed Asset Item list.
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2 Click the Item menu button, and select New.

QuickBooks displays the New Item window.

The item type is preset as Fixed Asset.

3 In the Asset Name/Number field, type Trailer.

4 Enter the following information to complete the Purchase Information section:

 Item is: new

 Purchase Description: Trailer

 Date: 12/15/2015

 Cost: 30,000

 Vendor/Payee: East Bayshore Auto Mall
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The New Item window should look like the following graphic.

5 Enter the following information to complete the Asset Information section:

 Asset Description: White trailer with company logo

 Serial Number: 123456789

 Warranty Expires: 12/15/2020
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6 From the Asset Account drop-down list, choose Trailer:Cost.

The New Item window should look like the following graphic.

7 Click OK.

8 Close the Fixed Asset Item list.

If you work with an accountant who uses the QuickBooks Fixed Asset Manager (a 
separate application used to work with fixed assets), he or she can determine the 
depreciation of your assets and update your company file with that information. A 
summary of information calculated in the QuickBooks Fixed Asset Manager and sent to 
QuickBooks displays in the Fixed Asset Item list.

Recording a payment on a loan

When it's time to make a payment on a loan, use the Write Checks window to record a 
check to your lender. You’ll want to assign part of the payment to a loan interest 
expense and the remainder to loan principal.

To record a payment on a loan:
1 From the Banking menu, choose Write Checks.

QuickBooks displays the Write Checks window.

2 In the “Pay to the Order of” field, type Great and then press Tab.

QuickBooks fills in the field with Great Statewide Bank. If QuickBooks asks whether 
you want to use the last transaction for this vendor, click No.

3 For the dollar amount of the check, type 500.00.

4 Click in the Account column on the Expenses tab and choose the Interest 
Expense:Loan Interest expense account from the drop-down list.
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5 In the Amount column highlight the amount that QuickBooks prefilled and then 
type 225.00.

6 Assign the remainder of the expense (275.00) to the Trailer Loan long-term liability 
account.

7 Click Save & Close to record the payment.

When you record the transaction, QuickBooks automatically updates the accounts 
affected by this transaction:

 In your checking account, QuickBooks subtracts the amount of the check from your 
balance.

 In the expense account that tracks interest, QuickBooks enters the interest amount 
as an increase to your company's interest expense.

 In the Trailer Loan liability account, QuickBooks subtracts the principal amount 
from the current value of the liability (reducing the amount of your debt).

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the trailer loan payment. 

Account Title Debit Credit

Checking $500.00

Loan Interest $225.00

Trailer Loan $275.00
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Understanding equity accounts

Many students will see the equity accounts QuickBooks automatically adds for them, 
and wonder what equity is all about. Equity can be a complicated subject, especially for 
newer business owners, and a complete discussion of it is not the focus of this lesson. 
This section introduces the subject of equity, and helps students understand why 
QuickBooks creates the two default equity accounts.

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities). If you sold all your assets today and paid off your liabilities using the money 
received from the sale of your assets, the money you’d have left would be your equity.

A balance sheet shows your company assets, liabilities, and equity on a particular date. 
Because equity is the difference between total assets and total liabilities, it’s also true 
that total assets equal the sum of total liabilities and equity.

As you enter the opening balances of your assets and liabilities, QuickBooks calculates 
the amount of equity and records it in an equity account called Opening Bal Equity (Bal 
stands for Balance).

In addition to the Opening Bal Equity account, QuickBooks sets up another type of 
equity account for you called Retained Earnings. This account tracks your company's 
net income from previous fiscal years. QuickBooks automatically transfers your profit 
(or loss) to Retained Earnings at the end of each fiscal year.

If your company is a sole proprietorship (an unincorporated company with only one 
owner), you don’t have to add any more equity accounts to your chart of accounts. All 
the equity belongs to the company’s sole owner.

You can get as involved in tracking equity as you wish. Some people like to track owner 
investments, owner’s draws, and retained earnings prior to their QuickBooks start date 
by putting them in separate equity accounts. If your business is a partnership, you’ll 
probably want to set up separate equity accounts for each partner.

To learn more about equity and to learn how to set up equity accounts for your business, 
search the onscreen Help index for equity.

QuickStart Tip
A common use of an equity account is to record an owner’s draw (a payment you make to 
yourself). To record an owner’s draw, use the Write Checks window to make out a check to 
yourself. In the detail area of the check, assign the amount of the check to the equity 
account you use to record owner draws.
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Lesson objectives
 To learn about the different formats available for sales forms

 To save sales and purchase forms in Portable Document Format (PDF)

 To practice creating a new invoice

 To learn the purpose and use of the QuickBooks Item list

 To see how QuickBooks records the information you enter on sales forms

 To memorize an invoice transaction for reuse

 To add a new item to the Item list

 To add a new price level to the Price Level list

 To associate a price level with a customer

 To create invoice letters

 To generate reminder statements

 To create sales orders (QuickBooks Premier and higher)

 To track backorders (QuickBooks industry-specific editions)

Supporting materials
 Handout 4: QuickBooks item types

 PowerPoint file: Lesson 6

 Video tutorial: Items (products & services you sell)

 Video tutorial: Create an invoice

 Video tutorial: Generate a sales receipt

 Video tutorial: Create a statement

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handout 4 ready for distribution.
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To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 6 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Using sales forms in QuickBooks
Any time you make a sale in your business, you record it in QuickBooks on a sales form. 
A sales form can be an invoice (when you expect payment to come later), a sales receipt 
(when you expect payment at the time you make the sale), or a credit memo.

You use a credit memo when a customer returns merchandise for which you’ve already 

entered a payment or a cash sale. This lesson shows students how to use invoices and 
sales receipts.

When to use different types of sales forms

The type of sales form you use depends on whether you expect payment in the future or 
at the time of the sale.

For payment in the future

If you expect to receive payment at some future date, you enter an invoice. The invoice 
lists the customer’s name and address, along with an itemized list of how much that 
customer owes.
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To display a completed invoice form in QuickBooks:
1 Click the Create Invoices icon on the Home page. If you are prompted to customize 

your QuickBooks forms, click Remind Me Later or No Thanks.

QuickBooks displays the Create Invoices window.

2 Click Previous to display the previously created invoice.

If you own a business that sells products, like Rock Castle Construction, your 
invoice lists the products purchased by the customer, the amount charged for each 
item, and any sales tax you need to apply. Notice that Rock Castle Construction’s 
invoice charges for both products and services (such as labor).

The History section on the right side of the Create Invoices window gives you a 
summary of recent activity related to this customer. You can click the arrow next to 
the name to close the History section of the window.

A business that sells mainly services, such as a consulting firm, might use a different 
type of sales form than the one shown above. QuickBooks lets you choose from 
three different preset formats for your sales forms, or you can create your own 
customized forms.

3 Close the Create Invoices window.
166



                                                                                                
L E S S O N 6
For payment at the time of sale

If you receive full payment at the time you make a sale—either by cash, check, or credit 
card—you fill out a sales receipt instead of an invoice. Like the invoice, the QuickBooks 
sales receipt includes information about the items or services purchased, but it also 
includes information about how payment was made.

To display a completed sales receipt in QuickBooks:
1 On the Home page, click Create Sales Receipts.

2 If the Integrated Payment Interview window appears, close it

QuickBooks displays the Enter Sales Receipts window.

3 Click the Previous button to view the previously entered sale.

The sales receipt is similar to the invoice—both forms display customer information 
and describe the items and services purchased. However, because payment is made 
at the time of sale, the sales receipt has deposit information at the bottom of the 
window.

4 Close the Enter Sales Receipts window.
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Using statements to bill customers

Another option for billing customers is to send statements. Statements are ideal if you 
want to accumulate charges before requesting payment, or if you assess a regular 
monthly charge. Billing statements list the charges a customer has accumulated over a 
period of time.

You enter statement charges one by one, as you perform services for the customer. Later, 
you print a billing statement that shows the previous balance, details of all new charges, 
payments received, and the new balance. Billing statements are appropriate if you want 
to send monthly statements that show the detail of new charges as well as the previous 
balance and payments received.

If you bill the same charge to a group of customers on a regular basis, you can set up 
QuickBooks to enter the charges automatically when it's time to send out your 
statements. Any business that bills a recurring charge on statements can use this feature. 
For more information, search the onscreen Help for recurring transactions for statement 
charges.

Understanding statement limitations

In QuickBooks, statements have the following limitations:

 You can't record sales tax, percentage discounts, payment items, or group items as 
a separate charge on a billing statement. To bill for any of these, you must use an 
invoice.

 You cannot group related charges together and subtotal them (you can group and 
subtotal charges on an invoice).

 A charge on a billing statement can represent only one item (in contrast, an invoice 
can represent many items). This means you must enter a separate statement charge 
for each service or product you sell.

 You cannot add custom fields (for lists or items) to the statement form.

You can include invoice detail on statements and include all open transactions as of a 
certain date.
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Choosing a template for sales forms

QuickBooks has several different templates for invoices. The invoices available depend 
on which version of QuickBooks you are using and the type of company you set up. For 
more information, search the onscreen help for invoice template.

The templates include:

 Custom Invoice—Use this template if you want to tailor a form to your type of 
business.

 Intuit Product Invoice—Use this template if you sell parts or products and need 
fields relevant to shipping.

 Intuit Professional Invoice—Use this template if you sell services and need a lot of 
room for descriptions of your services.

 Intuit Service Invoice—Use this template if you primarily sell services but 
occasionally sell goods.

Each template has an onscreen version and a printed version. This lets you record all the 
sales detail you need, but print only what you want customers to see. For example, if you 
use the Professional Invoice template, the onscreen version shows the number of hours 
you’re billing the client as well as your hourly rate; the printed version shows only the 
Description and the Amount fields.

You can save all QuickBooks sales and purchase forms as portable document format 
(PDF) files. To save a form as a PDF file, display the form and then choose Save as PDF 
from the File menu.

You’ll learn how to customize forms in Lesson 15, “Customizing forms and writing 
QuickBooks Letters.”
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Filling in a sales form
Suppose Rock Castle Construction wants to bill a customer for a portion of a kitchen 
remodeling job. Because they expect payment to be made in the future—rather than 
cash on the spot—they need to create an invoice.

Filling in the customer information

Filling in an invoice is just like filling in a paper form; you enter the customer 
information first, followed by a description of the charges.

To enter customer information on an invoice:
1 On the Home page, click Create Invoices.

Notice that the new invoice already has the current date (12/15/2015 in the sample 
file) entered in the Date field, and the next invoice number assigned in the Invoice # 
field.

2 In the Template field, select Custom Invoice from the drop-down list.

3 In the Customer:Job field, click the arrow next to the drop-down list.

QuickBooks shows you a list of Rock Castle Construction’s existing customers and 
jobs.

4 Choose Jacobsen, Doug:Kitchen for the customer and job.

Because this name has already been entered on the Customer:Job list, QuickBooks 
knows the billing name, the address, and the payment terms. It provides this 
information for you on the top half of the form.
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Filling in the line item area

On the bottom half of the invoice, you list each service or product you’re selling on its 
own line, along with the amount the customer owes for that item. Because information 
about individual items is on separate lines, the lines are called line items.

In QuickBooks, you enter line items using the Item list, so you don’t have to type and 
retype lines for services or products you sell frequently. For example, an architect would 
have one item for design and another for construction supervision.

But items are not just products you sell or services you provide to clients. Line items can 
be anything you might want to put in the detail area of an invoice, like a discount, a 
subtotal line, a markup, or a sales tax calculation.

Rock Castle Construction has already entered the items for which it bills customers on 
its Item list.

To complete the line item area of an invoice:
1 In the Item field, type the letters rem (for Removal).

QuickFill is an alternative to choosing from a list. Whenever you’re in a field where 
you’ll use a list item, you can start typing the first letter or two of the list item you 
want, and QuickBooks fills in the field with the item that matches the letters you’re 
typing.

2 Press Tab.

When you press Tab to accept a QuickFill entry, QuickBooks fills in other
information about the item, like its description and rate. In this case, QuickBooks 
displays “Removal labor” in the Description column and a rate of $35 per hour. All 
you have to do is enter the number of hours.

3 Type 40 in the Quantity column.

4 Press Tab to have QuickBooks update the invoice total.
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Completing the sales form

If you want to check the form before you print it, you can use the print preview feature 
in the Create Invoices window.

To complete and record the invoice:
1 Click the Print Preview button near the top of the screen.

QuickBooks displays the invoice page as it will look when printed.

2 Click Zoom In and use the scroll bars to see the invoice items at greater 
magnification.

3 Click Close.

4 In the Create Invoices window, record the sale by clicking Save & Close.
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QuickBooks records the invoice in your accounts receivable register. If this were a sales 
receipt, QuickBooks would record the sale in your Undeposited Funds account until you 
deposit the money at the bank, or record a deposit in the bank account you specified in 
the Enter Sales Receipts window. (The option to select an account into which you want 
to deposit the payment is only available when the Payments preference “Use 
Undeposited Funds as a default deposit to account” is turned off.)

The accounts receivable register keeps track of how much money your customers owe 
you.

To see the Accounts Receivable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Receivable account.

QuickBooks displays the accounts receivable register.

3 Select the sale we just recorded in the register (for Doug Jacobsen).

4 Double-click the entry.

When you double-click an entry in a register, QuickBooks displays the original form 
(in this case, the invoice).

5 Keep the invoice window open; you’ll use it in the next exercise.
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Make sure students keep this invoice displayed on screen. You’ll show then how to 

memorize it in the next lesson.

QuickStart Tip
When you’ve been using QuickBooks for a while and need to find a particular invoice, you 
can use the QuickBooks Find command or the Search command. Suppose you want to 
search for the invoices you wrote to three particular customers.
Here’s how you’d find those using the Find command:

1 From the Edit menu, choose Find Invoices and then click the Advanced button.

2 In the Find window, select Transaction Type from the list of filters, and then select 
Invoice from the list of transaction types.

3 Select Name from the list of filters, and then choose Multiple names from the Name 
drop-down list.

4 In the window that appears, click the names of the three customers. When you click 
OK and then click Find, QuickBooks finds all the invoices written to those particular 
customers.

You can also find a particular customer invoice by scrolling through the customer 
register for that customer. (Right-click that customer’s name in the Customers & Jobs List 
and choose Use Register.) If you know the invoice number, you can sort the customer 
register by number rather than date to find an invoice more quickly. (You can change the 
sort order by selecting a different order in the Sort By field in the register window.)
Another way to find an invoice for a particular customer is to click the Find icon (magnify-
ing glass) in the Create Invoices window. You can then enter a customer:job name, a date 
range, an invoice number, or an amount that QuickBooks can use to locate an invoice or 
invoices. (This functionality is available for eight common QuickBooks forms.)
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Repeating a sale
Many of the sales you make in your business are ones you repeat again and again. For 
example, you may have a standing monthly order from a customer, or you may perform 
essentially the same services for more than one client. QuickBooks lets you memorize 
sales forms and send batch invoices so that you don’t have to retype the information.

To memorize the invoice:
1 Make sure you have the invoice you want to memorize displayed on your screen.

For this exercise, use the removal labor invoice you just created.

2 From the Edit menu, choose Memorize Invoice.

QuickBooks displays the Memorize Transaction window.

3 In the Name field, type a brief description that helps you recognize the memorized 
invoice, or keep the default description QuickBooks has provided.

You can enter any description you like. Notice that you can also have QuickBooks 
remind you when to use the memorized transaction (for an invoice you always send 
at the end of the month, for example).

4 Click OK.

5 Close the Create Invoices, Accounts Receivable, and the Chart of Accounts 
windows.

When you memorize an invoice, QuickBooks adds it to the Memorized Transaction list.
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To recall a memorized sale:
1 From the Lists menu, choose Memorized Transaction List.

QuickBooks displays the Memorized Transaction List window.

2 Double-click the transaction you just added.

QuickBooks displays the Create Invoices window, with the information you 
memorized displayed on the form. It gives you a new invoice number and displays 
the current date. You can modify the information as you wish, or just save the 
invoice as is.

3 Click Save & Close to record the invoice.

4 Press the Esc key to close the Memorized Transaction list.

To create a batch invoice
1 From the Customers menu, choose Create Batch Invoices.

2 Click OK to close the message.

3 In the Look for field, type shed.
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4 Click Search.

5 In the Billing Group field, type Sheds and click Tab.

6 Click Setup.

7 Click Select All.

8 Click Add.

9 Click Save Group.

10 Click Next.
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11 Enter the following information:

Quantity: 1

Item Code: Repairs

Description: Repair work. Annual shed roof maintenance.

12 Click Next.

13 Review the list of customers to invoice and click Create Invoices.
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14 Click Email.

15 Since you are using sample data you cannot email the invoices, so click Close.

16 Click Close to close the Batch Invoice Summary.

17 Click Create Invoices.

18 Click the Previous button.

19 Review the invoice for annual shed roof maintenance that you created.

20 Click Previous again. 

21 Notice that the information on the invoice is the same.

22 Close the Create Invoices window.
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Entering a new service item
When you begin using your own QuickBooks company file, you’ll need to create your 
own line items to include on your invoices. In the next exercise, you’ll see how to add 
information to the Item list.

Rock Castle Construction already has a service item called Repairs that it uses when it 
wants to charge for general repair work. Suppose Rock Castle wants to add a subitem for 
plumbing repairs to the Item list. (The company charges a higher rate for plumbing 
repairs, so it wants a separate item for it on its Item list.)

Have students refer to Handout 4 for a review of the types of items they can add to the 
Item list.

To create a new service item:
1 From the Customers menu, choose Item List.

QuickBooks displays the Item list for Rock Castle Construction.
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2 Click the Item menu button, and then choose New. If a message about the Add/Edit 
Multiple List Entries item feature appears, click OK to close it.

QuickBooks displays the New Item window.

Note: The options available in the Type list depend on the version of QuickBooks 
you are using. If you are using a QuickBooks Premier or higher edition product you 
will see Inventory Assembly listed as an item type.

3 In the Type field, select Service from the drop-down list if it is not already selected.

4 In the Item Name/Number field, type Plumbing.

5 Click the “Subitem of” checkbox to select it.

6 In the drop-down list below the “Subitem of” field, select Repairs.

7 In the Description field, type Plumbing repairs and maintenance and press Tab.

8 In the Rate field, type 55.

9 In the Tax Code drop-down list, select Non.

Now you need to assign this line item to one of Rock Castle Construction’s income 
accounts.
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10 In the Account field, select Construction:Labor from the drop-down list.

Your screen should look like the following figure.

11 Click OK to add the new item to Rock Castle Construction’s Item list.

12 Close the Item list.

Now that the new item is on the Item list, Rock Castle Construction can invoice for 
plumbing repairs separate from its general repair work. It can also create sales reports 
that show sales for general repairs separate from sales for plumbing repairs.

QuickStart Tip
To offer a discount on an invoice (or other sales form) at the time of sale (for example, for a 
senior discount), create a “discount” type item and enter it as a line item on the form.
If the discount is to apply to more than one item, first use a “subtotal” type item to 
calculate the total of the items. Then, enter the discount item beneath the subtotal.
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Using multiple price levels
In the last exercise, you set up a new service item for Rock Castle construction and 
assigned a price to that item. Sometimes businesses want to vary an item’s price based 
on who they are selling to. For example, Rock Castle Construction charges different 
prices depending on whether it is selling to a residential or a commercial customer.

You can associate price levels with specific customers so that each time you create an 
invoice (or estimate, sales receipt, credit memo, or sales order) for that customer, 
QuickBooks uses the appropriate price level when calculating rates and amounts on the 
form. Price levels make it easy to use different rates on sales forms without having to 
calculate percentage amounts manually. Price levels affect amounts for service, 
inventory, non-inventory part, and inventory assembly items only. (Inventory 
assembly items are available in QuickBooks Premier and higher.)

In this section, you’ll create a new price level, associate it with one of Rock Castle’s 
customers, and then create an invoice for that customer.

Creating new price levels

Rock Castle Construction charges its residential customers the base sales price it set up 
on its Item list. The company charges its commercial customers 10 percent less than the 
base sales price. In this exercise, you’ll create a new price level for Rock Castle 
Construction to use to reduce the sales amount for its commercial customers.

For each price level you create, you assign a name and percentage increase or decrease 
to the item’s base sales price. You can create up to 100 price levels to use on invoices, 
sales receipts, estimates, and credit memos.

To create a new price level:
1 From the Lists menu, choose Price Level List.

2 From the Price Level menu button, choose New.

3 In the Price Level Name field type Commercial.

4 From the Price Level Type drop down list, select “Fixed %.”

Note: The Price Level Type field is selectable only with QuickBooks Premier or 
higher.
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5 Leave “decrease” selected in the “This price level will” field, and then type 10 in the 
percentage field.

Always enter the percentage as a positive number.

6 From the “Round up to nearest” drop-down list, choose “1.00 minus .01.”

This option rounds all the prices to the nearest dollar amount minus one cent, for 
example, $10.00 rounds to $9.99. With QuickBooks, you can round your prices to 
the nearest whole cent, or you can precisely determine the amount by creating a 
user defined option.

Your window should look like the following.

7 Click OK.

Your Price Level list should now resemble the following.

8 Close the Price Level list.
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Associating price levels with customers

When you assign price levels to customers, QuickBooks calculates rates and amounts on 
sales forms based on the price level associated with that customer.

To associate a price level with a customer:
1 Click Customer Center on the icon bar. 

2 In the Customers & Jobs list, select Lew Plumbing - C.

3 Click Edit Customer.

If a message about the Add/Edit Multiple List Entries item feature appears, click OK 
to close it.

4 Click the Additional Info tab.

5 From the Price Level drop-down list, choose Commercial.

Your screen should look like this.

6 Click OK to close the Edit Customer window and save your changes.

Leave the Customer Center open for the next exercise.
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Using price levels on sales forms

In this section, you’ll create an invoice for the customer with whom you just associated 
the Commercial price level to see how the price level affects amounts on the form.

To use a price level associated with a customer:
1 Make sure Lew Plumbing - C is selected in the Customers & Jobs list.

2 Click the New Transactions menu button and choose Invoices from the drop-down 
menu.

3 Press Tab.

Notice that QuickBooks displays the name of the price level associated with this 
Customer:Job in brackets above the Customer:Job drop-down list. (This 
information will not be printed on the form.)

4 Click in the Item column and choose Framing from the drop-down list. 

If you don’t see the Item column, make sure you are using the Custom Invoice 
template.

5 In the Quantity field, type 8.

6 Click below Framing in the Item field and choose Wood Door:Exterior from the 
drop-down list.
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7 In the Quantity field, type 2 and then press Tab.

Your screen should look like this.

8 Keep the invoice open and choose Item List from the Lists menu.

9 In the Item list, go to Framing. Note that the price for framing is $55.00, but the rate 
on the invoice is $49.99—10 percent less than the base sales price, rounded to the 
nearest dollar minus one cent. QuickBooks has automatically reduced the rate on 
the invoice by 10 percent and rounded the amount according to your price level 
setting.

Note: You can set up QuickBooks to round rates up to the nearest cent. You can set 
the rounding option for a rate from the Price Level list. See “Creating new price 
levels” on page 183.

10 In the Item list, scroll to the Wood Door:Exterior item and note that the base sales 
price is $120—10 percent greater than the rate listed on the invoice using the 
Commercial price level. It appears on the invoice as $107.99, including the 
discount and rounding settings.

11 Close the Item list.

12 Record the invoice by clicking Save & Close.
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Assigning price levels to individual line items

In addition to associating price levels with customers, you can also use price levels on an 
individual basis on sales forms. The following are some examples of when you might 
want to do this.

 You’ve associated a price level with a customer, but want to charge the base sales 
price for an item on a sale to that customer.

 You want to use a price level for one or more items, but you don’t want to assign a 
price level to the customer for whom you’re recording the sale.

To apply a price to a single line item:
 In a sales form with line items, click in the Rate column and select the price level you 

want to use from the drop-down list that displays.

When you move out of that field on the form, QuickBooks recalculates the amount 
and balance due.

Note: If you use QuickBooks Premier, you can refine your price levels even further by 
setting price levels for select items. For example, you could give a particular customer or 
group of customers an extra discount for a specific item or group of items as shown in 
the following graphic.
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Managing overdue customer payments
You can create documents to remind customers about overdue payments.

The first method involves creating a letter to a specific customer directly from that 
customer’s overdue invoice. Using this method, you can create a cover letter that 
summarizes information about the original invoice and lists the outstanding balance. 
You can also have QuickBooks list all of the line-item information. An additional 
option is to have QuickBooks format the letters to work with window envelopes.

The second method involves generating reminder statements, which allow you to 
generate documents that list recent invoices, credit memos, and payments received.

Using the Collections Center

The Collections Center helps you manage collecting payments from your customers. It 
lists all overdue and almost due invoices in a single place. You can send email reminders 
to one customer or many customers, and it tracks customer notes about your collection 
efforts.

To review overdue and nearly due payments for all customers:
1 Click the Customer Center icon.

2 Click Collections Center.

3 Notice that you have no Overdue invoices. Click the Almost Due tab.

4 Close the Collections Center.
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Creating invoice letters

Rock Castle has noticed that one of its customers has an invoice with a partial balance 
still outstanding and wants to send a quick reminder. You create an invoice letter to 
remind the customer about the unpaid balance.

To create an invoice letter:
1 From the Reports menu, choose Customers & Receivables, and then choose Open 

Invoices from the submenu.

2 In the report window, scroll down until you see the listings for Anton Teschner:Sun 
Room.

3 Double-click on the line for invoice # 60.

4 In the Create Invoices window, click the down arrow next to the letter and envelope 
icon to display the drop-down list.

5 Select Prepare an Invoice Letter.

If QuickBooks prompts you to find letters, click Copy. QuickBooks will copy the 
QuickBooks letters from your installation directory to your QBtrain folder.

6 Choose Cover Letter.

If you wanted to include all of the line-item detail from the invoice, you would 
choose the Invoice Letter with Details option.

7 Click Next.

8 Type Tom Ferguson in the Name field and then type President in the Title field.

9 Click Next.
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QuickBooks displays a letter containing summary information pulled from 
QuickBooks about the unpaid balance on the invoice.

10 You don’t need to save the letter for this exercise, so close the Microsoft Word file 
without saving.

11 In QuickBooks, click Cancel because you don’t need to print envelopes now.

12 From the Window menu, choose Close All.

To create your own custom letters that pull information from the Customers & Jobs, 
Vendor, Employee, and Other Names lists in QuickBooks, see “Using QuickBooks 
Letters” starting on page 439.

Generating reminder statements

Reminder statements summarize a customer's account with a company by listing recent 
invoices, credit memos, and payments received. You can use reminder statements when 
you bill through invoices but want to remind your customers about delinquent 
payments.

Reminder statements are different than other “forms” in QuickBooks such as invoices, 
sales receipts, or checks. Because QuickBooks already has all the information you need 
to create reminder statements, you don't have to fill them out. Instead, you review the 
information that will appear on each statement, decide whether to add finance charges, 
and print them.

Rock Castle uses invoices to bill its customers, but it sends reminder statements to 
customers with overdue invoices. In this exercise, you generate statements to send to 
customers with outstanding balances.
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Rock Castle wants to send reminder statements to all customers who have balances 
more than 30 days past due.

To generate reminder statements:
1 Click Home to display the Home page, then click Statements.

QuickBooks displays the Create Statements window.

2 For Statement Date, enter 1/15/2016.

3 In the Enter Statement Date and Type section of the window, select the “All open 
transactions as of Statement Date” option.

4 Click to select the “Include only transactions over” checkbox.

5 Leave the number of days past due field entry at 30.

6 In the Select Customers section, select “All Customers.”

7 In the Select Additional Options section, click to select the “Show invoice item 
details on statements” checkbox.

8 Click to select “Do not create statements with a balance less than 0.00.”
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Your screen should look like the following graphic.

9 Click Assess Finance Charges.

QuickBooks displays the Assess Finance Charges window.

10 Verify that there is a checkmark next to Lew Plumbing - C.

Your screen should look like the following graphic.
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11 Click Assess Charges.

12 Answer Yes when QuickBooks displays the message telling you that finance charges 
have already been assessed today.

QuickBooks creates a finance charge invoice for Lew Plumbing - C in the amount of 
$5. This amount does not display on the current statement, but you can send the 
finance charge invoice with the reminder statement.

13 Click Preview.

QuickBooks displays reminder statements for the customers whose balances are 30 
days or more past due—including the details from the original invoices.

14 Click Close.

At this point you could generate and send the reminder statements to your 
customers.

15 Close the Create Statements window.

Processing sales orders
The sales order feature lets you track orders from customers and “set items aside.” You 
can also use sales orders to track back orders when a customer orders something and you 
are out of stock. Using this feature, you can track the orders you need to fill without 
affecting accounts receivable. Sales orders affect only inventory quantities—not 
values—until you actually sell the items.

When inventory items come in, you can create an invoice directly from the sales order. 
If only some of the items have come in, you can invoice for those items, and use the sales 
order to create invoices for the remaining items later. Once all items have been received 
and invoiced for, QuickBooks Premier closes the sales order.

Note: Sales orders are available in QuickBooks Premier and higher editions only. To 
proceed through this exercise, you must be using QuickBooks Premier or a higher 
edition.

Invoicing against sales orders

In this exercise, you’ll create an invoice from a sales order. You display a report to see if 
there are any open sales orders. The report shows that there is an open sales order for 
Lumber for Fran Smallson. Rock Castle now has sufficient quantity on hand to fill the 
customer’s order, so you can close the sales order and invoice the customer.

If you’re using QuickBooks Premier, you can also generate purchase orders directly from 
sales orders by clicking the down arrow on the Create Invoices button in the Create Sales 
Order window, and then selecting Purchase Order. You don’t need to create the 
purchase order in this exercise.
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To create an invoice from a sales order:
1 Click Report Center, choose Sales and then select Open Sales Orders by Item.

2 Click Display Report.

QuickBooks displays the Open Sales Orders by Item report.

3 Double-click the sales order for Decking in the report window (Sales Order #2 for 
Fran Smallson).

QuickBooks opens the sales order.
195



E n t e r i n g  s a l e s  i n f o r m a t i o n
4 Click the Create Invoice menu button on the toolbar at the top of the Create Sales 
Orders window.

Creating the invoice from the sales order links the sales order and invoice, which 
means that when you invoice the customer for items on the sales order, those items 
are marked as closed.

QuickBooks displays the Create Invoice Based On Sales Order window.

5 Leave the “Create invoice for all of the sales order(s)” option selected, and click OK.

QuickBooks creates an invoice for the customer.

In this case, all of the items the customer order arrived, so you can close the sales 
order. If only some of the items had come in, you could invoice for only those items 
and keep the sales order open until any remaining items arrived. QuickBooks tracks 
which items are still open.

6 In the Create Invoices window, click Save & Close.

7 Close the report window and the Report Center.

Tracking backorders
Using certain industry-specific QuickBooks Editions, you can use sales orders to track 
items that customers have ordered, but that are out of stock. Tracking backorders on 
sales orders, invoices, and other sales forms shows exactly what still needs to be shipped 
out. Tracking backorders on purchase orders shows what is still expected to be received 
from a vendor.

In this exercise, you’ll first create a sales order and create an invoice from that sales 
order. (The customer has ordered items, but you don’t have sufficient quantities to fill 
the entire order.) Then, you’ll receive items into inventory and track the remaining 
items on backorder.

Note: You must be using QuickBooks Premier Accountant Edition, Retail Edition, 
Manufacturing and Wholesale Edition, or Enterprise Solutions Editions to track 
backorders and perform this exercise.
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To create a sales order:
1 On the Home page, click Sales Orders.

QuickBooks displays the Create Sales Orders window.

2 In the Customer:Job drop-down list, select Roche, Diarmuid:Room Addition.

3 Click in the Item column and select Frames:Exterior Frame from the drop-down list.

4 In the Ordered column, click the Availability icon.

In the Current Availability window, you can get information about what is 
available in inventory, what is listed on other sales orders, what’s reserved for 
assemblies, and what’s on order. 

Notice you have two exterior frames available. However, you need four exterior 
frames to complete the room addition. So you’ll need to put the remaining two on 
backorder.

5 Click Close, and then type 4 in the Ordered column.
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6 Press Tab, and then click OK at the two messages that appear.

7 Type 40.00 in the Rate column.

8 Press Tab again to have QuickBooks update the total.

The sales order should look like the following graphic.

You can fill part of the order now because you have two exterior frames in stock, so 
you’ll create an invoice from the sales order.

9 In the Create Sales Orders window, click the arrow next to the Create Invoice menu 
button on the toolbar and choose Invoice.

This links the sales order and invoice, which means that when you invoice the 
customer for items on the sales order, those items are marked as closed.

QuickBooks displays the Create Invoice Based On Sales Order(s) window.

10 Click “Create invoice for selected items” and click OK.
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QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) 
window. When you create the invoice for selected items only, you indicate how 
many of each item from the sales order you want to include on the invoice.

Note: You can click the “Show quantity available instead of quantity on hand” 
checkbox to display the number of items in inventory plus the number of items on 
purchase orders with vendors, minus the number listed on all other sales orders and 
quantity on pending builds.
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11 Make sure 2 appears in the To Invoice column and click OK to invoice for the two 
exterior frames you have in inventory.

QuickBooks displays the invoice. The invoice lists how many of each item has been 
invoiced previously and how many are included in the current invoice.

12 Click Save & Close.

QuickBooks creates an invoice for the two door frames in stock and puts the other 
two on backorder.

The Open Sales Orders by Item report can help you track which items are on backorder 
by showing the quantity ordered and the quantity invoiced. (To run the report, go to 
the Reports menu, choose Sales, and then choose Open Sales Orders by Item.)
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Receiving items

Rock Castle Construction has just received 10 exterior door frames from 
Perry Windows & Doors. Before you can invoice Diarmuid Roche for the door frames on 
backorder, you need to receive the items into inventory.

To receive items into inventory:
1 From the Vendors menu, choose Receive Items.

2 In the Create Item Receipts window, choose Perry Windows & Doors from the 
Vendor drop-down list.

3 Click No at the message that appears.

4 In the Item column, select Frames:Exterior Frame.

5 Press Tab twice to go to the Quantity column and type 10.

6 Press Tab and QuickBooks updates the amounts.

Your screen should resemble the following graphic.

7 Click Save & Close.
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Once you’ve entered the items into inventory, you have sufficient quantity on hand to 
finish filling Diarmuid’s order. 

To fill Diarmuid’s order:
1 From the Customers menu, choose Create Sales Orders.

2 Click the Previous button to display Diarmuid’s sales order.

Notice that QuickBooks helps you track backordered items by adding a Backordered 
column to sales orders. (Backordering always starts from sales orders.) In addition, 
you’ll see Invoiced and Clsd columns. Once the sales order is either fully invoiced 
or closed, the Backorder column no longer displays. The Invoiced and Clsd columns 
always appear. 

3 In the Create Sales Orders window, click the Create Invoice menu button on the 
toolbar.

QuickBooks displays the Create Invoice Based On Sales Order window. 
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4 Click “Create invoice for selected items” and click OK.

QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) 
window. When you create the invoice for selected items only, you indicate how 
many of each item from the sales order you want to include on the invoice.

5 Make sure 2 appears in the To Invoice column and click OK to invoice for the two 
exterior frames for Diarmuid’s room addition.

QuickBooks displays the invoice. On the invoice, QuickBooks lists how many of 
each item has been invoiced previously and how many are included in the current 
invoice.

You can customize invoices to display a Backordered column. See Lesson 15, 
“Customizing forms and writing QuickBooks Letters.”

6 Click Save & Close to save the invoice and close the Create Invoices window.

7 On the Home page, click Sales Orders.
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8 Click the Previous button to display Diarmuid’s sales order.

Notice the sales order now indicates that it has been invoiced in full.

9 Close the Create Sales Order window.

Tracking backorders on purchase orders

A backorder is the inventory on a purchase order that has not yet been received. In 
QuickBooks this occurs when a purchase order has been sent, a partial shipment has 
been received, but you have not received the final shipment. The items on the purchase 
order that have not yet been received are considered to be on backorder.

Backordered and Rcv'd columns automatically appear after a purchase order has been 
partially received.

Note: You can customize your purchase order template if you want the Backordered 
column to be printed on the purchase order.
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Lesson objectives
 To learn how to record customer payments in QuickBooks

 To learn how to handle customer discounts, partial payments, overpayments, or 
down payments

 To see how to record a deposit in QuickBooks, and learn how QuickBooks treats the 
deposit behind the scenes

 To learn how to enter cash back from a deposit in QuickBooks

Supporting materials
 PowerPoint file: Lesson 7

 Video tutorial: Enter and deposit customer payments

 Video tutorial: Handling upfront deposits and retainers

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 7 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Recording customer payments
If you’re receiving payment at the time of a sale, and you fill out a sales receipt, 
QuickBooks records a customer payment. When you invoice a customer, and you 
receive payment later, you enter the payment in the QuickBooks Receive Payments 
window.

The Receive Payments window lets you match up payments you receive with invoices 
you’ve written. You’ll be working with the Receive Payments window in this lesson.

Recording a payment in full for a single job

The simplest case is when a customer has one outstanding invoice for one job and sends 
you a payment for the full amount. Suppose that Rock Castle Construction receives a 
check for $4735.73 from Mike Violette for his workshop. Here’s how you’d enter the 
payment.

To record a payment in full:
1 From the Customers menu, choose Receive Payments.

2 If the QuickBooks Payment Interview window displays, close it.

QuickBooks displays the Receive Payments window.

The first step is to enter the name of the customer from whom you’ve received
a payment.

3 In the Received From field, select Violette, Mike:Workshop from the 
drop-down list.

QuickBooks displays the outstanding invoice for Mike Violette.

4 Press Tab to move to the Amount field.
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5 In the Amount field, type 4735.73 and press Tab.

QuickBooks updates the amount in the Payment field to 4735.73, and applies the 
payment to the one outstanding invoice.

6 In the Payment Method field, select Check from the drop-down list and then press 
Tab.

When you enter a preferred payment method in a customer’s record, QuickBooks 
pre-fills that information when you select the customer’s name in this window.

7 In the Check # field, type 6745.

8 Click Save & New.

This records the payment and clears the window so you can enter another one.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the payment. 

Account Title Debit Credit

Undeposited Funds $4,735.73

Accounts Receivable $4,735.73
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Entering a partial payment

Rock Castle Construction has also received a check for $1,000 from Ecker Designs. Ecker 
Designs has two outstanding invoices and owes more than $6,000.

To enter a partial payment:
1 In the Received From field, select Ecker Designs:Office Repairs from the drop-down 

list.

In the middle of the window, QuickBooks shows you the invoices still outstanding 
for the job. In this case, there are two.

2 Press Tab to move to the Amount field, and then type 1000. Then press Tab again.

QuickBooks automatically applies the payment you’ve entered to Ecker Design’s 
oldest invoice.

To choose which invoice a payment applies to, rather than having QuickBooks 
apply it to the oldest one, you can un-apply the payments and apply them as you 
wish. If you always want to select the invoice yourself, turn off the Sales & 
Customers preference “Automatically apply payments.”

3 Click Un-Apply Payment.
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4 In the Payment column, type 1000 as the amount you want to apply to the second 
invoice, and then press Tab.

5 In the Pmt. Method field, leave Check selected.

6 In the Check # field, type 5678.

7 Leave the “Leave this as an underpayment” option selected.

8 Click Save & New to record the partial payment and clear the window.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the partial payment.

Account Title Debit Credit

Accounts Receivable $1,000.00

Undeposited Funds $1,000.00
210



                                                                                                
L E S S O N 7
Applying one payment to multiple jobs

Rock Castle Construction is working on several jobs for a customer, Brian Cook. Brian 
has payments outstanding for four invoices. He wants to write one check to cover all 
outstanding payments.

In this exercise, you’ll apply this single payment to invoices for multiple jobs.

To apply one payment to multiple jobs:
1 In the Receive Payments window, select Cook, Brian from the Received From 

drop-down list.

QuickBooks lists the open invoices for all of the jobs associated with Brian Cook.

2 Press Tab to move to the Amount field.

3 In the Amount field, type 7812.63 and then press Tab.

Notice that QuickBooks applies the payment to all outstanding invoices.

4 In the Pmt. Method drop-down list, make sure that Check is selected.
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5 In the Check # field, type 375.

Your window should look like this.

6 Click Save & New.

Entering overpayments

If a customer sends you an overpayment, you simply enter the amount in the Receive 
Payments window, and QuickBooks keeps track of the additional payment. When the 
customer has future invoices, you can apply the overpayment to those amounts—you 
can even apply the credit directly to the invoice.

Suppose that Rock Castle Construction has received a payment of $12,500.00 from 
Pretell Real Estate for the 75 Sunset Rd. job. The outstanding invoice for that job is 
$12,412.18.

To enter the payment:
1 In the Received From field of the Receive Payments window, select 

Pretell Real Estate:75 Sunset Rd. from the drop-down list.

QuickBooks displays an invoice dated 12/01/2015 for $12,412.18.

2 Press Tab and type 12500 in the Amount field.
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3 Press Tab again.

QuickBooks shows an overpayment amount of $87.82 and prompts you to choose 
whether to leave the credit to be used later or to refund the amount to the customer. 
You want to refund the overpayment.

4 Select “Refund the amount to the customer” option.
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5 Click Save & New.

6 In the Issue a Refund window, click OK.

Handling down payments or prepayments

If a customer makes a payment before you’ve invoiced him for services (for example, he 
may be making a down payment or paying a retainer fee), you can still record the 
payment at the Receive Payments window. However, because you don’t have any 
invoices to which to apply the payment, QuickBooks records the payment as an unused 
payment (just like an overpayment).

QuickBooks holds the unapplied amount with the customer’s name. The next time you 
enter that customer in the Receive Payments window, QuickBooks displays the credit 
amount in the Unused Credits area. The customer’s balance also reflects the credit 
amount.

Suppose Kristy Abercrombie wants Rock Castle Construction to do a kitchen 
remodeling job for her. She’s sent Rock Castle Construction a check for $1,000 as an 
initial payment, but the company hasn’t invoiced her yet.

QuickStart Tip
To apply a discount for early payment for any customer whose payment terms include a 
discount for payment before the due date, use the Set Discount button in the Receive Pay-
ments window.

Even if the customer has already sent you a payment for the full amount of the invoice, 
you can apply a discount. QuickBooks holds any credit amount in accounts receivable 
until you apply it to an invoice or issue a refund check.
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To enter the down payment you’ve received:
1 In the Received From field, select Abercrombie, Kristy:Kitchen from the 

drop-down list and then press Tab.

2 Type 1000 in the Amount field and then press Tab.

QuickBooks displays the payment as an overpayment.

3 Leave the “Leave the credit to be used later” option selected.

4 In the Pmt. Method field, make sure Check is selected.

5 In the Check # field, type 4321.

6 Click Save & Close.

7 Click OK in the message that displays.

Later, Rock Castle Construction is ready to prepare its invoices and needs to invoice 
Kristy for the labor the workers have already completed on the job.

To create an invoice for a customer who made a down payment:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, select Abercrombie, Kristy:Kitchen from the drop-down 
list.

3 QuickBooks displays the Available Estimates window. You don’t want to create the 
invoice from the estimate listed, so click Cancel.

4 From the Template drop-down list, choose Custom Invoice.

5 Click in the Item column, select Removal from the Item drop-down list, and then 
press Tab.
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6 In the Quantity column, type 40 and press Tab.

7 Notice that the $1000 payment you entered appears in the Recent Transactions list 
of the Customer Snapshot.

8 Click Apply Credits to apply the down payment amount made earlier towards this 
invoice.

9 Click Yes at the message that displays.

QuickBooks opens the Apply Credits window displaying the credit you entered 
earlier.
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10 This is the credit that you want to apply to the invoice, so click Done.

QuickBooks updates the invoice and displays the remaining balance due ($400) on 
the invoice.

QuickBooks applies the existing credit to the new invoice.

11 Click Save & Close to record the transaction.

QuickStart Tip
To see all the transactions related to customers (grouped by customer and job), create a 
customer balance detail report. (From the Reports menu, choose Customers & Receivables, 
then choose Customer Balance Detail.)
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Making deposits
When you use the Enter Sales Receipt window (for a sales receipt where you receive 
payment on the spot), the Receive Payments window (for payments on invoices), or a 
payment item on an invoice, QuickBooks keeps track of the money you’ve received 
until you deposit it in the bank. When you receive payments from customers, you can 
either deposit each payment directly into a QuickBooks bank account or you can group 
payments together to be moved to that account at a later time. 

Selecting payments to deposit

At your office, you might hold payments in a locked cash drawer or a cash register until 
you can get to the bank; QuickBooks holds the amount in an asset account called 
Undeposited Funds. When you’re ready to take your payments to the bank, you can 
record the deposit in QuickBooks, print a deposit slip to bring with you, and enter cash 
back amounts.

To select payments to deposit:
1 From the Banking menu, choose Make Deposits.

QuickBooks displays the Payments to Deposit window, which lists the payments 
you have not yet deposited.
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2 Click to select the payments you want to bring to the bank.

For this exercise, select the payments you recorded from Mike Violette, Ecker 
Designs, Brian Cook, Pretell Real Estate, and Kristy Abercrombie.

3 Click OK.

QuickBooks displays the Make Deposits window, which shows the payments you 
just selected.
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4 In the Deposit To field, make sure that Checking is selected.

Note: If you have money to deposit that is not the result of a payment you received 
for a sale, you can enter it in the detail area of the window. For example, if you 
received a premium refund from your insurance vendor, you would enter it here.

QuickBooks updates the deposit total at the bottom of the window automatically. If 
you wanted to print a deposit slip to take to the bank, you would click Print. The 
Printable Deposit Slips that you can order to work with QuickBooks work only with 
deposits of cash and checks.

5 Click Save & Close to record the deposit.

How QuickBooks handles the deposit

QuickBooks updates the Undeposited Funds account to show that you’ve made a 
deposit. It also adds the deposit to your checking account register.

To view the Undeposited Funds account:
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, double-click the Undeposited Funds account.

QuickBooks displays your deposits and reduces the balance in the account by the 
amount of the deposits.

3 Close the account register window.

Now you can look at the deposit transaction in the checking account.
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4 In the chart of accounts, double-click the checking account.

QuickBooks has entered the deposit as a transaction in the checking account 
register and has updated the balance of your checking account.

5 Close the checking account register and the chart of accounts.

QuickStart Tip
You can create a report that shows you a list of all deposits and the payments included in 
each deposit. From the Reports menu, choose Banking, and then choose Deposit Detail.
221



R e c e i v i n g  p a y m e n t s  a n d  m a k i n g  d e p o s i t s
Getting cash back from a deposit

In the Make Deposits window, you can enter information about any cash you took out 
of the deposit when you are recording the deposit.

To record getting cash back from a deposit:
1 On the Home page, click Record Deposits.

QuickBooks displays the Payments to Deposit window. Notice that the deposits you 
made in the last exercise are no longer listed.

2 In the Payments to Deposit window, select the payment from Doug Jacobsen.

3 Click OK.

4 In the Make Deposits window, type Petty Cash in the “Cash back goes to” field and 
press Tab.

5 When QuickBooks displays a message telling you that Petty Cash is not on the 
account list, click Set Up.

QuickBooks displays the Add New Account window with the account name preset 
to Petty Cash.
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6 Make sure Bank is selected in the Type drop-down list, and then click Save & Close 
to return to the Make Deposits window.

7 In the “Cash back amount” field, type 200 and press Tab.

QuickBooks displays the deposit subtotal amount ($2000.00) and the total less the 
cash back amount ($1800.00).

8 Click Save & Close.

QuickBooks records the Deposit Total amount in your checking account and the 
cash back amount in your Petty Cash account. 
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9 To see the effect on these accounts, choose Chart of Accounts on the Home page.

10 Close the chart of accounts.
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Lesson objectives
 To discuss the different ways you can handle bills in QuickBooks

 To learn how to enter a bill in QuickBooks

 To use the Pay Bills window to pay a bill in QuickBooks

Supporting materials
 PowerPoint file: Lesson 8

 Video tutorial: Write checks and enter expenses

 Video tutorial: Enter bills

 Video tutorial: Pay bills

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 8 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Handling bills in QuickBooks
When you have a business expense, you can handle it in one of the following ways: 

 You can write a check manually and enter the information into a QuickBooks check 
register later. This doesn’t take advantage of features in QuickBooks, but sometimes 
it’s necessary. For example, if you purchase supplies at a retail store, they expect 
payment on the spot, and you may not know the amount in advance.

 You can use QuickBooks to write and print a check. When you receive a bill that you 
want to pay immediately, you can write a QuickBooks check more quickly and 
accurately than you can by hand. An additional advantage is that QuickBooks 
makes the entry in the checking account register for you.

 You can use the QuickBooks accounts payable feature to track the amounts you owe 
to vendors, track your cash flow needs, and handle bills you want to pay later.

 You can pay by credit card and enter the credit card receipt into QuickBooks later.

Lesson 4, “Working with bank accounts,” shows you how to enter a handwritten check 
and a QuickBooks check. In Lesson 5, “Using other accounts in QuickBooks,” you learn 
about credit card accounts. This lesson shows you how to manage accounts payable.

Using QuickBooks for accounts payable
Some business owners, especially if they own smaller, home-based businesses, pay their 
bills when they receive them. Most business owners, however, find it more convenient 
to pay bills less often. (They also like keeping the cash in the company for as long as 
possible.) If you don’t plan on paying your bills right away, QuickBooks can help you 
keep track of what you owe and when you owe it.

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the 
Accounts Payable account to track all the money you owe. Like any QuickBooks balance 
sheet account, the Accounts Payable account has a register where you can view all your 
bills at once.
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To see the Accounts Payable register:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Double-click Accounts Payable in the list to open the register.

QuickBooks displays the Accounts Payable register.

The register keeps track of each bill you have entered, shows you the due date, and 
keeps a running balance of all the bills you owe. As a business owner, this helps you 
forecast your cash flow, and the QuickBooks reminder system helps you pay your 
bills on time.

3 Press Esc twice to close the open windows.

Using accounts payable to pay your bills involves two steps: entering the bill, and 
paying the bill. You’ll practice both steps in this lesson.
228



                                                                                                
L E S S O N 8
Entering bills
When you receive a bill from a vendor, you should enter it into QuickBooks as soon as 
you can. This keeps your cash flow forecast reports up to date and doesn’t give you the 
chance to set aside a bill and forget it.

Rock Castle Construction received a bill from the company that created its new 
brochures. The bill includes a charge for courier delivery. Rock Castle Construction 
doesn’t plan to pay the bill until close to its due date, but the company wants to keep an 
eye on the accounts payable total, so enter the bill now.

To enter a bill:
1 From the Vendors menu, choose Enter Bills.

The top half of the window is where you enter the bill; the bottom half is where you 
can assign the bill amount to different expense accounts, customers, or jobs. 

Notice that the Bill Received checkbox has a checkmark. The only time the Bill 
Received checkbox should be cleared is if you’re using QuickBooks for inventory 
and you want to record items you’ve received that you haven’t been billed for yet.

2 In the Vendor field, type Willis Advertising, and then press Tab.

3 When QuickBooks displays a message telling you that Willis Advertising is not on 
the Vendor list, click Quick Add.

4 In the Amount Due field, type 1500.
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5 Click in the Bill Due field.

Notice that QuickBooks supplies a date for you in the Bill Due field. The date 
displayed is ten days from the date in the Date field. You can change the date if you 
wish. If your Vendor list had payment terms entered for this vendor, 
QuickBooks would have used those terms to calculate the bill’s due date.

6 Click in the Account column on the Expenses tab and type Printing.

QuickFill completes the entry for you, and displays Printing and Reproduction as 
the account. QuickBooks lets you assign transactions to more than one account, so 
you can keep close track of where your company spends its money. Rock Castle 
Construction wants to assign the majority of this bill to a printing and 
reproduction expense account, and the rest to a freight delivery expense account.

Note: You can set a preference so that QuickBooks pre-fills the account based on 
previous transactions for that vendor. QuickBooks remembers all your recent 
transactions for a vendor, not just the most recent one. If you consistently use the 
same account for a vendor, QuickBooks will automatically pre-fill that information 
any time you select the vendor in a bill, check, or credit card transaction.

7 Press Tab to accept Printing and Reproduction as the account.

8 Type 1450 to change the amount from 1,500 to 1,450.
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9 Click in the Account column below Printing and Reproduction.

10 From the drop-down list, choose Freight & Delivery, and then press Tab.

QuickBooks automatically assigns the remainder of the bill amount ($50.00) to 
Freight & Delivery.

Your screen should resemble the figure below.

11 Click Save & Close to record the bill.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the bill. 

Account Title Debit Credit

Accounts Payable $1,500.00

Printing and Reproduction $1,450.00

Freight & Delivery $50.00

QuickStart Tip
You can enter bills and vendor credits directly in your accounts payable (A/P) register 
instead of using the Enter Bills window to create the transactions. One benefit to using the 
register is speed—you can work more quickly in a register than you can if you fill out a sep-
arate bill for each transaction. And, since the register shows you all the transactions in the 
account to date (not just one transaction at a time), you have a better record of the entire 
account.
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Paying bills
When you start QuickBooks or open a QuickBooks company file, a Reminders window 
appears that tells you whether you have transactions to complete, such as bills to pay or 
money to deposit.

Note: If you don’t see the Reminders window when you start QuickBooks, you can turn 
it on by choosing Preferences from the Edit menu. Click Reminders, click the My 
Preferences tab, and select “Show Reminders List when opening a Company file.”

The Reminders & Alerts section on the right side of the Home page also provides a list of 
transactions you need to complete.

When QuickBooks tells you that you have bills due, you can display the Pay Bills 
window and select the bills you want to pay. 

To pay a bill:
1 From the Vendors menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

The Pay Bills window shows your unpaid bills as of any date you enter. You can pay 
by check, credit card, or with an online payment (if you are set up to make online 
payments).

For this exercise, you’ll pay a bill using a QuickBooks check (rather than a 
handwritten one).

2 Select the “To be printed” option.

This tells QuickBooks that you will print this check later.
232



                                                                                                
L E S S O N 8
3 Select the Willis Advertising bill by clicking in the column to the left of the bill.

QuickBooks displays a checkmark next to the bill and changes the amount in the 
Ending Bank Balance to reflect a payment of $1,500.00. If you want to make a partial 
payment, you can enter the amount you want to pay in the Amt. To Pay column.

Your screen should resemble the figure below.
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4 Click Pay Selected Bills.

QuickBooks displays a summary of your bill payments.

5 You could print the checks at this point, but for this exercise, click Done.
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How QuickBooks records your bill payment

When you pay a bill through the Pay Bills window, QuickBooks makes an entry in the 
accounts payable register, showing a decrease of $1,500 in the total payables. It also 
creates a check from your checking account to pay the bill.

To see the entry in the accounts payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Payable account.

QuickBooks displays the accounts payable register.

The register now shows the bill payment to Willis Advertising.

3 Close the accounts payable register.

At the same time QuickBooks recorded the entry in your accounts payable register, it 
made an entry in your Checking account.
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To see the entry:
1 In the chart of accounts, double-click Checking.

QuickBooks displays the checking account register.

Notice that the last entry in the register is the check for the payment to Willis 
Advertising.

2 Select the Willis Advertising transaction.
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3 On the toolbar, click Edit Transaction.

QuickBooks displays the Bill Payments (Check) window.

This check is called a “Bill Payment Check” and differs from the check form that you 
use to enter checks directly into the checking account. (That form shows expenses 
directly on the check voucher portion, while the bill payment form shows the bills 
paid by the check.)

4 From the Window menu, choose Close All to close all the open QuickBooks 
windows.

5 Click Home in the icon bar to open the Home page.

QuickStart Tip
The unpaid bills report lists the unpaid bills in accounts payable, grouped by vendor. If a 
bill is overdue, the Aging column shows the number of days past due. (To create this 
report, from the Reports menu, choose Vendors & Payables, and then choose Unpaid Bills 
Detail.)

The A/P aging summary report summarizes the status of unpaid bills in accounts 
payable. For each vendor to whom your company owes money, the report shows (1) what 
your company owes for the current billing period, and (2) what your company still owes 
from the previous billing periods. The 1-30, 31-60, 61-90, and >90 columns show overdue 
balances from previous billing periods. For example, an amount in the 31-60 column is 
between 31 and 60 days overdue. (To create this report, choose Vendors & Payables from 
the Reports menu, and then choose A/P Aging Summary.)
237



E n t e r i n g  a n d  p a y i n g  b i l l s
238



• • • • • • • • • •

LESSON 9 Analyzing financial 
data
9
Lesson objectives, 240
Supporting materials, 238
Instructor preparation, 238
To start this lesson, 240
Reports and graphs help you understand your business, 241
Creating QuickReports, 242

When to use a QuickReport, 242
Zooming in on a QuickReport, 244
Customizing QuickReports, 245

Creating and customizing preset reports, 248
Using the Report Center, 249
Creating a balance sheet comparison report, 251
Filtering reports, 252
Saving reports in PDF format, 254
Creating and customizing a sales report, 254
Using QuickZoom in a preset report, 256

Saving report settings, 258
Creating memorized report groups, 258
Memorizing preset reports, 259
Adding reports to memorized report groups, 260

Printing reports, 261
Processing reports in groups, 262

Exporting reports to Microsoft Excel, 263
Sending a report to Microsoft Excel, 263
Filtering a report in Microsoft Excel, 268

Creating QuickInsight graphs, 270
Creating an Income and Expense graph, 270
Features of QuickInsight graphs, 272
Customizing graph data, 273
Using QuickZoom with graphs, 274
Customizing how graphs display, 277
239



A n a l y z i n g  f i n a n c i a l  d a t a
Lesson objectives
 To discuss some of the tools QuickBooks gives you for analyzing financial data: 

QuickReports, preset reports, and graphs

 To create a QuickReport

 To add a column to a report

 To learn how to move a column in a report

 To learn about the types of preset reports QuickBooks offers

 To practice creating reports and viewing them onscreen

 To customize a report by changing how it looks and the data it covers (filtering)

 To learn how to process reports in batches

 To save reports as Portable Document Format (PDF) files

 To learn how to export a report to Microsoft Excel

 To practice filtering reports in Microsoft Excel

 To learn about the types of graphs QuickBooks offers

 To create and customize several graphs

Supporting materials
 PowerPoint file: Lesson 9

 Video tutorial: Reports

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.
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To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 9 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Reports and graphs help you understand 
your business
So far, you’ve been learning ways to track your data in QuickBooks. In this lesson, you’ll 
work with two of the most valuable tools in QuickBooks: reports and graphs. Reports 
and graphs give you insight into your finances; they’re two of the most important 
benefits of tracking your data in QuickBooks.

Often, people’s perceptions of their business profitability don’t match the facts. If you 
enter your data in QuickBooks, but don’t take the time to analyze the data, your 
business decisions are based on incomplete knowledge. Reports let you summarize your 
financial data so you make decisions based on analysis of the numbers.

Reports give you the bottom line—you can see exactly how profitable your business is. 
If it’s not doing as well as you’d hoped, you can create reports that show you which areas 
need improvement. QuickBooks has dozens of preset reports, but if you have specific 
reporting needs, you can customize any QuickBooks report to show exactly the data you 
want. And if you’re interested in getting quick information, you can use a QuickReport 
that lets you summarize information from your lists, forms, or registers with one click 
of a button.

Some people find it easier to see a visual picture of their financial data. If you’re 
interested in learning more about trends or patterns in your business data (for example, 
what proportion of your income comes from consulting services as compared to 
product sales), QuickBooks offers six types of QuickInsight graphs.

Note: Some versions of QuickBooks include additional reports that are not available in 
all other versions. 
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Creating QuickReports
One of the fastest ways to see a report on your QuickBooks data is to create a 
QuickReport. QuickReports are predesigned reports that give you information about 
the items you’re currently viewing on screen. Whenever you have a list, a register, or a 
form displayed, you can click a button to have QuickBooks create a QuickReport.

When to use a QuickReport

Suppose you’re viewing the Vendor list in the Vendor Center and you want to see a 
history of all transactions for a certain vendor. Select the vendor’s name, then click the 
QuickReport link at the top right section of the window. You’ll see a report listing 
information about each bill for that vendor.

Suppose that Rock Castle Construction wants to see what it owes to Patton Hardware.
242



                                                                                                
L E S S O N 9
To see what you owe a vendor:
1 Click Vendor Center on the icon bar.

QuickBooks displays the Vendor Center.

2 Select Patton Hardware Supplies.

3 In the Reports for this Vendor section, click the QuickReport link.

Note: If you want to see only unpaid bills and unapplied credits for the selected 
vendor, click the Open Balance link in the Reports for this Vendor section.

A vendor QuickReport shows all transactions for this month to date for the selected 
vendor, Patton Hardware Supplies. The transactions shown can include purchase 
orders, item receipts, bills, bill payments, and credits received from the vendor.

4 Leave the report open; you will use it in the next exercise.
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Zooming in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better 
understand the information presented in reports, QuickBooks lets you trace report data 
to the individual transaction level using QuickZoom.

When you position the mouse pointer over a number in a report and you see the 
QuickZoom symbol (a magnifying glass with a Z in it), you can double-click the number 
to display the original transaction in QuickBooks.

Suppose you want more detail about the item receipt shown in the report. (You use an 
item receipt in QuickBooks when you want to record that you’ve received inventory 
items, but you haven’t yet received a bill.)

To see more detail about an item:
1 Position the mouse pointer over the item receipt dated 12/05/2015.

The arrow pointer turns into a magnifying glass with the letter Z (z for zoom).

2 Double-click the item receipt.

QuickBooks displays the Create Item Receipts window for the selected transaction.

3 Click Save & Close to close the window.

QuickBooks returns you to the QuickReport.
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Customizing QuickReports

Each QuickReport window has a buttonbar at the top of the report for customizing 
report content and layout.

In this exercise, you’ll customize the QuickReport you just created to display 
transaction numbers in the report.

To add a column to a report:
1 In the QuickReport window, click Modify Report.

QuickBooks displays the Modify Report window.

Use the Display tab of the Modify Report window to select the columns to include 
in the report and the date range of the report.

2 In the Columns list, select Trans #.

QuickBooks displays a checkmark next to Trans # to indicate that it’s selected.
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3 Click OK to accept the change.

QuickBooks displays the customized vendor QuickReport.

Notice that the item receipt from Patton Hardware Supplies is now listed as 
Transaction #266.

Next, you’ll move the Trans # column to a new position in the report.

To move a report column:
1 Position your mouse pointer over the Trans # column that you added to the 

QuickReport.

The mouse pointer changes shape to look like a hand.

2 Hold down the left mouse button and drag the Trans # column to the right until you 
see an arrow between the Date Column and the Num column.

3 Release the mouse button.

QuickBooks places the Trans # column between the Date column and the 
Num column.

Next, you’ll use the QuickReport buttonbar to customize the report header.
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To change information in the report heading:
1 In the QuickReport window, click Modify Report, then click the Header/Footer tab.

On the Header/Footer tab, you can change the company name, report title, subtitle, 
and date and time prepared. You can also specify whether to print the header on all 
pages or on just the first page. The Header/Footer tab is the same for all QuickBooks 
reports.

Use this window to change the report title from Vendor QuickReport to Vendor 
History Report.

2 In the Report Title field, highlight the text for “Vendor QuickReport,” and type 
Vendor History Report to replace the title.

3 Click OK to close the Modify Report window.

QuickBooks changes the title of the report and displays the new report.

4 Close the QuickReport window.

5 Close the Vendor Center.
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Creating and customizing preset reports
In addition to QuickReports, QuickBooks has dozens of preset report formats. You can 
create profit and loss reports, balance sheet reports, accounts receivable reports, sales 
reports, accounts payable reports, inventory reports, and many other types of reports.

The Report Center categorizes the preset reports into 12 major categories:

Company & Financial reports include the following:

 Profit and loss reports give you a global view of your company’s income, expenses, 
and net profit or loss over a specific period of time.

 Balance sheet reports show the financial position of your business by listing assets, 
liabilities, and equity.

 Statement of cash flows reports show the net change in your cash during a period of 
time.

Customers & Receivables (accounts receivable) reports give you information about 
the receivables side of your business: which invoices are due (or overdue), how much 
each customer owes your company, and so on. 

Sales reports give you information about what you have sold and to whom.

Jobs, Time & Mileage reports give information about the profitability of jobs, how well 
your company is doing at estimating jobs, how much time is spent on each job, and the 
mileage expenses for each vehicle or job.

Vendors & Payables (accounts payable) reports give you information about the 
payables side of your business, including which bills are due, information about 
vendors and transactions that require 1099s, your sales tax liability, and your current 
balance with each vendor. 

Purchases reports give you information about your purchases and open purchase 
orders.

Inventory reports give you information about status (such as the quantities you have 
on hand or on order) and the value of your inventory.

Employees & Payroll reports summarize the information you need to pay your current 
payroll liabilities and fill out your tax forms. 

Banking reports include check detail, deposit detail, missing check reports, and 
reconciliation reports.

Accountant & Taxes reports summarize information that you need to give to your 
accountant and information to help you monitor activity in the company file. These 
include income tax summary, income tax detail, general ledger, trial balance, journal, 
transaction journal, and audit trail reports.

Budget & Forecast reports show how your income and expenses compare to the 
budgets you’ve set up and help you forecast income and expenses and compare actual 
values to forecasts.
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List reports let you report on any information stored in a QuickBooks list.

Industry-specific reports are available in each of the industry-specific editions of 
QuickBooks. Accountant Edition includes the reports from all of the industry-specific 
editions.

Using the Report Center

A good way to learn about the reports available in QuickBooks—and how to work with 
them—is the Report Center, which is available by clicking Report Center on the icon 
bar. The Report Center contains a description and example of each QuickBooks report. 

To learn more about reports:

You can click the icons at the top right corner of the Report Center to select the display 
format that you prefer.

1 Click Report Center.

2 Click Grid view.
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3 Click List view.

4 Click Carousel view.

5 Click Find More Reports to open an Intuit Community web page where you can 
download and import additional reports. Review the information, then close the 
window.
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Creating a balance sheet comparison report

The balance sheet comparison report compares the current year against the previous 
year in both dollar amount and percentage.

To create a balance sheet comparison report for Rock Castle 
Construction:
1 In the Report Center, choose Company & Financial, scroll down to the Balance 

Sheet & Net Worth section, and choose Balance Sheet Prev Year Comparison.

2 Click the Display Report icon.

The report on your screen should resemble the following figure.

3 Scroll the report window to see more of the report.

Notice that the buttonbar at the top of the report is the same buttonbar you saw in 
the QuickReport window with the addition of a Collapse button. 
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4 Click the Collapse button to see the difference.

The Collapse button hides subaccounts, jobs, and subclasses. Amounts are 
summarized under the main heading. This button affects both the onscreen and 
printed report.

5 Click Expand to return to the original report display.

6 Keep the report displayed on your screen. You’ll use it in the next exercise.

Filtering reports

You can customize preset reports the same way you customize QuickReports. In this 
exercise you’ll customize the balance sheet comparison report and filter it to include 
only the transactions you specify.

Report filters let you set custom criteria for the transactions you want included in a 
report. When you filter a report, QuickBooks includes only those transactions that 
match the rules you create.

To filter a preset report:
1 With the balance sheet prev year comparison report displayed, click Modify Report 

on the report buttonbar.

2 Click the Filters tab.

QuickBooks displays the Filters tab of the Modify Report window.

Suppose you want to see only the asset accounts on the comparison balance sheet. 
You can filter the report by account.
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3 In the Filter scroll box, make sure Account is selected.

Notice that QuickBooks provides a description of the selected filter below the list of 
filters. If you need more information about how applying a particular filter will 
affect the report, click Tell me more.

4 In the Account field, choose All assets from the drop-down list.

5 Click OK.

QuickBooks displays the customized balance sheet comparison report.

If you scroll to the bottom of the report, you’ll see that QuickBooks removed the 
liability and other accounts from the report.

QuickStart Tip
Some filters represent more than one thing. This may be a little confusing if you’ve never 
used report filters in QuickBooks before. Here are some tips on what to filter for:

Use “Item” to filter for any kind of line item that appears on a purchase order or sales form. 
These include goods and services, discounts, and sales tax.

Use “Name” to filter for customers, jobs, vendors, employees, or any name on your Other 
Names list.

Use “Transaction type” to filter for any transaction, including invoices, cash sales, state-
ment charges, customer payments, bank deposits, purchase orders, item receipts, bills, bill 
payments, credit card charges, checks, paychecks, and general journal entries.
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Saving reports in PDF format

To keep a record of the information in the report as it exists today, you can save the 
report in Portable Document Format (PDF).

To save a report as a PDF file:
1 With the report open, choose “Save as PDF” from the File menu.

2 Navigate to the folder in which you want to store the file, and enter a filename.

3 Click Save.

4 Close the report window.

5 Click No when asked if you want to add this report to the Memorized Report list.

6 Go to the Window menu and choose Close All.

7 Click Home in the icon bar.

Creating and customizing a sales report

In this exercise, you’ll create a QuickBooks sales report, which you will then customize 
by changing the date range it covers.

To create a sales report:
1 From the Reports menu, choose Sales, and then choose Sales By Customer Summary 

from the submenu.

QuickBooks displays the sales by customer summary report.
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The Dates field in the report buttonbar shows that the report covers “This 
Month-to-date.” Customize the report so you can see sales figures from January 2015.

To customize a report:
1 In the Dates field, select Custom from the drop-down list.

2 In the From field, enter 01/01/2015.

3 In the To field, enter 01/31/2015 and press Tab.

QuickBooks updates the report and displays the new data.

4 From the Dates field, choose All from the drop-down list.
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Using QuickZoom in a preset report

As with all QuickBooks reports, you can QuickZoom any item in the report to see more 
detail.

To QuickZoom on a report item:
1 Position the mouse pointer over the $11,105.00—the amount for Anton Teschner’s 

sun room.

The arrow pointer turns into a magnifying glass with a Z in it.

2 Double-click $11,105.00.

QuickBooks displays a QuickZoom report showing sales by customer detail.
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To QuickZoom further to display the original invoice for a 
transaction:
1 Position the mouse pointer over the first item on the report (invoice #40 dated 

10/05/2015 for Removal labor).

2 Double-click anywhere in the first line.

QuickBooks displays Invoice #40 for Anton Teschner’s sun room.

Notice that QuickBooks puts a paid stamp on invoices for which payment has been 
received in full.

3 From the Window menu, choose Close All.

4 Click No when QuickBooks asks if you want to memorize the report.

5 Click Home in the icon bar to display the Home page.

What you see when you QuickZoom in a report depends on the type of report displayed:

 If the report shows summary figures (like the sales by customer summary report we 
just displayed) and you QuickZoom an amount, QuickBooks displays a 
transaction report that includes the transactions which contribute to that amount.

 If the report shows transactions and you QuickZoom a transaction, QuickBooks 
displays the invoice, bill, or other form for the requested transaction.

QuickStart Tip
You can widen or narrow columns on any type of QuickBooks report. To make a column 
wider, drag the small diamond at the right of the column header toward the right. To 
make a column narrower, drag the small diamond at the right of the column header 
toward the left.
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Saving report settings
After you have customized a report to provide the information you need, you can have 
QuickBooks memorize the settings so you can quickly produce the same report in the 
future. (QuickBooks memorizes a report’s settings, not the actual data.)

Note: If you use one of the QuickBooks Premier products, you can export the settings 
for memorized reports as report templates. A report template lets you specify all of a 
report’s settings in advance—for example, report date, format, and filters. Report 
templates can be imported into other QuickBooks data files and then accessed from the 
Memorized Report list.

Creating memorized report groups

In addition to saving report settings, you can create memorized report groups that you 
can use to organize your memorized reports in a way that makes sense for your business 
and to allow you to quickly process a group of reports at once. 

QuickBooks comes preset with a number of memorized report groups each containing 
common reports for each area. You can add your own reports to these groups, modify 
the groups to meet your needs, and even create your own groups.

In this exercise, you’ll create a memorized group called “Year End” to which you will 
add some memorized reports. Later, you learn how you can batch process memorized 
reports.

To create a memorize report group:
1 Choose Memorized Reports from the Reports menu, and then choose Memorized 

Report List.

QuickBooks opens the Memorized Report list.

2 In the Memorized Report list, click the Memorized Report menu button, and choose 
New Group.
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3 In the Name field of the New Memorized Report Group window, type Year End.

Your window should look like this.

4 Click OK.

QuickBooks adds the new group to the Memorized Report list.

Memorizing preset reports

Now, you’ll memorize a report and add it to the memorized report group you created.

To memorize a report:
1 From the Reports menu, choose Accountant & Taxes, and then choose

Income Tax Summary.

2 On the report buttonbar, click Memorize.

QuickBooks displays the Memorize Report window.

3 Leave the name of the report as is.

4 Click the “Save in Memorized Report Group” checkbox to select it, and then choose 
Year End from the drop-down list, if it is not already selected.

Your window should look like this.

5 Click OK to memorize the report and add it to the Year End memorized report 
group.

6 Close the income tax summary report.
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Adding reports to memorized report groups

Now, you’ll add two previously memorized reports to the Year End group.

To add memorized reports to a memorized report group:
1 In the Memorized Report List window, select the report called 

“1099 Summary--Year End.”

2 Click the Memorized Report menu button, and then choose Edit Memorized 
Report.

QuickBooks opens the Edit Memorized Report window.

3 Leave the report name as is.

4 Click the “Save in Memorized Report Group” checkbox to select it, and then choose 
Year End from the drop-down list.

5 Click OK.

QuickBooks moves the 1099 Summary report to the Year End memorized report 
group.

6 In the Memorized Report List window, select the report called 
“Balance Sheet--Year End.”

7 Click the Memorized Report menu button, and then choose Edit Memorized 
Report.

8 Leave the report name as is.

9 Click the “Save in Memorized Report Group” checkbox to select it, and then choose 
Year End from the drop-down list.

10 Click OK.

Once a report is memorized, you can easily display it from the QuickBooks Memorized 
Report list.
260



                                                                                                
L E S S O N 9
To display a memorized report:
1 In the Memorized Report list, select “Balance Sheet--Year End.”

2 Click Display.

QuickBooks displays the report.

3 Leave the report open.

Printing reports
Any time you have a report displayed in the report window, you can print it by clicking 
the Print button in the report buttonbar.

To print a report:
1 With the balance sheet year end summary report displayed, click Print.

QuickBooks displays the Print Reports window.

In the Print Reports window you can select the print orientation and tell 
QuickBooks where you would like the pages to break in multi-page reports.

2 Click Preview to see how the report will look when you print it.

QuickBooks displays a preview of your report onscreen.

3 Click Close to close the Print Preview window.

4 Close the Print Reports window, and then close the report.
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Processing reports in groups

Organizing your memorized reports in groups makes it fast and easy to process several 
reports at once. Now, you’ll process the reports you added to the Year End report group 
you created in the previous exercise.

To batch process reports:
1 In the Memorized Report list, select Year End.

2 Click Display.

QuickBooks opens the Process Multiple Reports window. You can use this window 
to display or print the selected reports. You can also change the date range for 
reports in this window before you display or print them by clicking in the From or 
To columns.

3 Leave all three reports selected and click Display.

QuickBooks opens the three reports in the Year End group.

4 Review the information in the reports.

5 From the Window menu, choose Close All.
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Exporting reports to Microsoft Excel
Occasionally, you may want to change a report’s appearance or contents in ways that 
aren’t available in QuickBooks, filter report data in ways that you can’t in QuickBooks, 
or run “what-if” scenarios on your QuickBooks data.

You can send reports from QuickBooks to Microsoft Excel. Since the changes you make 
in Excel don’t affect your QuickBooks data, you’re free to customize reports as needed, 
and even change data to run what-if scenarios.

Note: To proceed with this exercise, you need Microsoft Excel. If you don’t have Excel, 
proceed to “Creating QuickInsight graphs” on page 270.

Sending a report to Microsoft Excel

When exporting a report to Microsoft Excel, you indicate whether or not you want to 
preserve the formatting from your QuickBooks report. You also have the option of 
turning on or off several Excel features from within QuickBooks.

By default, QuickBooks preserves the look of your report when exporting to Microsoft 
Excel, and turns on the following Excel features:

 AutoFit sets column widths in Excel wide enough to display your data without 
cutting off words or numbers.

 Freeze panes allows you to scroll through data while keeping the row and column 
headers in view.

 Show Gridlines turns on gridlines in Excel.

In this exercise, you learn how to select which QuickBooks report formatting options 
you want to preserve in Excel, and how to turn on and off certain Excel features from 
within QuickBooks.
263



A n a l y z i n g  f i n a n c i a l  d a t a
To send a report to Microsoft Excel:
1 From the Reports menu, choose Company & Financial, and then choose 

Balance Sheet Standard.

2 On the Report buttonbar, click Modify Report.

QuickBooks displays the Modify report window.

3 In the “Add subcolumns for” area, click the Previous Period checkbox, and then 
click the $ Change and % Change checkboxes.
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Your screen should resemble the following.

4 Click OK.

Your balance sheet should now look like this.
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5 On the Report buttonbar, click Export.

QuickBooks displays the Export Report window.

6 On the Basic tab, make sure that “a new Excel workbook” is selected.

If desired, you can also send the report to a new sheet in an existing Excel workbook, 
or to a comma separated value (.csv) file.

7 Click the Advanced tab.

8 Under Formatting options, click the Colors checkbox to clear it.

The title font will remain blue in QuickBooks, but display in black in Excel.
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9 Under Excel features, select the Auto Filtering checkbox.

10 Click Export.

QuickBooks starts Excel (if it’s not running already) and opens the report in a new 
spreadsheet.

11 Leave the report open in Excel; you’ll use it in the next exercise.

If you wanted to save the report, you would choose Save from the Excel File menu.
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Filtering a report in Microsoft Excel

Within Microsoft Excel, you can filter on any column of data using a drop-down list at 
the top of the column. Using the drop-down list, you can apply a number of preset 
filters or create your own custom filter.

To find out if any of Rock Castle Construction’s account balances have decreased since 
the previous period, you’ll filter the balance sheet report you just created.

To filter a report in Microsoft Excel:
1 In the Excel window, click the down arrow in the $ Change column of the balance 

sheet report, and choose (Custom...) from the drop-down list.

Excel displays the following window.

2 In the $ Change field, choose “is less than” from the drop-down list.

3 In the field to the right, type 0.

Your screen should resemble the following.
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4 Click OK.

Excel filters the $ Change column for negative amounts and displays the results.

5 Close Excel without saving the report.

6 Close the balance sheet report in QuickBooks.

7 Choose No when asked if you want to memorize the report.
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Creating QuickInsight graphs
A report gives you numbers that are essential if you want to stay on top of your business 
finances. But when you want a visual picture to plan current or future business 
decisions, a graph is another invaluable tool.

A QuickInsight graph shows your data pictured as either a bar graph or a pie chart. The 
bar graphs and pie charts are simply different views of the same company financial 
information.

QuickBooks has six types of graphs, providing up to 15 different views of your data:

 Income and Expenses graphs show your income and expenses for the period you 
specify.

 Sales graphs show your company’s sales income for the period you specify.

 Accounts Receivable graphs show how much your customers owe.

 Accounts Payable graphs show how much you currently owe your vendors.

 Net Worth graphs show changes in your company’s net worth.

 Budget vs. Actual graphs let you see the variance between your budgeted amounts 
and the actual amount you earned or spent.

To create a QuickInsight graph, select the type of graph you want from a report 
submenu or from the Report Center.

Creating an Income and Expense graph

If you want your business to be profitable, you need to keep an eye on your expenses. 
The income and expense graph shows you exactly what you’re spending and where.

You should be especially concerned with the proportion you’re spending relative to the 
income you receive. As a simplistic example, if you’re earning only $20,000 in income, 
you don’t want to spend $30,000 in expenses.
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To create an income and expense graph:
1 From the Reports menu, choose Company & Financial, and then choose 

Income & Expense Graph.

QuickBooks displays a graph depicting your income and expenses.

In the top portion of the graph window, QuickBooks displays a bar graph and 
legend showing total income and expenses. In the lower portion of the window, 
QuickBooks displays a pie chart and legend showing expense percentages by 
account.

2 QuickBooks can display only 10 accounts at a time. To display more accounts, click 
the Next Group button at the top of the graph window.
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Features of QuickInsight graphs

These features are common to all QuickInsight graphs:

 Every graph window, except for the Net Worth and the Budget vs Actual graphs, 
shows a bar graph in the top part of the window and a pie chart in the bottom half.

The bar graph usually shows totals. For example, the Income and Expense graph 
shows the total for income and the total for expenses in each month of the period.

The pie chart shows a breakdown of the information shown in the bar graph; each 
pie slice in the Income and Expense graph represents a type of income or expense. 
The legend to the right of the pie chart shows you which income or expense account 
corresponds to the color shown in the pie chart; it also shows you what percentage 
of the pie each slice represents.

 Every graph window has a buttonbar with buttons you can click to customize the 
graph. For example, you can change the time period shown in the graph by clicking 
the Dates button. If you want the pie chart to show a breakdown by customer or 
class rather than a breakdown by account, just click By Customer or By Class.

 Just as you can use QuickZoom in a report to get more detail on the numbers, you 
can use QuickZoom in a graph to see the numbers behind the picture. When you 
double-click a bar or pie slice, QuickBooks shows you the numbers represented by 
that graphic image. For example, the pie chart legend tells which income/expense 
accounts are represented by each pie slice, and tells you what percentage of the 
whole is represented by each slice. When you zoom in on a pie slice, you can find 
out exactly how much you received or spent (in dollars) for each account.
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Customizing graph data

To display income accounts instead of expense accounts:
1 Click Income at the bottom of the graph window.

2 Click By Customer in the button bar.

QuickBooks changes the pie chart to display income by customers.
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Using QuickZoom with graphs

To help you better understand the information shown in the graphs, QuickBooks lets 
you trace graphical data using QuickZoom graphs.

To display the sales for Anton Teschner:
1 Position the mouse pointer over the Teschner, Anton slice of the pie chart.

(Use the Key on the right side of the window.)

The pointer changes to a magnifying glass with the letter Z inside.

2 Double-click the Teschner, Anton slice.

Note: If a slice is too small to click, click on its legend representation instead.

QuickBooks displays a QuickZoom graph depicting sales for Anton Teschner by 
month.
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To display a report describing the transactions for a given month:
1 Position the mouse pointer over the bar representing November 2015.

The pointer turns into the QuickZoom symbol.

2 Double-click the bar.

QuickBooks displays the custom transaction detail report for the month of 
November 2015.

You may need to scroll to the right to see the entire report.
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To display the invoice for the transaction in the report:
1 Double-click any of the lines in the report for Invoice #60.

QuickBooks displays the invoice.

2 From the Window menu, choose Close All.
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Customizing how graphs display

You can customize graphs to control what data they include and how the data is 
displayed. In this exercise, you’ll change the display from three-dimensional (3D) to 
two-dimensional (2D) graphs.

To change from 3D to 2D:
1 From the Edit menu, choose Preferences.

QuickBooks displays the Preferences window.

2 In the left panel, click Reports & Graphs.

QuickBooks displays the Preferences window for Reports and Graphs.

3 Click “Draw graphs in 2D (faster).”

4 Click OK.

5 Click Report Center.

6 Choose Sales. Then from the Sales by Customer list, choose Sales Graph.
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7 Click the Display Report icon.

QuickBooks displays the sales graph in 2D.

Displaying graphs in 2D often allows your computer to draw them on your screen 
faster than displaying them in 3D.

8 Close the graph.

9 Close the Report Center.
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Lesson objectives
 To get an overview of inventory in QuickBooks

 To practice filling out a purchase order for inventory items

 To track the receipt of the inventory items in QuickBooks 

 To adjust inventory manually to enter a stock loss or increase

 To create, build, and edit inventory assemblies (finished goods) (QuickBooks: 
Premier or higher)

 To set up and use units of measure

Supporting materials
 Handout 5: Inventory workflow

 Handout 6: Group vs. inventory assembly items

 PowerPoint file: Lesson 10

 Video tutorial: Inventory overview

 Video tutorial: Set up inventory

 Video tutorial: Buying and selling inventory

 Video tutorial: Using reports to manage inventory

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have handouts 5 and 6 ready for distribution.
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To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 10 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Turning on the inventory feature
The QuickBooks inventory feature is turned on in your exercise file, but you’ll review 
how to turn on this feature so you become familiar with QuickBooks preferences. If you 
need to track inventory for your company, you can turn the feature on while 
completing the EasyStep Interview. If you want to turn on the inventory feature after 
you’ve completed the EasyStep Interview, follow this procedure.

To turn on the inventory feature:
1 From the Edit menu, choose Preferences.

2 Select Items & Inventory from the left panel.

3 Click the Company Preferences tab.

Note: Only the QuickBooks Administrator can change company preferences.

4 Click the “Inventory and purchase orders are active” checkbox to select it.

A checkmark shows that the inventory feature is turned on.

5 Click OK.
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Entering products into inventory

QuickBooks uses the average cost method to determine the value of inventory (rather 
than another method such as FIFO or LIFO). The average cost of an inventory item 
equals the total cost of the items currently in stock, divided by the number in stock.

Many small businesses that stock inventory don’t know the number of units they have 
on hand or on order at any given time, and have no way of getting that information 
quickly. Using QuickBooks to manage your inventory, you’ll be able to track the 
number of items in stock and the value of your inventory after every purchase and sale. 
As you order inventory items, receive the items, and later sell the items from inventory, 
QuickBooks tracks each inventory-related transaction. You will know the status of your 
inventory and will have a more accurate picture of your business’s assets.

Refer to the diagram on Handout 5, “Inventory workflow” for the following discussion.

To track inventory, you must enter each product into the Item list as an inventory part. 
Once you enter a product, QuickBooks tracks it as you sell or reorder the product.

To enter a product into inventory:
1 From the Vendors menu, choose Item List.

QuickBooks displays the Item list.

2 Click the Item menu button, and then choose New.

3 If the New Feature screen for Add/Edit Multiple List Entries appears, click the box for 
“Do not display this message in the future” and click OK.

QuickBooks displays the New Item window.

You’ll enter one new item into your inventory.

4 In the Type field, choose Inventory Part from the drop-down list.

QuickBooks changes the New Item window to accept information for an inventory 
part.
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5 In the Item Name/Number field, type Cab 2015 (2015 is the style number).

6 Select the “Subitem of” checkbox, and then choose Cabinets from the drop-down 
list.

Note: You can use the Manufacturer’s Part Number field to specify the part number 
the manufacturer uses. This can simplify reordering.

7 In the “Description on Purchase Transactions” field, type Kitchen Cabinet #2015, and 
then press Tab to move to the Cost field.

Notice that QuickBooks fills in the Description on Sales Transactions field with the 
same description you entered for the purchase side. You can leave the sales 
description the same or change it later.

8 In the Cost field, type 169.

9 In the Preferred Vendor field, choose Thomas Kitchen and Bath from the 
drop-down list.

Or, type the first few letters of your selection and QuickBooks fills in the rest.

10 In the Sales Price field, type 225.

11 Leave the Tax Code setting as is.

If you wanted to assign a different tax code, you could select a different code from 
the drop-down list when setting up the item.

12 In the Income Account field, choose Construction:Materials.

13 Press Tab to move to the Asset Account field.

Inventory Asset was filled in when you selected Inventory Part as the type of item. 
Leave this default setting.
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14 In the Reorder Point field, type 15.

The Reorder Point is the minimum quantity of a particular inventory item that you 
want to have in stock at any given time. When the quantity reaches the reorder 
point, it's time to order more of the item. By using your Reminders list, you can have 
QuickBooks remind you when it's time to reorder a particular item.

15 In the On Hand field, type 20, and then press Tab to move to the Total Value field.

Notice that QuickBooks has calculated the value of your item by multiplying the 
number in the On Hand field by the number in the Cost field.

16 Click OK to close the New Item window.

QuickBooks adds the new item to the Item list.

17 Close the Item list.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the inventory item. 

Account Title Debit Credit

Opening Bal Equity $3,380.00

Inventory Asset $3,380.00

QuickStart Tip
When you want to check on the status of your inventory stock, you can create a stock 
status by item report. For every item in your inventory stock, the report gives you the reor-
der point, the current quantity on hand, the average cost to date, the quantity on order 
(and expected date of receipt), and the average sales per week.
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Ordering products
Once you enter your current products and vendors into the Item and Vendor lists, you’ll 
need to order products to keep your inventory stocked.

QuickBooks doesn’t require you to use purchase orders, but you may want to 
recommend their use for students who track inventory. Using purchase orders lets you 
see items you have on order and when they’re due to be received. You can also check 
items you receive against the PO.

If students don’t order items in advance or don’t want to use purchase orders, they can 
buy inventory directly by writing a check or entering a credit card transaction.

Creating purchase orders

When you order items from a vendor, you create a purchase order.

To order a product using a purchase order:
1 From the Vendors menu, choose Create Purchase Orders.

QuickBooks displays the Create Purchase Orders window.

You use the Create Purchase Orders window to enter the products you wish to order, 
the quantities, and the vendor. As you fill in this information, QuickBooks 
automatically calculates purchase order number, item cost, and total cost.

Notice that QuickBooks has already entered today’s date and a sequential purchase 
order number.

2 In the Vendor field, choose Perry Windows & Doors from the drop-down list.

Notice that QuickBooks displays all of the information about 
Perry Windows & Doors in the appropriate places on the purchase order form.

3 In the Item column, select Frames:Exterior Frame from the drop-down list.

4 In the QTY field, type 10.
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5 In the Vendor Message field of the purchase order, type Please rush ship this order.

Your Purchase Order should resemble the following figure.

6 Click Save & Close to record the purchase order.

After you have created a purchase order, QuickBooks adds an account to the chart of 
accounts called Purchase Orders. This is a non-posting account and does not affect your 
balance sheet or income statement. The Purchase Orders account is used to produce a 
QuickReport showing current purchase orders so you always know what is on order.
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Getting a report of purchase orders

To get a chronologically ordered report of all the purchase orders 
you have written:
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, click Purchase Orders once to select it.

You may need to scroll to see it. By default, QuickBooks lists non-posting accounts 
at the bottom of the list.

3 Click the Reports menu button and choose QuickReport: Purchase Orders.

QuickBooks displays a report of all purchase orders.

Notice the purchase order you have just created is at the bottom of the report.

4 Close the QuickReport.

5 Close the chart of accounts.
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Receiving inventory
When you receive the items you have ordered with your purchase order, you have to 
enter the items into inventory. You can receive items with a bill or without a bill.

This exercise shows you how to enter into QuickBooks inventory items you’ve received 
when the bill for those items will follow later.

To receive inventory without a bill attached:
1 From the Vendors menu, choose Receive Items.

QuickBooks displays the Create Item Receipts window.

The Create Item Receipts window lets you enter information for inventory parts 
you’ve received.

2 In the Vendor field, choose Perry Windows & Doors from the drop-down list and 
press Tab.

QuickBooks tells you that there are open purchase orders for this vendor and asks if 
you wish to receive against one of these orders.
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3 Click Yes.

QuickBooks displays the Open Purchase Orders for Perry Windows & Doors.

4 Click the third purchase order (#40, dated 12/15/2015) to select it.

QuickBooks places a checkmark in the left-most column for the item selected.

5 Click OK to move the information to the item receipt.

The Create Item Receipts window should resemble the following figure.

6 Click Save & Close to process the receipt.

QuickBooks processes the items and adds them to your inventory. If you display the 
Item list, you’ll see that you now have 10 additional door frames on hand.
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Entering a bill for inventory
If you've entered an item receipt for inventory, but the bill hasn't arrived yet, you can 
still record the bill amount in QuickBooks. Entering the bill as shown in this exercise 
records the amount in your accounts payable account so you can track how much you 
owe.

When the bill comes, you pay the bill just like you would pay any other bill in 
QuickBooks (from the Pay Bills window).

To enter the bill:
1 From the Vendors menu, choose Enter Bill for Received Items.

QuickBooks displays the Select Item Receipt window, where you can select the 
vendor and the item for which you have a bill.

2 In the Vendor field, select Perry Windows & Doors in the drop-down list 
and press Tab.

QuickBooks fills in the Date and Memo fields with information that corresponds to 
your bill.

3 Select “Received items (bill to follow),” dated 12/15/2015. 
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4 Click OK.

QuickBooks displays the Enter Bills window.

5 Click Save & Close.

6 Click Yes if another dialog box appears.

QuickBooks changes the item receipt to a bill in the Accounts Payable account and 
lists the bill in the Pay Bills window. If you look at the Accounts Payable, you’ll see 
that the balance increased by $200.00, based on the bill entered for 
Perry Windows & Doors.

Because you must have inventory on hand before you can enter a sale for inventory 
parts, we recommend that you enter your item receipts before entering sales.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the bill payment. 

Account Title Debit Credit

Accounts Payable $200.00

Inventory Asset $200.00
291



S e t t i n g  u p  i n v e n t o r y
Manually adjusting inventory
When you have spoilage or send out samples of your products, you can adjust your 
inventory manually.

To adjust the inventory manually:
1 On the Home page, click the arrow next to Inventory Activities and choose Adjust 

Quantity on Hand.

QuickBooks displays the Adjust Quantity/Value on Hand window.

The Adjust Quantity/Value on Hand window lets you enter the adjustment 
account, and either the New Qty or the Qty Difference.

Since two wood interior doors were damaged, you’ll adjust the inventory account 
to remove two doors.

You may want to point out to students that they can also adjust inventory value 
without affecting quantities by selecting the Value Adjustment checkbox.

2 In the Adjustment Account field, type Inventory Adjustment and press Tab.

3 Click Set Up in the window telling you that Inventory Adjustment is not in the 
account list.

QuickBooks opens the Add New Account window.
292



                                                                                                
L E S S O N 1 0
4 In the Account Type field, choose Expense from the drop-down list, if it is not 
selected already.

5 Click Save & Close to close the Add New Account window.

6 Click in the Item column and select Wood Door: Interior.
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7 In the Qty Difference column for Wood Door:Interior wood door, type –2 (the 
number of damaged doors), and then press Tab.

QuickBooks calculates the value adjustment and decreases the inventory by two 
items.

8 Click Save & Close.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the inventory adjustment.

Account Title Debit Credit

Inventory Asset $137.00

Inventory Adjustment $137.00

QuickStart Tip
The inventory valuation reports in QuickBooks break down the value of your inventory 
and give you several statistical measures of its value. The valuation summary report shows 
the quantity on hand, average cost, asset value, % of total asset value, retail value, and % 
of total retail value for each of your inventory items. The valuation detail report lists the 
opening balance, ending balance, and every transaction (purchase or sale) that has 
affected the inventory value of each inventory item during the period of time 
covered by the report.
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Tracking finished goods
QuickBooks Premier products let you track the building and sale of finished goods using 
assembly items. When you define assembly items, you tell QuickBooks how many of 
each inventory item is needed to create the finished product.

Inventory assembly items allow you to create an item that contains assembled material 
units (finished goods) you buy or produce, track as inventory, and resell. You can keep 
track of how many items remain in stock after a sale, how many items you have on 
order, your cost of goods sold, and the value of your inventory. Note that inventory 
assembly items in QuickBooks are appropriate for indicating “light” assembled items 
on sales forms and in reports. QuickBooks does not track inventory throughout a 
manufacturing process.

You must have a QuickBooks Premier product to create and build inventory assembly 
items. Afterwards, you can use any desktop for Windows edition of QuickBooks to view, 
sell, and report on existing assembly items.

Deciding whether to use group items or create 
inventory assemblies

Both group items and inventory assembly items record a group of items as a single entry 
on purchase or sales forms in QuickBooks. (Group items are available in 
QuickBooks Pro and higher editions.)

Refer to Handout 6, “Group vs. inventory assembly items” for more information about 
choosing between group and inventory assembly items.

Using group items

Group items are useful for quickly entering a group of individual items that you've 
already set up as single items on your list and often sell together.

Group items let you track the items you sell in greater detail. For example, a 
construction firm that remodels houses could set up a group item that lists the 
significant components of a remodeling job: lumber, carpentry hours, markup, etc. 
Sales reports for the company would then show income broken down by each 
component instead of a single lump sum for all remodeling jobs.

If you need to track a lot of detail about your items but you also want to give your 
customers simple, uncluttered invoices, you can use group items to do both. You can set 
up a group item so that the printed version of an invoice reduces a group item to a single 
line item and one amount. Yet when you view the invoice on your screen, you see a 
separate line entry and amount for each item in the group.

Group items also give you a way to enter a great amount of line item detail quickly. On 
a sales or purchase form, all you have to do is enter the name of the group item—
QuickBooks fills in all the details about the items in the group for you.
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Using inventory assemblies

When you build an assembly, an assembled unit is automatically added to quantity on 
hand and its component parts (inventory items or other assembly items) are 
automatically deducted from quantity on hand. By using assembly items, you always 
know how many assembled and component items you actually have in stock.

You can specify a price for an assembly that's different than the sum of component 
items.

You can easily access the date items were assembled, quantity and cost of assembled 
items, and a detailed bill of materials.

You can set a build point and QuickBooks will automatically remind you to build 
finished goods when stock is running low. At build time, QuickBooks will notify you if 
you don't have enough component items in stock to build the specified number of 
assembly items.

Note: The ability to create inventory assemblies is available only in QuickBooks Premier 
and higher. To proceed through this exercise, you must be using a QuickBooks Premier 
or higher edition.

Setting a default markup

With QuickBooks, you can add a markup to your basic costs by entering a default 
markup percentage. QuickBooks uses this percentage to calculate the sales price of items 
that have both a cost and a sales price.

You'll see the effect of the default markup percentage when you create inventory part, 
non-inventory part, service, and other charge items. When you enter the item's cost, 
QuickBooks calculates the sales price and enters it in the Sales Price field. For example, 
entering a cost of $10.00 when the markup is 25% causes QuickBooks to fill in the sales 
price as $12.50. If you don't want to use the default markup for an item, you can change 
the sales price that QuickBooks fills in.
296



                                                                                                
L E S S O N 1 0
To set the default markup percentage:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the left panel.

3 Click the Company Preferences tab.

4 In the Default Markup Percentage field, type 20 and press Tab.

5 In the Default Markup Account field, choose Construction.

Your screen should look like this:

6 Click OK.

You’ll see the effects of this markup percentage in the next exercise.
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Adding a labor item to use in assemblies

Suppose you have plans to sell all the items needed for installing a door as a kit. You’ll 
also need to account for the labor needed to assemble the kit. To do this, you’ll create an 
“Assembly Labor” item.

To create a labor item to use in assemblies:
1 From the Lists menu, choose Item List.

2 Click the Item menu button and select New.

QuickBooks displays the New Item window.

3 In the Type field, select Service.

4 In the Item Name/Number field, type Assembly Labor.

5 Click the checkbox for “This service is used in assemblies or is performed by a 
subcontractor or partner.”

The New Item window expands so you can enter details that will be used for this 
item in both sales and purchase transactions.

6 In the Description on Purchase Transactions field, type Direct Labor, and then press 
Tab.

7 In the Cost field, type 20, and then press Tab.

QuickBooks automatically enters the Sales Price based on the 20% markup you set 
in the Company preferences.

8 From the Expense Account drop-down list, choose Payroll Expenses.

9 From the Tax Code drop-down list, choose Non-taxable Labor.
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10 From the Income Account drop-down list, choose Construction:Labor.

Your screen should look like this:

11 Click OK.

Creating inventory assembly items

Creating assembly items in QuickBooks is a two-part process: first you define an 
assembly item, and then you build the assembly. Assembly item units are not added to 
inventory and assembly components (inventory parts or other assemblies) are not 
deducted from inventory until you build the assembly.

Inventory assembly items can include inventory part and other assembly items. You 
can also include the costs associated with building the assembly item by adding 
non-inventory part items, service items, and other charge items to the Bill of Materials.

All items included in an inventory assembly item must be defined in the Item list. You 
can define them before you create the inventory assembly item, or as you create the 
assembly item. 

In addition to selling individual items, Rock Castle sells pre-assembled exterior door 
kits. In this exercise, you define the assembly item for the exterior door kits. All of the 
component items are already defined in the Item list.
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To create an inventory assembly item:
1 In the Item List, click the Item menu button and select New.

QuickBooks displays the New Item window.

2 In the Type field, select Inventory Assembly.

3 In the Item Name/Number field, type Exterior Door Kit.

4 Type 199 in the Cost field, and then press Tab twice.

QuickBooks calculates the Sales price based on the cost you enter in this field and 
the default markup percentage as set in the company preferences. Leave the COGS 
Account as is.

5 In the Description field, type Complete exterior door kit, and press Tab.

The New Item window should resemble the following graphic.

QuickBooks allows you to set any price for assembled items; the price is 
independent of the sales price of the component items. You could change this 
amount if you wanted.

The Sales Price reflects the cost plus the 20% markup you entered in preferences, so 
leave it as is.

In addition, the tax code for the assembled item and the component parts can be 
different. 

6 In the Income Account field, select Construction:Materials from the list.

7 In the Bill of Materials section, click in the Item column.
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8 In the Item drop-down list, select Frames:Exterior Frame, and then press Tab.

9 In the Qty field, type 1, and then press Tab.

10 In the Item drop-down list, select Hardware:Doorknobs Locking Exterior, and then 
press Tab.

11 In the Qty field, type 1, and then press Tab.

12 In the Item drop-down list, select Hardware:Brass Hinges, and then press Tab.

13 In the Qty field, type 3, and then press Tab.

14 In the Item drop-down list, select Wood Door:Exterior, and then press Tab.

15 In the Qty field, type 1, and then press Tab.

16 In the Item drop-down list, select Assembly Labor, and then press Tab.

17 In the Qty field, type 1, and then press Tab.

The New Item window should resemble the following graphic.

You can edit the Bill of Materials for an assembly item at any time. However, 
assembly revision history is not tracked; if you need to build a previous version of 
an assembly, you need to edit the assembly and re-enter the original bill of 
materials.
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Entering the build point

You can have QuickBooks remind you to build this assembly when your inventory 
quantity reaches a certain level. (Assembly Items to Build must be turned on in the 
Company Preferences for Reminders.) QuickBooks will remind you to build when the 
combined value of the quantity on hand and the quantity on order (from a purchase 
order) falls below the value displayed in the Build Point field. Reminders appear in the 
Reminders window. In QuickBooks Premier or Enterprise Solutions editions, you can 
rebuild directly from the Reminders list in any of these windows.

To enter the build point:
1 In the Build Point field, type 5.

2 Leave the On Hand and Total Value fields as they are.

The New Item window should now resemble the following graphic.

3 Click OK.

4 Close the Item list.
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Building finished goods

Once you’ve created assembly items that define the pieces you build, you are ready to 
enter the builds into QuickBooks. In this exercise, you build two exterior door kits for 
Rock Castle.

To build an inventory assembly:
1 From the Vendors menu, choose Inventory Activities, and then choose Build 

Assemblies from the submenu.

QuickBooks displays the Build Assemblies window.

2 In the Assembly Item field, select Exterior Door Kit from the drop-down list.

3 In the Quantity to Build field, type 2.

The Build Assemblies window should resemble the following graphic.

QuickBooks warns you when you do not have sufficient inventory items on hand to 
complete a build.

If you choose to build an assembly and do not have enough components in 
inventory to build the number of assemblies you have specified, you can postpone 
the build by marking it pending. If you don’t mark the build as pending, you have 
to reduce the number of assemblies or you won’t be able to save the build.

You have enough inventory to build two assemblies, so you can proceed with the 
build.

4 Click Build & Close.
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Understanding the effect of builds on inventory

When you build an assembly item, QuickBooks decrements the appropriate number of 
individual inventory items from inventory and increments the number of inventory 
assembly items. It takes the inventory asset value of the component items and transfers 
the value to the assembly item. The parts and the values are combined into the quantity 
and value of the assembly item.

To generate an item list, go to the Reports menu, choose List, and choose Item Listing 
from the sub-menu.

The following graphic shows the number of component and built items before the 
build. (Note that these graphics show reports that have been modified to show only the 
information relevant to the inventory assembly item you created.)

The following graphic shows the number of component and built items after the build.
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Managing pending builds

A pending build is an inventory assembly build transaction that could not be finalized 
because there were not enough component parts in inventory to build the specified 
number of assemblies at build time. When a build is pending, “Pending” appears in the 
Build Assemblies window to remind you that these assemblies haven't been built.

If you modify or delete a previous build transaction, or change inventory quantities or 
the dates of purchase orders, invoices, or sales receipts, assembly builds that were 
finalized could change to pending. Finalized builds change to pending when the 
quantity of at least one component drops below the quantity needed to build the 
specified number of assemblies on the build transaction date. You can use the pending 
builds report to see a list of all builds that are currently pending.

In addition, you can choose to manually mark a build as pending even if you currently 
have enough components in stock to build the specified quantity. This allows you to set 
up build information but postpone building the assembly until later. 

Disassembling inventory assemblies

There are several ways to disassemble inventory assemblies and return component 
items to inventory. You can do any of the following:

 Use the Adjust Quantity/Value on Hand window to adjust the quantity on hand for 
each assembly component and the assembly item.

 Reduce quantity to build in the Build Assemblies window and then click Build & 
Close. The quantity of assembly units in inventory are decreased and the quantity 
of component inventory parts are increased accordingly.

 Delete a build transaction completely. The quantity of assembly units in inventory 
is decreased and the quantity of component inventory parts is increased 
accordingly, but this method completely removes the build transaction from 
QuickBooks and should not be used if you want to maintain a record of the 
transaction.

Selling finished goods

When assembly items appear on any form (for example a sales receipt or in a report), 
their component items are hidden. Only the assembly name, description, and price 
appear.

If you attempt to sell more assembly units than you have available in inventory, 
QuickBooks warns you that quantities are insufficient to fulfill the order. If you decide 
to go ahead with this transaction, the quantity on hand for the specified assembly 
changes to a negative value. You can set a build point in the Build Assemblies window 
to remind you when assembly stock is getting low and you need to build more units. If 
you turn on reminders, a list of assemblies that need to be built appear in the Reminders 
window.
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Using units of measure
Note: You must be using certain editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions to follow the exercises in this section. The exercises in the 
remainder of this lesson require the use of editions of QuickBooks that support units of 
measure functionality. Some of the exercises require the use of an edition that supports 
single units of measure; others require the use of an edition that supports multiple units 
of measure. You’ll find a list of the editions that support single and/or multiple units of 
measure below.

Using units of measure can show what quantities, prices, rates, and costs are based on. 
You set up the units of measure and assign them to Service, Inventory Part, 
Non-inventory Part, Inventory Assembly, and Group items. Some businesses need to 
track transactions using only a single unit of measure, for example, a business buys 
inventory by the gallon and sells by the gallon. Service businesses also may track by only 
one unit of measure, such as by the hour. Other product-based businesses buy, sell, and 
stock inventory items in multiple units of measure. A business may receive inventory in 
one unit, store it in another, and sell and ship the items in a third unit of measure. 
Service businesses might also use multiple units of measure, for example if they bill by 
the hour and by the day.

QuickBooks provides two different ways or modes for assigning units of measure to 
items: single unit of measure per item and multiple unit of measure per item. The 
following editions of QuickBooks support only the Single Unit of Measure (U/M) Per 
Item mode:

 QuickBooks Premier

 QuickBooks Premier Non-Profit

 QuickBooks Premier Professional Services

The following editions of QuickBooks support both the Single U/M Per Item and 
Multiple U/M Per Item modes:

 QuickBooks Premier Accountant

 QuickBooks Premier Contractor

 QuickBooks Premier Manufacturing & Wholesale

 QuickBooks Enterprise Solutions (all editions except Retail)

QuickBooks provides two ways to set up the unit of measure modes. You can turn on the 
mode in Preferences, or you can turn it on through the Item list.
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Setting up single unit of measure mode

Note: You must be using one of the editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions that supports single units of measure to follow the exercises in this 
section.

In Single mode you can assign different units of measure to different items, but each 
item can have only one unit of measure assigned to it. If you buy, stock, and sell each 
item by the same unit of measure, set up single unit of measure mode. For example, 
choose this mode if you buy an item by the foot, keep track of it in inventory by the foot, 
and sell it by the foot.

To set up single units of measure:
1 On the Home page, click Items & Services to open the Item List.

2 Select the non-inventory part item called Lumber: Decking.

3 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Decking.
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4 To turn on the unit of measure feature, click Enable.

This starts the unit of measure wizard where you set up the base unit.

Choosing single units of measure lets you define a base unit. Rock Castle buys and 
sells the decking lumber by the foot.

5 Select Single U/M Per Item.

6 Make sure “Begin defining units of measure” is selected and click Next.

You’ll next select the type or category of measure units.

7 Since Rock Castle will buy and sell by the foot, select Length as the unit of measure 
type. 

8 Click Next.

Now, you select the base unit. 
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9 Select Foot as the base unit.

The base unit should be the smallest unit of measure used for an item when 
purchasing it, tracking it in inventory, and selling it. In QuickBooks, the base units 
of items are used to count inventory, generate most inventory reports, and perform 
quantity-related calculations.

10 Click Finish.

11 Click OK in the Edit Item window and close the Item List.

Setting up multiple units of measure

Note: You must be using one of the editions of QuickBooks Premier or QuickBooks 
Enterprise Solutions that supports multiple units of measure to follow the exercises in 
this section.

If you buy, stock, or sell items in different units, set up multiple units of measure. For 
example, choose this mode if you buy an inventory item by the gallon and sell it by the 
ounce, or if you sell consulting services by both the hour and the day.

If you choose Multiple mode, you define unit of measure sets that you can assign to 
items. A unit of measure set consists of a base unit (usually the smallest unit used to track 
a certain type of item) and any number of related units (defined as containing a certain 
number of base units). For example, you could create a unit of measure set called 
“Length by the inch” with a base unit of inch and related units of foot (containing 12 
inches) and yard (containing 36 inches).
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With Multiple mode, you can change or convert the unit of measure when you enter an 
item on a transaction form, such as an invoice or purchase order. For example, suppose 
you have an item called Cable that you've assigned a unit of measure set that contains 
the inch, foot, and yard units of measure. If you enter Cable on an invoice with a 
quantity of 30 feet, you could then change the unit of measure to yards (causing 30 feet 
to become 30 yards) or convert the unit of measure to yards (causing 30 feet to become 
10 yards).

Rock Castle purchases and sells inventory items in different units of measure. To track 
the different units of measure, you need to turn on multiple units of measure.

Turning on multiple units of measure mode

Depending on how your company file has been set up, you turn on the multiple units 
of measure mode in one of two ways. If your file has not yet been set up with units of 
measure, skip ahead to the procedure on page 311.

If your file has already been set up with single units of measure (as with the qblesson 
company file, you’ll need to switch from single to multiple mode. Follow the next 
procedure.

To switch from single to multiple units of measure:
1 From the Edit menu, choose Preferences.

2 Click Items & Inventory, and then click the Company Preferences tab.

3 From the U/M drop-down menu, choose Multiple U/M Per Item.

4 Click OK.

5 Click OK at the message that appears to notify you that QuickBooks must close all 
open windows to switch to multiple units of measure.

6 Continue with the procedure in “Assigning units of measure to items” on page 312.
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Turning on unit of measure for the first time

If you are not using the QBLESSON sample file and your company file has not been set 
up with units of measure, follow this procedure.

To turn on multiple units of measure in a company file the first time:
1 From the Edit menu, choose Preferences.

2 Click Items & Inventory, and then click the Company Preferences tab.
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3 In the U/M section, click Enable.

4 Select Multiple U/M Per Item.

5 Click Finish.

QuickBooks returns to Preferences.

6 In the Preferences window, click OK.

7 Click OK if a message appears to notify you that QuickBooks must close all open 
windows to switch to multiple units of measure.

8 Continue with the procedure in the next section.

Assigning units of measure to items

Rock Castle sells countertops that can be customized according to a customer’s wishes. 
One customer who is remodeling a kitchen wants Italian marble for the countertop. 
Rock Castle has a non-inventory part item called Counter for materials they purchase 
on behalf of a customer but that they don’t normally carry in stock. Rock Castle 
purchases the marble in square meters, but charges the customer by the square foot. To 
track the different units of measure, you’ll assign units of measure to items.

To assign multiple units of measure:
1 Click Home on the icon bar to open the Home page.

2 On the Home page, click Items & Services to open the Item List.

3 Select the non-inventory part item called Counter.
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4 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Counter.

5 In the Unit of Measure section, click Enable.

6 For U/M Set, enter Area and click Tab.

7 Click Set Up.

This starts the unit of measure wizard where you set up the base unit and any related 
units.

Choosing multiple units of measure lets you define a base unit and multiples of that 
base unit. Since Rock Castle buys the marble countertop in square meters and sells 
the countertop in square feet, you define a measure set for area.
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8 Select Area as the unit of measure type. 

You’ll be defining a measurement set called Area that consists of a base unit and 
related units.

9 Click Next.

10 Select Square foot (sqft) as the base unit.

The base unit should be the smallest unit of measure used for an item when 
purchasing it, tracking it in inventory, and selling it. In QuickBooks, the base units 
of items are used to count inventory, generate most inventory reports, and perform 
quantity-related calculations. 
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11 Click Next.

QuickBooks displays the window where you define the units related to the base 
unit. Related units make it possible to show quantities of the same item in different 
measurements in different places in QuickBooks. Rock Castle purchases the marble 
by square meter, counts that item in inventory by the square yard, and sells it by the 
square foot. By creating a unit of measure set with a base unit of square foot and 
related units of square meter and square yard, you can enter a quantity of square 
meters on a purchase order, show the item in square yards on inventory reports, and 
enter a quantity of square foot on an invoice.

12 Click in the Add column for Square Yard and Square Meter.

Notice that QuickBooks has already calculated the number of base units the related 
unit contains in the # of sqft column.

13 Click Next.

Next, you’ll select the default unit of measure to use when buying this item and 
when selling and shipping this item.
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14 From the Purchase drop-down menu, select square meter.

Since Rock Castle buys by the square meter, that’s what you want to appear by 
default on purchase orders for this item.

15 Leave the Sales default as square foot and leave the Shipping default blank.

16 Click Next.

You need to give this measure set a name.

17 Click Finish to use the name Area.

QuickBooks returns you to the Edit Item window. Notice that the Counter item has 
been assigned the Area by the square foot measurement set.

18 Click OK in the Edit Item window.
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Assigning measure sets

You can create several measure sets for your company that you can assign to items. You 
just created a measure set for area for Rock Castle. Since Rock Castle buys and sells other 
items using different measurements, you could create a measure set for count (each, 
pair, dozen, and so on) and another one for length (inch, foot, yard, and so on). The 
number of measure sets you create will depend on your business needs.

After creating the measure sets, you’ll need to go through the items in your Item List and 
assign the unit of measure set to use for each item.

To assign a unit of measure set to an item:
1 In the Item List, select the non-inventory part item called Flooring.

Rock Castle also buys and sells flooring by area, so you can assign the Area measure 
set to this item.

2 Click the Item menu button and select Edit Item.

QuickBooks displays the Edit Item window for the non-inventory part called 
Flooring.

3 Select Area:sqft from the U/M Set drop-down menu.

4 Click OK in the Edit Item window.

5 Close the Item List.
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Using units of measure on sales forms

Rock Castle needs to order the marble for the kitchen remodel. In this exercise, you 
order the marble using a purchase order, and see how you could easily convert from one 
unit of measure to another unit within the same measure set.

To convert units of measure on sales forms:
1 In the Vendors area of the Home page, click Purchase Orders.

2 On the purchase order, select Custom Kitchens of Bayshore.

Rock Castle orders the marble from this vendor.

3 Click in the Item column and select Counter.

4 In the Quantity column, type 10.

Your screen should resemble the following graphic.

Notice that QuickBooks displays a menu you can use to specify the unit of measure 
if you want to change it. For this exercise, leave the measurement as 10 sqm.

5 Click the down arrow in the U/M column to open the conversion menu. 

Notice that QuickBooks uses the default unit you selected for purchasing this item. 
You can use the menu to convert to other units of measure within the Area measure 
set you created. For this exercise, leave the unit of measure as sqm.

6 Click Save & Close.

Once you've created a unit of measure set and assigned it to an item, you can easily 
convert to other units of measure within the set when you add the item to a transaction. 
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Lesson objectives
 To get an overview of sales tax in QuickBooks (the steps involved in tracking, 

collecting, and paying it)

 To see how to set up QuickBooks to track sales tax

 To see how to apply sales tax to a sale

 To learn how to determine a business’s sales tax liability

 To write a QuickBooks check to the appropriate tax agency for sales tax liability

Supporting materials
 Handout 7: Sales tax

 PowerPoint file: Lesson 11

 Video tutorial: Track and pay sales tax

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handout 7 ready for distribution.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 11 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Overview of sales tax in QuickBooks
If you have a business where you need to collect sales tax, you already know how 
complicated the process can be. These are some of the issues you may have to deal with:

 You may have to collect and pay more than one tax (for example, one rate for local 
taxes and one rate for state taxes).

 You may have some items that are taxable and some that aren’t.

 You may tax some customers while others are non-taxable.

QuickBooks reduces some of the complication because it lets you automatically apply 
sales tax on particular sales and keep track of how much you collect and from whom. 
When you’re ready to pay your taxes, QuickBooks can write a check for the correct 
amount.

Refer to Handout 7, “Sales tax,” for the following discussion.

To use QuickBooks to track and pay your sales tax:
1 Set up your tax rates and agencies.

In the QuickBooks Item list, set up the separate tax rates you need to charge. In the 
Vendor list, set up the agencies to whom you submit the taxes you’ve collected.

You can also set up sales tax codes, which can help you classify why a transaction 
(or part of one) is either taxable or non-taxable.

2 Indicate who and what gets taxed.

Not all of the items you sell are taxable, and not all of your customers pay tax. In 
your Item and Customers & Jobs lists, you can indicate which items or customers 
are taxable.

3 Apply tax to each sale.

When you fill out an invoice or sales receipt form, and choose a taxable item from 
your Item list, QuickBooks applies the appropriate sales tax.

4 Find out what you owe.

As you record taxable sales, QuickBooks keeps track of the tax you’ve collected in 
your Sales Tax Payable account. When you’re ready to pay your sales tax agency, 
you can open the Sales Tax Payable register to see how much you owe, or you can 
create a sales tax liability report.

5 Pay your tax agencies.

When you go to the Pay Sales Tax window, QuickBooks shows the amount you owe 
and writes a check to the tax agency for that amount.

This lesson walks you through each of these steps.
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Setting up your tax rates and agencies
The first step is to enter your sales tax rates, and then provide information about the tax 
agencies to which you pay the taxes.

Creating a tax item for each single tax you apply

Some businesses need to apply more than one sales tax to their sales; for example, they 
may collect a state sales tax as well as several county sales taxes. You need to create a 
separate sales tax item for each tax whose amount you must report (not necessarily for 
each tax you collect—some states want you to report state sales tax and county sales tax 
as separate items, while others let you report them as one item).

Even if you’re paying more than one type of tax, you usually want your customers to see 
one overall tax amount, not separate taxes for the state and county. You’ll learn how to 
do that in this lesson.

On the Item list, you already have sales tax for San Tomas and San Domingo Counties. 
Because Rock Castle Construction now does business in the city of Bayshore, you need 
to add sales tax items for that city.

To add a sales tax item:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item list.

2 Click the Item menu button, and then choose New.

3 If the New Feature screen for Add/Edit Multiple List Entries appears, click the box for 
“Do not display this message in the future” and click OK.

QuickBooks displays the New Item window.

4 In the Type field, choose Sales Tax Item from the drop-down list.

5 In the Sales Tax Name field, type Bayshore.

6 In the Description field, type Bayshore City.

7 In the Tax Rate (%) field, type 1.
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8 In the Tax Agency field, type Bayshore Tax Agency.

Your New Item window should now resemble the following figure.

9 Click OK.

QuickBooks displays a message telling you that Bayshore Tax Agency is not on your 
Vendor list.

10 Click Quick Add.

11 Click OK.

If QuickBooks prompts you to add ‘Bayshore’ to the dictionary, click Add.

QuickBooks adds Bayshore Tax Agency to the Vendor list.

Your Item list should resemble the following figure.

Grouping single taxes together

Even if you collect a combination of sales taxes (for example, city tax and county tax) 
that you report separately, you probably don’t want to confuse customers by showing 
separate taxes on your invoices or sales forms. QuickBooks lets you group some or all of 
your tax items so that customers see a single tax amount on your invoices and sales 
receipts. Instead of a sales tax item, you’ll be creating a sales tax group.
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To create a sales tax group:
1 With the Item list displayed, click the Item menu button, and then choose New.

2 In the Type field, choose Sales Tax Group.

The New Item window on your screen should resemble the figure below.

3 In the Group Name/Number field, type Bayshore Group.

4 In the Description field, type Sales Tax, Bayshore.

5 Click in the Tax Item column, and then choose Bayshore from the drop-down list.

6 Click on the second line in the Tax Item column, and then choose San Tomas.

Your New Item window should resemble the following figure.

Notice that the total Group Rate is 8.75%.

7 Click OK.

QuickBooks adds the Bayshore Group to the Item list.
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Identifying your most common tax

If you want QuickBooks to apply sales tax to your invoices and sales receipts, you have 
to tell it which sales tax item or group is the one you use most often. Once you do that, 
QuickBooks applies that sales tax when you fill out an invoice or a sales receipt. (You can 
choose a different sales tax from the sales form if you don’t want the default tax.) 

Assume Rock Castle Construction uses the San Tomas sales tax most often, and set that 
up as the default sales tax.

To set up a default sales tax:
1 From the Edit menu, choose Preferences.

QuickBooks displays the Preferences window.

2 In the Preferences window, click the Sales Tax icon in the left panel, and then click 
the Company Preferences tab.

3 In the “Your most common sales tax item” field, make sure San Tomas is selected.

4 Click OK.

If you’re using sales tax codes, you can use the Preferences window to tell QuickBooks 
which sales tax codes to use as the default taxable and non-taxable codes. You can use 
the codes that come preset with QuickBooks, or define your own. You can also manage 
sales tax codes using the Sales Tax Code list, which is available on the Lists menu when 
the sales tax feature is turned on in a company data file.
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Indicating who and what gets taxed

The next step in setting up sales tax is to indicate who and what gets taxed. You have to 
tell QuickBooks whether or not a customer is taxable and assign a default tax item or tax 
group to that customer.

You must also distinguish between taxable and non-taxable items on the Item list. 
When you add an item to the Item list, there’s a place in the window where you can 
indicate whether you charge tax for the item. QuickBooks remembers this information, 
and shows whether or not an item is taxable when you enter the item on a sales form.

In the next exercise, you’ll take a look at an item on Rock Castle’s Item list to see how to 
indicate that an item is taxable.

To indicate a taxable item:
1 In the Item list, select Doorknobs Std (under Hardware).

2 Click the Item menu button, and then choose Edit Item.

The code in the Tax Code field is a taxable code, which tells you that this item is 
taxable. When you choose the item to be included on a sales form, QuickBooks 
knows that the item is taxable and automatically applies the default sales tax (San 
Tomas sales tax with a rate of 7.75%).

To indicate that an item is non-taxable, select a non-taxable code from the 
drop-down list. 

3 Click OK to close the Edit Item window.

4 Close the Item list.
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In the same way that you can specify that an item in the Item list is taxable, you can 
indicate whether or not a particular customer is taxable or non-taxable in that 
customer’s record.

To see an existing customer record:
1 Click Customer Center on the icon bar.

QuickBooks displays the Customer Center, including the Customers & Jobs list.

2 Select Jimenez, Cristina.

3 Click Edit Customer.

QuickBooks displays the Edit Customer window.

4 Click the Additional Info tab.

The tax code selected indicates that transactions with this customer are subject to 
sales tax. Because it is the default sales tax, the San Tomas tax item is assigned 
automatically. However, this customer is located in Bayshore, which has just 
instituted its city sales tax, so change the tax item to Bayshore Group.
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5 In the Tax Item field, choose Bayshore Group from the drop-down list.

6 Click OK.

7 Close the Customer Center.

Applying tax to each sale
If you’ve set up a default sales tax, assigned taxes to your customers, and marked taxable 
items you sell as taxable, QuickBooks automatically calculates and applies the tax when 
you make a sale.

To apply tax to a sale:
1 On the Home page, click Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, choose Jimenez, Cristina:Utility Shed from the 
drop-down list. (Select both the customer and the job.)

3 In the Template field, select Custom Invoice from the drop-down list.

4 Click in the Item column and select Doorknobs Std from the drop-down list and 
press Tab.
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The Create Invoices window should resemble the figure below.

When you enter a taxable item, QuickBooks displays the tax code associated with 
that item in the Tax column (which appears to the right of the Amount column). If 
the customer is taxable, QuickBooks includes all items associated with a taxable tax 
code in its tax calculation.

Note: You can select a different tax code from the list to turn taxable status on and 
off for unique situations. You can also change the customer’s taxable status by 
selecting a non-taxable code from the Customer Tax Code drop-down list.

Notice that QuickBooks applies to the Bayshore Group tax automatically because 
this is the sales tax you assigned to this customer.
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5 In the Quantity column, type 4, and then press Tab.

The Create Invoices window should resemble the following figure.

6 Click Save & Close.

The following table shows the journal entry for the invoice. 

Account Title Debit Credit

Accounts Receivable $130.50

Materials $120.00

Inventory Asset $108.00

Cost of Goods Sold $108.00

Sales Tax Payable $1.20

Sales Tax Payable $9.30
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Determining what you owe
If you’re required to collect sales tax from customers, you also have to make periodic 
payments of the sales tax you’ve collected. QuickBooks gives you three ways to 
determine the amount of your sales tax liability: the sales tax liability report, the Sales 
Tax Payable register, and the Pay Sales Tax window.

Creating a sales tax liability report

The sales tax liability report provides complete information about the sales tax your 
company owes for a particular period of time.

To create the sales tax liability report:
1 From the Reports menu, choose Vendors & Payables, and then choose 

Sales Tax Liability.

Your report should resemble the following figure.
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2 In the Dates field, choose This Month-to-date from the drop-down list.

Your report should resemble the following figure.

The sales tax liability report shows the total taxable sales as of a date you choose, 
total non-taxable sales, and the amount of sales tax you owe each tax agency.

QuickBooks displays the sales tax liability report on an accrual basis (unless you 
changed the default setting in the Sales Tax Preferences window). The report shows 
exactly how much sales tax you collected.

3 Close the sales tax liability report.

4 If QuickBooks asks if you want to memorize the report, click No.
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Determining the source of sales tax revenue

If you’d like to see where your sales tax revenue is coming from, you can run the sales 
tax revenue summary report, which shows you the sources of all taxable and 
non-taxable sales transactions, broken down by individual sales tax codes. 

To run the sales tax revenue summary report:
1 From the Reports menu, choose Vendors & Payables, and then choose Sales Tax 

Revenue Summary from the submenu.

You can QuickZoom on the numbers in the report to get more information about 
specific sales transactions.

2 Close the report.

Using the sales tax payable register

Each time you write an invoice or sales receipt that includes sales tax, QuickBooks enters 
the information in the sales tax payable register. QuickBooks keeps track of transactions 
for all tax vendors in the same Sales Tax Payable account.

To see the sales tax payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Click Sales Tax Payable once to select it.

3 Click the Activities menu button and select Use Register.
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QuickBooks displays the Sales Tax Payable register.

Each entry in the register is a single tax transaction. Taxes you record on invoices 
and sales receipts appear as increases, and payments you make to tax agencies 
appear as decreases. The ending balance of the register is your current tax liability.

Notice how some transactions have the same invoice number. When you record 
two tax rates on the same invoice or cash sale, the register shows a separate 
transaction for each tax agency. (This is because you have to make separate 
payments to individual tax agencies.)

4 Close the register.

5 Close the chart of accounts.

Paying your tax agencies
When it's time to pay sales tax, you use the Pay Sales Tax window to write a check to 
your tax agency or agencies. Suppose Rock Castle Construction is ready to make a sales 
tax payment.

To make a sales tax payment:
1 On the Home page, click Manage Sales Tax.

2 In the Manage Sales Tax window, click the Pay Sales Tax button.
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QuickBooks displays the Pay Sales Tax window.

3 Select the “To be printed” checkbox.

4 In the “Show sales tax due through” field, type 12/15/15, and then press Tab.

QuickBooks displays tax agencies and the amounts you owe.

5 To mark them for payment, click the Pay All Tax button.

The Pay Sales Tax window should resemble the figure below.

6 Click OK.

7 Close the Manage Sales Tax window.

QuickBooks writes and records checks to the tax agencies you indicated. All you need to 
do is print the checks. QuickBooks updates the tax report and sales tax payable register 
to show that you’ve paid the tax agencies.
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Lesson objectives
 To gain an overview of payroll in QuickBooks

 To learn more about payroll setup

 To set up employee payroll information

 To set up payroll schedules

 To practice writing and printing a payroll check

 To learn how QuickBooks tracks your tax liabilities

 To practice paying payroll taxes

Supporting materials
 Handout 8: Employer payroll responsibilities

 Handout 9: Payroll item types

 Handout 10: List of payroll expenses and liabilities

 PowerPoint file: Lesson 12

 Video tutorial: Payroll overview

 Video tutorial: Paying employees

 Video tutorial: Paying taxes and liabilities

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handouts 8, 9, and 10 ready for distribution.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.
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To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 12 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Overview of payroll tracking

Refer to Handout 8, “Employer payroll responsibilities” for the following discussion.

This lesson is designed to demonstrate some of the QuickBooks payroll features. The 
way you process payroll for your company may differ from this lesson depending on 
which (if any) payroll service you subscribe to. Intuit provides several payroll service 
options. For information about them, click the “Learn about payroll options” link in 
the “Do More with QuickBooks section” of the Home screen.

Because payroll information is already set up in the exercise file, you will not go through 
the payroll setup process in this lesson.

To calculate payroll, QuickBooks uses tax tables. The exercise file includes the tax table 
data needed to complete this lesson. To get the tax tables to use with your own 
QuickBooks company data file, you need to subscribe to one of the Intuit Payroll 
Services: Intuit Online Payroll, QuickBooks Basic Payroll, QuickBooks Payroll 
Enhanced, or QuickBooks Assisted Payroll. To learn about these options or subscribe to 
one of them, on the Home page go to the “Do more with QuickBooks” section and click 
“Learn about payroll options.”

QuickBooks calculates each employee’s gross pay, and then calculates taxes and 
deductions to arrive at the net pay. With QuickBooks, you can write the paycheck, 
record the transaction in your QuickBooks checking account, keep track of your tax 
liabilities, and pay them.

You, as the employer, must subtract taxes and other deductions before issuing an 
employee’s paycheck. Some typical paycheck deductions are federal and state 
withholding (income) taxes, social security taxes (FICA), Medicare taxes, and state 
unemployment insurance. You may also deduct for benefits such as a 401(k) plan, or 
contributions to your company’s medical/dental plan.
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When you withhold social security, Medicare, and federal withholding taxes from 
employees’ paychecks, you must submit regular deposits of the withheld tax money 
(semiweekly or monthly, depending on the size of your payroll), and file quarterly 
forms that list the total amounts you withheld from each employee’s paycheck.

Calculating payroll with QuickBooks

To do its payroll calculations, QuickBooks needs four kinds of information:

 Information about your company

Besides the company name and address, this includes information about your 
federal tax ID numbers. You enter this information in the EasyStep Interview when 
you set up your QuickBooks company data file. (You can view most company 
information by choosing Company Information from the Company menu.)

 Information about your employees

The QuickBooks Employee list stores general information about each of your 
employees, and specific information related to payroll (such as the employee’s 
salary or hourly rate, filing status, number of exemptions, and miscellaneous 
additions, deductions, and company contributions). You can store payroll 
information that most employees have in common in employee defaults. 
Whenever you have a new employee to add, simply enter information that’s 
specific to that employee (name, address, and so on).

 Information about your payroll items

QuickBooks maintains a list of items that affect the amount on a payroll check—
including company expenses related to payroll. When you specify that you want to 
use payroll, QuickBooks creates a number of payroll items for you. You add others 
as you need them.

 Tax tables for federal, state, and local withholdings

QuickBooks uses tax tables to calculate payroll. You get the current tax tables and 
keep them current when you subscribe to one of the Intuit Payroll Services 
mentioned in “Overview of payroll tracking” on page 339. If you choose not to 
subscribe to one of these payroll services, you need to calculate and enter your 
payroll tax deductions manually for each paycheck.

Once you’ve set up your company, employee data, and payroll items, to run payroll 
you enter the number of hours worked during the pay period for each employee. 
QuickBooks calculates the gross wages for the employee, and then refers to its tax 
tables (if you’ve subscribed to one of the Intuit Payroll Services—Intuit Online 
Payroll, QuickBooks Basic Payroll, QuickBooks Payroll Enhanced, or QuickBooks 
Assisted Payroll) and the company and employee information you’ve entered to 
calculate all withholdings and deductions and to arrive at the net pay figure. 
QuickBooks also calculates your company payroll expenses (for example, your 
contributions to social security and Medicare).
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Setting up for payroll
By default, the QuickBooks payroll feature is turned on and it is turned on in the 
exercise file. If you want to turn off payroll in your own company file, follow the 
procedure below.

To turn payroll off in a company data file:
1 From the Edit menu, choose Preferences, and click Payroll & Employees in the left 

panel.

2 Click the Company Preferences tab and select “No payroll.”

3 Click OK.

Understanding payroll items

Refer to Handout 9, “Payroll item types,” for this discussion.

QuickBooks maintains a list for everything that affects the amount on a payroll check 
and for every company expense related to payroll. This list is called the Payroll Item list. 
There are payroll items for compensation, taxes, other additions and deductions, and 
employer-paid expenses. QuickBooks uses payroll items to track individual amounts on 
a paycheck and accumulated year-to-date wage and tax amounts for each employee.

QuickBooks adds some items to the list for you, and you can add others as you need 
them. For common payroll items, such as compensation and benefits, QuickBooks 
provides extra assistance so you can set them up quickly and accurately.

You work directly with payroll items as you do payroll tasks. Behind the scenes, 
QuickBooks tracks your payroll liabilities in the Payroll Liabilities account (an Other 
Current Liability account) and your payroll expenses in the Payroll Expenses account.
341



D o i n g  p a y r o l l  w i t h  Q u i c k B o o k s
To view the Payroll Item list:
1 From the Employees menu, choose Manage Payroll Items, and then choose 

View/Edit Payroll Item List. (You must have payroll turned on to see this choice.)

QuickBooks displays the Payroll Item list.

You’ve already used the QuickBooks Item list, so this list should look familiar. Just 
like the regular Item list, each payroll item has a Name and a Type.

The names of the payroll items are what you’ll see on paychecks and in payroll 
reports.

2 Close the Payroll Item list.

You won’t add a new payroll item in this lesson, but if you need to add an item after 
you’ve set up payroll in QuickBooks, you can use the following procedure.

To add a payroll item:
1 From the Employees menu, choose Manage Payroll Items, and then choose 

View/Edit Payroll Item List. 

2 Click the Payroll Item menu button, and then choose New.

3 Leave EZ Setup selected and click Next.
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QuickBooks displays the Add new payroll item window, which steps you through 
the payroll item setup process.

4 Select the type of payroll item you want to create. Then, click Next.

5 Follow the onscreen instructions to create any type of payroll item you like. When 
you are done, click Finish.

6 Close the Payroll Item List.

Setting up employee payroll information
QuickBooks calculates payroll for each employee on the basis of that employee’s pay 
rate, filing marital status, exemptions, and so on. The Employee list stores general 
information about each employee, as well as payroll information.

What information does QuickBooks store?

You’re going to add a new employee to Rock Castle Construction payroll in a moment. 
First, look at the information QuickBooks stores in the Employee list.

QuickStart Tip
Depending on your company’s payroll, you may need additional payroll items of the 
following types: Yearly salary, Hourly Wage, State Withholding, State Disability, State 
Unemployment, Other Tax, Deduction, Addition, Commission, or Company 
Contribution. Consult with your tax advisor.
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To view information stored in the Employee list:
1 Click Employee Center on the icon bar.

2 Select Dan T. Miller in the list, and then click Edit Employee.

QuickBooks displays the Edit Employee window for Dan T. Miller.

The Personal tab contains general information about Dan Miller, such as his name, 
social security number, and date of birth.
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3 Click the Address and Contact tab.

This is where QuickBooks stores employees’ addresses, telephone numbers, and 
other contact information.

4 Click the Additional Info tab.

The Additional Info tab lets you add custom fields to the Employee list.
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5 In the Change tabs drop-down list, select Payroll and Compensation Info.

QuickBooks displays the Payroll Info tab of the Edit Employee window. This is 
where QuickBooks stores payroll information.

The Payroll Info tab contains an employee’s specific salary or hourly rate, and any 
additions, deductions, or company contributions. You can see tax information for 
this employee (the type of information you get from a W-4) by clicking the Taxes 
button.
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6 Click Taxes.

QuickBooks displays the Federal tab of the Taxes for Dan T. Miller window.

The checkboxes indicate the types of taxes the employee should have deducted 
from each paycheck. A checkmark in the Federal Unemployment checkbox 
indicates that this employee’s pay is subject to the employer-paid federal 
unemployment tax.

7 Click the State tab to review the state withholdings.

This window stores information about state withholding taxes, state 
unemployment, and state disability.

8 Click OK to return to the Edit Employee window. 

9 Click OK again to return to the Employee Center.

Using the employee defaults to store common 
information

QuickBooks stores a wealth of information about each employee, but it doesn’t require 
you to enter the same information over and over. When you have information that 
applies to most of your employees, you can enter it into your employee defaults. Then, 
when you add an employee, QuickBooks automatically fills in the information stored 
with the defaults. You just need to add or change any information that is different for a 
particular employee.
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To view employee defaults:
1 With the Employee Center displayed, go to the Manage Employee Information 

menu button and choose Change New Employee Default Settings.

QuickBooks displays the Employee Defaults window.

Use this window to set up the payroll information that most of your employees 
have in common. QuickBooks saves the information so you won’t have to re-enter 
it when you set up the payroll record for an individual employee.

Rock Castle Construction employees are not paid on the same schedule, so you 
would not enter default payroll schedule or pay frequency here. You’ll learn how to 
set up payroll schedules in the next exercise.

All employees are subject to a deduction for health insurance, limited to a 
maximum of $1,200. This information isn’t reflected in the defaults, so you can add 
it now.

2 Select the “Use time data to create paychecks” checkbox to include pay for time 
entered using the time tracking feature.

3 In the Additions, Deductions and Company Contributions area, click in the Item 
Name column, and then choose Health Insurance from the drop-down list.
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4 In the Amount column, type 50 and press Tab.

Your screen should look like the following.

5 Click Taxes.

QuickBooks displays the Federal tab of the Taxes Defaults window.

The withholding taxes that should be deducted from each employee paycheck are 
entered in this window.

6 Click Cancel to close the Taxes Defaults window.
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7 Click Sick/Vacation.

QuickBooks displays the Sick & Vacation Defaults window.

Information regarding earned sick days and vacation days is entered in this 
window. QuickBooks keeps track of the earned time each pay period.

8 Click Cancel to close the Sick & Vacation Defaults window.

9 Click OK to close the Employee Defaults window.

Setting up payroll schedules

You can set up payroll schedules to group employees with the same pay frequency 
(daily, semi-monthly, bi-weekly, and monthly). You define how often you pay your 
employees, which date their paycheck is due, and which day you run payroll. 
QuickBooks calculates your upcoming payroll schedule so that you can pay your 
employees on time. 

Using payroll schedules is a quick and convenient way to pay your employees at each 
pay period. You set up the payroll schedule one time, assign the payroll schedule to the 
appropriate employees, and QuickBooks calculates the due dates for each upcoming 
pay period.

Note: If you do not set up at least one payroll schedule, you can still pay employees 
using Unscheduled Payroll in the Payroll Center.

QuickStart Tip
The employee defaults affect employees you set up in the future. If your employee list 
already contains names of employees but does not have payroll information for them, the 
defaults will not be applied to those employees.
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Suppose Rock Castle Construction has two payroll schedules: one for exempt 
employees who are paid monthly and another one for non-exempt employees who are 
paid weekly.

To define a payroll schedule:
1 From the Employees menu, choose Add or Edit Pay Schedules. 

QuickBooks displays the Payroll Schedule List window.

2 Click the Payroll Schedule menu button, and then choose New.

QuickBooks displays the New Payroll Schedule window.

3 Type Monthly in the “What do you want to name this payroll schedule?” field.

4 Press Tab and select Monthly as the pay frequency.
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5 Press Tab and select 12/31/2015 as the pay period end date.

A pay period is the duration of time for which you are paying your employee wages. 
The pay period end date is the last date of the pay period you have specified for a 
specific pay schedule. It is the last date of the pay period that you want this 
paycheck to cover. QuickBooks uses this date to calculate how many weeks an 
employee has worked in a year and the time information to include in the 
paycheck.

6 Press Tab and select 12/31/2015 as the date that should appear on the checks.

The check date is the date when employees know they are getting paid. It is the date 
you want the paycheck to affect your bank account. For example, your pay period 
end date could be Friday, April 14, but your paycheck date is 5 business days later on 
the following Friday, April 21. The IRS bases your tax liability and that of your 
employees on the check date. For example, if you pay an employee in January 2016 
for time worked in December 2015, the income is reported on the employee's 2016 
W-2 form.

7 Press Tab and choose “last day of the month” from the drop-down menu.

This is the date that the paycheck date falls on for the month.

Your screen should resemble the following graphic:
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8 Click OK.

The Payroll Schedule List now includes the Monthly pay schedule.

9 To define the pay schedule for the employees paid weekly, click the Payroll 
Schedule menu button, and then choose New.

10 Type Weekly in the “What do you want to name this payroll schedule?” field.

11 Press Tab and select Weekly as the pay frequency.

12 Press Tab and select 12/22/2015 as the pay period end date.

13 Press Tab and select 12/22/2015 as the date that should appear on the checks.

Your screen should resemble the following graphic:

14 Click OK.

15 Close the Payroll Schedule List.
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Now that you’ve set up the pay schedules, you can assign each employee to the 
appropriate pay schedule.

Assigning employees to pay schedules

To assign employees to a schedule, choose the payroll schedule on the Payroll 
Compensation Info tab of the employee record. (You can also assign employees during 
the Payroll Schedule Setup process, but for this exercise, we’ll use the employee records.)

To assign a pay schedule:
1 From the Employees menu, choose Employee Center.

2 Click the Employees tab if it is not already selected.

3 Select Dan T. Miller and then click Edit Employee.

4 In the Edit Employee window, choose Payroll and Compensation Info from the 
Change tabs drop-down list.
354



                                                                                                
L E S S O N 1 2
5 From the Payroll Schedule drop-down list, select Monthly.

Dan Miller is an exempt employee and he is paid monthly. Notice that QuickBooks 
changes the Pay Frequency to Monthly.

Your screen should resemble the following graphic.

6 Click OK.

7 Select Elizabeth Mason from the Employee List and click Edit Employee.

8 In the Edit Employee window, choose Payroll and Compensation Info from the 
Change tabs drop-down list.

9 From the Payroll Schedule drop-down list, select Weekly.

Elizabeth Mason is a non-exempt employee and she is paid weekly. Notice that 
QuickBooks changes the Pay Frequency to Weekly.

10 Click OK.

11 Repeat the steps for Gregg Schnieder and assign him to the Weekly pay schedule.

Leave the Employee Center open. You’ll use it in the next exercise.

Adding a new employee

Suppose you have a new employee on the payroll, and want to add him to your records.

To add a new employee:
1 With the Employee Center displayed, click New Employee.

QuickBooks displays the New Employee window.
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2 On the Personal tab, enter the employee data as shown below.

3 On the Address and Contact tab, enter the employee data as follows.

4 In the Change tabs drop-down list, select Employment Info.

5 In the Hire Date field, enter 11/28/2015.

6 In the Change tabs drop-down list, select Payroll and Compensation Info.

7 In the Earnings section of the window, click the Item Name column and press Tab. 
(Notice that the Regular Pay item is displayed already.)
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8 In the Hour/Annual Rate column for the Regular Pay payroll item, type 15. Then 
press Tab.

9 From the Pay Schedule drop-down list, choose Weekly.

The Payroll Info tab should look like the following.

10 Click Taxes.

QuickBooks displays the Federal tab of the Taxes for Michael M. Wilhite window.

11 From the Filing Status drop-down list, choose Married.

12 Click State.

QuickBooks displays the State tab of the Taxes for Michael M. Wilhite window.

13 In the Filing Status field, choose “Married (two incomes).”

14 Click OK.

QuickBooks returns to the New Employee window.

15 In the Additions, Deductions, and Company Contributions area, type 15 in the 
Amount column for Health Insurance and press Tab.
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QuickBooks enters –15.00 in the Amount column. The New Employee window 
should now look like this.

16 Click OK.

17 When QuickBooks asks whether you want to set up additional payroll 
information, click Leave As Is.

QuickBooks returns to the Employee Center, where the new employee’s name is 
now displayed.

18 Leave the Employee Center open, you’ll use it in the next exercise.
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Running a payroll schedule
QuickBooks lets you print payroll checks in a batch based on payroll schedules. You 
may want to process the paychecks of salaried employees in one batch, and do payroll 
for the weekly employees as another batch.

To run a paycheck:
1 In the Employee Center, click the Payroll tab.

QuickBooks displays the Payroll Center.

2 In the Pay Employees section, choose the Weekly pay schedule.

3 Click the Start Scheduled Payroll button.

QuickBooks displays the Enter Payroll Information window.

Notice that QuickBooks has filled in the Pay Period Ends field and the Check Date 
field based on the Weekly pay schedule you set up.

4 Click in the Regular Pay column for Gregg O. Schneider’s name and enter 40.
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5 Click in the Regular Pay column for Michael M. Wilhite’s name and enter 25 and 
press Tab.

Your screen should resemble the following graphic.

6 Click Continue.

QuickBooks displays the Review and Create Paychecks window. To review an 
employee’s paycheck, click the employee name. 

7 In the Employee column, click Michael M. Wilhite. (Be sure to click the underlined 
link for the employee name.)
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QuickBooks fills in the Employee Summary area of the Preview Paycheck window, 
showing the gross regular pay and all of the deductions from Michael’s paycheck. 
The net amount of the check appears at the bottom.

Because payroll tax rates change regularly, your numbers may vary from this
illustration.

The Company Summary area of the window shows company-paid taxes and 
contributions that don’t affect the amount of the paycheck (company-paid 
benefits). 

8 Click Save & Close to return to the Review and Create Paychecks window.

9 Click Create Paychecks.

QuickBooks writes a payroll check for each employee in the weekly payroll schedule 
for the correct net amount, showing the deductions in the voucher area.

QuickBooks confirms that you have created the paychecks. You can then choose to 
print the paychecks.

10 You don’t want to print the paychecks now, so click Close.

11 Close the Payroll Center.
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Viewing the paycheck

QuickBooks records payroll checks in your QuickBooks checking account register. You 
can see the check by going to the register.

To view the paycheck from the register:
1 From the Lists menu, choose Chart of Accounts.

2 Double-click “Checking.”

QuickBooks displays the Checking account register.

3 Select the paycheck transaction for Michael M. Wilhite, and click Edit Transaction.

QuickBooks displays the Paycheck – Checking window for Michael. Notice that the 
Paycheck Summary shows a summary of the check’s deductions. If you want to see 
the deductions that make up this total, you can click the Paycheck Detail button.

4 Click Save & Close to close the Paycheck – Checking window.

5 Close the checking account register, but leave the chart of accounts open.
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Printing paychecks and paycheck stubs

You can print paychecks as you would any QuickBooks check. If you use voucher 
checks, QuickBooks prints the payroll item detail in the voucher area. If you don’t use 
voucher checks, you can print paystubs to give to your employees.

To print a paycheck:
1 From the File menu, choose Print Forms, and then choose Paychecks.

QuickBooks displays the Select Paychecks to Print window.

2 In the First Check Number field, type 301.

3 Make sure there’s a checkmark next to all the employee names, and then click OK.

4 Click Print to see what the checks will look like, or else click Cancel.

Tracking your tax liabilities

Refer to Handout 10, “List of payroll expenses and liabilities.”

As an employer, you need to track both payroll expenses and payroll liabilities. These 
are the company payroll expenses you need to track:

 Employees’ gross pay

 Employer payroll taxes, such as contributions to social security (FICA), Medicare, 
federal and state unemployment insurance, and state disability insurance

QuickBooks uses an expense account called Payroll Expenses to track these actual costs 
to your company. (The funds you deduct from employee paychecks aren’t considered 
an actual cost because they’re monies you’re holding for the government; they don’t 
come directly from your company assets.) Whenever you run your payroll, QuickBooks 
keeps track of your company’s expenses for each employee. You can then see totals for 
these expenses on the payroll summary by employee report and on the profit and loss 
statement.
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QuickBooks uses the Payroll Liabilities account (an Other Current Liability account) to 
track what you owe to the government. When you do your payroll, QuickBooks 
calculates how much you owe for each tax, deduction, or company contribution payroll 
item and records that information as a transaction in the liability account. This 
produces a record of how much tax you owe at any time, so you can plan to have the 
cash available for payment. When you pay your payroll taxes or other payroll liabilities, 
QuickBooks decreases the balance of the liability account.

Look at the payroll expense and liability accounts, so you can see how QuickBooks 
recorded expenses and liabilities related to Michael Wilhite’s paycheck.

To display the payroll expenses QuickReport:
1 In the Chart of Accounts window, select the Payroll Expenses account.

2 From the Reports menu button, choose QuickReport: Payroll Expenses.

3 From the Dates drop-down menu, choose This Month.

QuickBooks displays the QuickReport. You can scroll through the report to see the 
expense items paid by the company for Michael Wilhite’s paycheck.

4 Close the QuickReport.
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5 In the chart of accounts, double-click the Payroll Liabilities account.

QuickBooks displays the register for the account. The register shows a separate 
transaction for each item from Michael’s paycheck. The running balance shows an 
increase for every liability.

6 Close the register.

7 Close the chart of accounts.

QuickStart Tip
The employee earnings summary report summarizes the wages, taxes, and adjustments, 
the gross pay (total and adjusted), and the taxes withheld for each employee and the entire 
company.

The payroll summary report shows information similar to the employee earnings 
summary report, but in a much different layout. The report has a column for each 
employee and a row for each payroll item.

To create either of these reports, choose Employees & Payroll from the Reports menu.
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Paying payroll taxes
As long as you have a valid subscription to one of the Intuit Payroll Services, QuickBooks 
uses current tax tables to keep track of your tax liabilities as they accrue, so you know 
how much you owe at any time.

Figuring out what you owe

If you’re about to pay taxes or other liabilities, the payroll liabilities report shows you 
how much to pay. Suppose you are ready to make a tax payment, and you want to see 
how much you owe.

To create a payroll liabilities report:
1 From the Reports menu, choose Employees & Payroll, and then choose Payroll 

Liability Balances.

2 Click Modify Report, select “Display columns by Year across the top,” and then 
click OK.

QuickBooks displays a report that shows what you owe for each payroll item.

3 Close the report.

4 Click No at the message asking if you’d like to memorize the report.
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Writing a check for payroll taxes

QuickBooks recommends that you set up scheduled tax payments for your payroll 
taxes. But you can also make an unscheduled tax payment if, for example, you don't 
have an active QuickBooks Payroll subscription, you have a payroll tax that isn't set up 
as a scheduled payment, or you need to make an adjustment to a payroll tax.

When it’s time to deposit payroll taxes with your deposit institution, use the Liability 
Check window to fill out a QuickBooks check.

Note: Don’t just open the Write Checks window and write a check from there to make 
payroll tax payments. QuickBooks can’t properly adjust your Payroll Liabilities account 
unless you use the Pay Liabilities feature.

To pay payroll liabilities:
1 From the Employees menu, choose Payroll Taxes and Liabilities, and then click 

Create Custom Liability Payments.

QuickBooks displays the Select Date Range For Liabilities window.

2 In the “From” field type 11/30/2015, and then type 12/15/2015 in the “Through” field.

3 Click OK.
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QuickBooks displays the Pay Liabilities window.

4 Click in the column to the left of the Federal Withholding payroll item.

QuickBooks places a checkmark in the column to show that the item will be paid. It 
also places a checkmark next to the Advanced Earned Income Credit item.

5 Click in the column to the left of the Medicare Company payroll item.

QuickBooks places checkmarks in the column for both Medicare Company and 
Medicare Employee.

6 Click in the column to the left of the Social Security Company payroll item.

QuickBooks places checkmarks in the column for both Social Security Company 
and Social Security Employee.
368



                                                                                                
L E S S O N 1 2
Now your Pay Liabilities window should look like the following.
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7 Make sure “Review liability check to enter expenses/penalties” is selected and then 
click Create.

QuickBooks displays the Liability Check window, with your check displayed.

You should use a separate check for each type of deposit coupon (for example, 941 
or 940).
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8 In the Memo field, type EIN 96-4820567, Form 941.

The Liability Check window should now look like the following.

9 Click Save & Close to record the check.

10 Click Yes if QuickBooks asks if you wish to save changes made to this 
transaction. 

Whenever you make a payment and record your check this way, QuickBooks decreases 
the balance of the Payroll Liabilities account.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the payroll liability transaction. 

Account Title Debit Credit

Checking $907.06

Payroll Liabilities $25.00

Payroll Liabilities $397.00

Payroll Liabilities $50.71

Payroll Liabilities $50.71

Payroll Liabilities $216.82

Payroll Liabilities $216.82
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Lesson objectives
 To learn how to create job estimates

 To find an estimate in a data file

 To learn to duplicate an existing estimate

 To create an invoice from an estimate

 To display project reports for estimates

 To update a job’s status

 To make an estimate inactive

Supporting materials
 PowerPoint file: Lesson 13

 Video tutorial: Prepare an estimate

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.
 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 13 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Creating jobs and estimates
An estimate is a description of work or products you propose to sell to a current or 
prospective customer. You can create multiple estimates for each name (customer or 
customer:job combination). If the customer accepts an estimate, you can turn the 
estimate into an invoice, modifying it as necessary. When you have actual costs and 
revenues, you can compare them to your estimated costs and revenues to see if you were 
over or under the estimate.

Estimates are “non-posting” transactions—they do not affect any financial reports or 
income and expense balances. QuickBooks allows you to create invoices from estimates 
either by transferring the entire estimate to an invoice or by allowing you to choose a 
percentage or selected items to invoice from the estimate. The ability to bill for only a 
percentage of the estimate or selected items on an estimate is called progress invoicing.

When you create a new QuickBooks company using the EasyStep Interview, 
QuickBooks asks you if you use estimates and/or progress invoicing. If you respond yes, 
QuickBooks turns on these features for you. If you respond no, you need to turn on 
these features in order to use them. Rock Castle Construction already has estimates and 
progress invoicing turned on, but you’ll review how to do this so you become familiar 
with QuickBooks preferences.

Turning on estimates and progress invoicing

To turn on estimates and progress invoicing:
1 From the Edit menu, choose Preferences.

2 Click Jobs & Estimates in the left panel.

3 Click the Company Preferences tab.

QuickBooks displays the Jobs & Estimates section of the Preferences window.

4 Click Yes for “Do You Create Estimates?”
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5 Click Yes for “Do You Do Progress Invoicing?”

6 Click OK to record your selections and close the Preferences window.

QuickStart Tip
If your industry uses a term other than “estimate” (for example, “bid” or “proposal”), you 
can change the title that appears on the QuickBooks estimate form.

To change the title of the form:

1 From the Lists menu, choose Templates.

2 In the Templates List window, click the Templates menu button and choose New.

3 In the Select Template Type window, select Estimate and click OK.

4 Click the Manage Templates button.

5 In the Template Name field, enter a name for the template and click OK.

6 Click the Additional Customization button.

7 In the Additional Customization window, enter the title you want (Proposal, for 
example) in the field next to the Title checkbox (this is the first field on the Header tab). 
Click OK.

8 Click OK if the Layout Designer message appears.

9 Click OK again to save the template.

10 Click OK to close the Basic Customization window.

11 Close the Templates List window.
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Creating a new job

Now that you’ve turned on the estimates feature, you can add a new job for a bathroom 
remodel project for your customer, Ernesto Natiello. Then you’ll create an estimate for 
the job.

To create a new job:
1 Click Customer Center on the icon bar.

2 In the Customers & Jobs list, select Natiello, Ernesto.

3 Click the New Customer & Job menu button, and then choose Add Job.

4 If the New Feature screen for Add/Edit Multiple List Entries appears, click the box for 
“Do not display this message in the future” and click OK.

QuickBooks displays the New Job window.
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5 In the Job Name field, type Bathroom remodel.

6 Click the Job Info tab.

QuickBooks displays the Job Info portion of the New Job window.

7 In the Job Status field, select Pending from the drop-down list.

8 In the Start Date field, type 01/04/2016, and then press Tab.

9 In the Projected End field, type 02/28/2016.

10 Press Tab to move to the End Date field, and then press Backspace (on the keyboard) 
to clear this field.

11 In the Job Description field, type Remodel bathroom.
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12 In the Job Type field, choose Remodel from the drop-down list.

Job types give you a way to classify your jobs so you can group and subtotal similar 
jobs on your reports. By using them, you’ll be able to determine which kinds of jobs 
are the most profitable for your business.

Your screen should look like the figure below.

13 Click OK.

QuickBooks returns you to the Customer Center.

14 Click the expand arrow to show full details in the Customers & Jobs list.

Click this button to expand the Customers & Jobs list.
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Notice that the new Bathroom Remodel is listed as a pending job for Natiello, 
Ernesto.

Writing an estimate
Now that you’ve created a new job for the bathroom remodel, you can create an 
estimate for it.

To create an estimate:
1 In the Customers & Jobs list, select Natiello, Ernesto:Bathroom remodel.

2 Click the New Transactions menu button, and then choose Estimates.

QuickBooks displays the Create Estimates window for this customer and job. You 
learned in Lesson 6 how to fill out an invoice form, so this form should look 
familiar.

3 Press Tab to accept Natiello, Ernesto:Bathoom remodel in the Customer:Job field.

Notice that QuickBooks enters the customer’s name and address in the 
appropriate area of the form.

4 Select “Custom Estimate” in the Template field.
380



                                                                                                
L E S S O N 1 3
5 Click in the Item column in the middle of the form.

A Down Arrow appears, indicating that a drop-down list of choices is available.

The Item list, which contains all the services and goods your business provides, is 
the same list that is available to you on invoice forms and throughout 
QuickBooks.

6 Type Installation.

Before you can finish typing, QuickBooks has filled it in for you, and QuickBooks 
fills in the default description for this item when you exit the field.

7 Press Tab twice to move to the Qty column.

8 Type 10 in the Qty column, and then press Tab.

The total amount is calculated by QuickBooks when you move out of this field.

9 Click the line under “Installation” in the Item column.

10 Type Framing.

11 Press Tab twice to move to the Qty column, and then type 40.

12 In the line under Framing in the Item column, type Rough.

QuickBooks completes the field with the item Lumber:Rough.

13 Press Tab three times to move to the Cost column, and then type 2500.

14 Press Tab to move to the Markup column.

15 Type 15%, and then press Tab twice.

Your estimate should look like the following figure.

Notice that QuickBooks has filled in most of the information for the estimate based 
on the items selected.
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16 Click Save & Close to save the estimate.

QuickBooks returns you to the Customers & Jobs list. Notice the Estimate Total 
column for the Pending Bathroom remodel job for Ernesto Natiello now has a 
balance of 5,647.81. (Click the expand arrow if you don’t see the Estimate column.)

17 Click the collapse arrow to collapse the Customers & Jobs list, then close the 
Customer Center.

Creating multiple estimates
Just as you’ve completed the estimate for this customer, he calls and asks you to prepare 
a second estimate for the same job. He’d like you to price a couple of different options.

Finding estimates

Because you just created the estimate, you can open the Create Estimates window and 
press Prev and that will take you to the correct estimate. However, when you don’t know 
where an estimate is, there are a couple of methods you can use to locate the estimate 
you want quickly. You’ll use one of them here.

To find an estimate:
1 From the Customers menu, choose Create Estimates.

2 Click the magnifying glass icon on the button bar.

QuickBooks displays the Find Estimates window.

3 In the Customer:Job drop-down list, select Natiello, Ernesto:Bathroom remodel.

4 Click Find.

5 If QuickBooks asks if you want to save the current transaction, click No.
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QuickBooks displays the estimate that you’ve already created for this job 
(Estimate # 35).

6 Keep the estimate open; you’ll use it in the next exercise.

Duplicating estimates

Your customer wants you to prepare a second estimate for the bathroom remodel job 
because he is considering buying the cabinets from you in addition to having you do the 
installation work.

First, you’ll create a duplicate of the original estimate, and then make the modifications 
necessary for the second bid.
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To create a duplicate of an existing estimate:
1 Right-click in the body of the estimate and choose Duplicate Estimate from the list 

that displays.

2 Click OK when QuickBooks notifies you that the duplicate estimate has been 
created.

QuickBooks duplicates the estimate and displays the new version on your screen. 
Notice that QuickBooks assigns the next available estimate number to the new 
form.

3 Select the number in the Qty column on the line for Installation.

4 Type 18.

5 Click in the Item column in the line below Lumber:Rough, and select 
Cabinets:Light Pine from the drop-down list.

6 Press Tab twice and type 6 in the Qty column.

7 Click in the Item column in the line below Cabinets:Light Pine and select 
Cabinets:Cabinet Pulls from the drop-down list.

8 Press Tab twice and type 12 in the Qty column.

9 Press Tab and type 10 in the Cost field.

10 Press Tab.
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Your estimate should look like the following figure.

11 Click Save & Close.

Creating an invoice from an estimate
Once you have created an estimate and the customer has approved it, you can use the 
estimate to invoice the customer. In this exercise, you’ll be using the QuickBooks 
progress invoicing feature.

Progress invoicing (also known as progress billing), lets you invoice for jobs that you 
work on and complete in phases. When using progress invoicing, you start by creating 
an estimate for the job (you don't have to give this estimate to the customer). Then, as 
you complete each phase, you can easily transfer items from the original estimate to an 
invoice. You can specify which items to include on each invoice and change estimated 
amounts or percentages. When you use estimates to create progress invoices, you can 
run reports to help you track your estimated versus actual costs.

To create an invoice from an estimate:
1 Click Customer Center on the icon bar.

2 In the Customers & Jobs list, select Natiello, Ernesto:Bathroom remodel.

3 Click the New Transactions menu button, and then choose Invoices.

QuickBooks displays the Create Invoices window.
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4 Press Tab to leave the Customer:Job field.

QuickBooks displays a list of estimates created for this job.

5 The customer accepted the first estimate you created, so select the line containing 
Estimate #35, and click OK.

QuickBooks displays the Create Progress Invoice Based On Estimate window.

Rock Castle Construction typically bills for one-third of the job before starting 
work, one-third when the project is one-third complete, and the final one-third 
when the job is completed.

6 Select “Create invoice for a percentage of the entire estimate.”

7 Type 33.333 in the “% of estimate” field.

If you need to invoice for only selected items on an estimate or for varying 
percentages or amounts for different items, select the option “Create invoice for 
selected items or for different percentages of each item.” QuickBooks then displays 
a table of all items on the estimate and allows you to select which items you want to 
include and the amounts for each item.

8 Click OK.
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9 In the Template drop-down list, select Progress Invoice.

QuickBooks completes the invoice for one-third of each item on the estimate. Your 
invoice should resemble the following figure.

Notice that QuickBooks changed the invoice template to Progress Invoice and 
added fields for Estimate Amount, Prior %, and Current %. QuickBooks also tracks 
that one-third of the Natiello bathroom remodel job has been invoiced and that 
two-thirds has not yet been invoiced.

Note: If you don’t want your customers to see this level of detail on the invoice you 
send them, you can customize the invoice to remove some of these columns from 
the printed form. See Lesson 15, “Customizing forms and writing QuickBooks 
Letters,” for more information.

10 Click Save & Close to record the invoice.

11 Close the Customer Center.
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Displaying reports for estimates
QuickBooks provides several reports on estimates. You can create these reports from the 
Jobs, Time & Mileage submenu of the Reports menu.

Displaying the job progress invoices vs. estimates 
report

Because you’ve just completed a progress invoice, you can see how QuickBooks records 
this on the job progress invoices vs. estimates report. This report shows job status, 
estimate total, total invoiced from the estimate on progress invoices, and the 
percentage of the estimate already invoiced on progress invoices.

To display the job progress invoices vs. estimates report:
1 From the Reports menu, choose Jobs, Time & Mileage.

QuickBooks displays a submenu of project reports that deal with customer jobs and 
estimates.

2 Choose Job Progress Invoices vs. Estimates.

QuickBooks displays the job progress invoices vs. estimates report.

Notice that the progress invoice you completed for Ernesto Natiello is listed in the 
Progress Invoice column. The % Progress column shows how much of the total 
estimate you’ve invoiced for so far.

3 Close the report window.
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Updating job status
Every time you change the status of a job, you should update its job status in the 
Customer:Job list. For example, the estimate for the bathroom remodel is no longer 
pending; Ernesto Natiello awarded you the job and you have started work.

To update the status of a job:
1 Click Customer Center on the icon bar.

QuickBooks displays the Customer Center.

2 In the Customers & Jobs list, select Natiello, Ernesto:Bathroom remodel.

3 Click Edit Job.

QuickBooks displays the Edit Job window.

4 Click the Job Info tab.

QuickBooks displays the Job Info portion of the Edit Job window.

5 In the Job Status field, select “In progress.”

Your screen should look like this.

6 Click OK.

QuickBooks returns you to the Customer Center. 

7 Click the expand arrow to display the full details on the Customers & Jobs list.

The Customers & Jobs list now shows this project as being in progress.

8 Collapse the Customers & Jobs list, and then close the Customer Center.
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Making estimates inactive

Now that the customer has accepted one of the estimates for the bathroom remodel job 
and you have started work, you might want to make the unaccepted estimate inactive. 
When you make an estimate inactive QuickBooks keeps a record of it, but does not use 
the numbers in reports.

To mark an estimate inactive:
1 From the Reports menu, choose Jobs, Time & Mileage.

2 Choose Estimates by Job from the submenu.

QuickBooks displays the estimates by job report.

3 Scroll to the section of the report that displays the estimates for Ernesto Natiello.

4 Double-click anywhere on the line for Estimate #36.

QuickBooks displays the estimate.
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5 Click to clear the checkmark in the Estimate Active checkbox.

6 Click Save & Close.

7 Answer Yes to the message asking if you want to save the changes you made to the 
transaction.

8 Close the report.
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Lesson objectives
 To learn how to track time worked on a project

 To learn how to invoice a customer for time worked on a project

 To create project reports for time tracking and learn about other project reports

 To learn how to set up items used to track time worked by owners or partners

 To learn how to pay nonemployees for time worked

Supporting materials
 PowerPoint file: Lesson 14

 Video tutorial: Time and billing

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 14 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Tracking time and mileage
QuickBooks provides time tracking for any job. Time tracking lets you keep track of the 
time a person spends on each job (including sick and vacation time and time spent for 
general overhead). The person whose time you track can be an employee, an owner or 
partner, or a subcontractor.

You can use time data to do the following:

 Invoice the customer for the time spent doing a job.

 Provide hours worked on an employee's paycheck, or a check to a nonemployee 
(vendor, owner, or partner).

 Track the cost of employees’ gross pay by job.

 Report on the number of hours worked—by person, by job, or by item.

Turning on time tracking

The following procedure shows how to turn on the time tracking feature, (it is turned 
on already in the exercise file).

To turn on time tracking:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the left panel. Then click the Company Preferences tab.

QuickBooks displays the Time Tracking Preferences window.

3 Make sure Yes is selected as the answer to the question “Do You Track Time?”

4 Click OK to save the preference setting.
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Entering time data

There are four ways to get time data into a company file:

 Enter time directly onto a weekly timesheet or single activity form in QuickBooks.

 Use the Stopwatch in the Time/Enter Single Activity window to time an activity 
while you are performing it.

 Use the QuickBooks Time Tracker service to track time and then import the time 
directly into QuickBooks.

 Download online timesheets using the QuickBooks Time & Billing Manager.1

When you track time with QuickBooks, you have a choice of two forms to enter time: 
Weekly Timesheet or Time/Enter Single Activity window. If you want to enter time for 
multiple jobs or multiple days, then the Weekly Timesheet is the best choice.

A single activity entry shows the time spent by one person doing a single activity for a 
single job on a single date. If you tend to enter a lot of detailed notes about your 
activities, or you prefer to enter time data as you complete an activity, use the 
Time/Enter Single Activity window instead.

1 QuickBooks Time &Billing Manager works with QuickBooks for Windows 2009 or later (Pro, 
Premier, and Enterprise versions), updated to the most current release. Internet access is required. 
Additional fees, terms, and conditions apply.
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For example, an attorney could use a single activity entry to record the time he or she 
just spent on a phone conversation with a client.

Information you enter in the Time/Enter Single Activity window displays in the Weekly 
Timesheet, and vice versa. They’re different views of the same information.

The Time Tracker service is useful when you have employees or subcontractors who 
need to track their time but don’t need or want to run QuickBooks. When time is 
imported into QuickBooks from the Time Tracker Service, you view the imported time 
data on the same timesheets you would use if you did the data entry directly into 
QuickBooks.

If you have employees who don’t have access to a computer or who don’t have access to 
QuickBooks, you can print blank copies of the weekly timesheet for your employees to 
fill out by hand.

To print a blank timesheet:
1 From the Employees menu, choose Enter Time and then choose 

Use Weekly Timesheet.

2 From the Print drop-down menu, choose Print Blank timesheet.

3 In the Print Timesheets window, click Print.
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Recording employee time on a weekly timesheet

In this exercise, you’ll complete a weekly timesheet for Gregg Schneider. Later, you’ll 
learn how to invoice a customer for the time Gregg spent working on their job.

To enter information on a weekly timesheet:
1 On the Home page, click Enter Time, and then click Use Weekly Timesheet.

QuickBooks displays the Weekly Timesheet window.

2 In the Name field, select Gregg O. Schneider from the drop-down list.

QuickBooks tracks the time you enter for this employee and displays it when you 
are ready to pay employees. 

3 Click in the Customer:Job column, and then choose Melton, Johnny:Dental office 
from the drop-down list.

QuickBooks will associate the time that you enter in this window with the office 
repairs being completed for Johnny Melton.

4 In the Service Item column, type Installation.

After you type a few characters, QuickBooks fills in the rest of the item for you. The 
Item list, which contains all the services and goods your business provides, is the 
same list that is available to you on invoice forms and throughout QuickBooks.

Notice that QuickBooks fills in the information in the Payroll Item column for you.

Gregg Schneider is paid by the hour. QuickBooks has his hourly rate stored in the 
Employee Center, on the Payroll Info tab in the Edit Employee window.

Note: If you try to select a payroll item that is not associated with this employee, 
QuickBooks displays a warning message. For example, if you try to select Salary as the 
payroll item for Gregg Schneider, QuickBooks tells you that you do not have that type 
of payroll item set up for the employee. (It still lets you make the selection, but it warns 
you that the Salary is set up with a $0.00 rate.)
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5 Click in the W 16 column for the row in which you entered Johnny Melton’s job.

W stands for Wednesday and 16 for the date, Wednesday, the 16th of December, 
2015. Note that you can change the first day of your workweek in the QuickBooks 
time tracking preferences. (From the Edit menu, choose Preferences, and then click 
Time Tracking.)

6 Type 8 to enter the number of hours worked on Wednesday.

7 In the Th field, type 8.

8 In the F field, type 8, and then press Tab.

As you enter hours for each day, the Total column displays the total hours for the 
week.

Your screen should resemble the figure below.

The Billable column to the right of the Total column tells QuickBooks if the time 
will be transferred onto an invoice. A checkmark in the field indicates that you do 
want to invoice the customer for time worked.

If you do not plan on invoicing the customer for time worked, you can click the 
checkbox to remove the checkmark. 

9 Click Save & Close to record the Weekly Timesheet.

QuickBooks records the time for Gregg Schneider and for Johnny Melton’s dental 
office job.

This time can now be transferred onto an invoice for Johnny Melton’s dental office job 
and to create a paycheck for Gregg Schneider.
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Entering mileage

By tracking your vehicle mileage, you can enter, sort, and print lists of your vehicles and 
the mileage you've driven for work-related tasks. You can use this information for your 
tax deductions and for billing your customers.

You cannot use this feature to reimburse employees or vendors for mileage. Nor can you 
track specific vehicle expenses, such as gas, tolls, etc. with this feature. However, you 
can track these types of expenses by entering bills for them as the expenses are incurred 
by employees.

Note: Intuit recommends that you consult with your tax advisor, accountant, or the IRS 
to determine if you can deduct the costs of operating and maintaining your vehicle, and 
which method you should use.

To record mileage:
1 From the Company menu, choose Enter Vehicle Mileage.

2 In the Vehicle field, select 2002 Ford Truck.

3 In the Start Date field, enter 12/16/2015.

4 In the End Date field, enter 12/16/2015.

5 In the Total Miles field, type 25.

6 In the Customer:Job field, select Melton, Johnny:Dental Office from the 
drop-down list.

7 In the Item field, select Mileage from the drop-down list.

The Enter Vehicle Mileage window should look like the following.

8 Click Save & New.

9 Repeat the steps above to enter 25 miles for the same vehicle and customer:job for 
December 17 and for December 18.

10 Click Save & Close.
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Invoicing a customer for time and 
mileage
QuickBooks provides two methods for invoicing customers for time and mileage:

 Create an invoice and then add charges for time and mileage to it.

 View a list of all unbilled charges for every customer, and select which customers to 
bill. When you select a customer to bill, the outstanding billables—time, expenses, 
mileage, and items—are transferred directly to an invoice.

Creating an invoice with charges for time and mileage

Now you can invoice Johnny Melton for the time Rock Castle Construction’s 
Employee, Gregg Schneider, spent working on the dental office job.

To invoice a customer for time:
1 On the Home page, click Create Invoices.

2 Select Melton, Johnny:Dental office as the customer:job.

3 Click Cancel in the Available Estimates window.

4 In the Date field, type 12/18/2015.

QuickStart Tip
Instead of entering time on a weekly timesheet, you can enter single activities at the time 
they occur. A single activity entry shows the time spent by one person doing a single activ-
ity for a single job on a single date. If you prefer to jot down the details of one day’s work as 
the day progresses, this method might work best for you. For example, an attorney could 
use a single activity entry to record the time he or she just spent on a phone conversation 
with a client.

You can move back and forth between the two time entry forms. If you are viewing a sin-
gle activity entry, you can display that person’s weekly timesheet with a click of the 
mouse. On a weekly timesheet, you can select any hourly entry and view it as a single 
activity entry. The two forms are simply different views of the same data.
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5 Click the Add Time/Costs button.

QuickBooks displays the Choose Billable Time and Costs window.

QuickBooks displays the time information entered on the timesheet for Gregg 
Schneider for the Johnny Melton dental office job.

Note: By default, QuickBooks combines time for activities that have the same 
service item, and lists them as one line item on the invoice. If you prefer to have 
each individual line from the timesheet displayed as a line item on the invoice, click 
the Options button and select “Enter a separate line on the invoice for each 
activity.” In the Options for Transferring Billable Time window, you can also select 
to transfer notes about time activities (in addition to descriptions) onto invoices.

6 Click in the Use column (the column with the checkmark) to select each of the lines 
that represents time worked by Gregg Schneider.

QuickBooks places a checkmark in the Use column to the left of each entry to 
indicate it is selected.

7 Click OK.
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8 From the Template drop-down list, select Intuit Service Invoice.

The invoice should resemble the figure below.

9 Keep the invoice open. You’ll use it in the next exercise.
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To invoice a customer for mileage:
1 In the Create Invoices window, click the Add Time/Costs button, and then click the 

Mileage tab.

QuickBooks displays the mileage you entered earlier for this job.

2 Click Select All to select each of the lines that represents the mileage for this job.

3 You want to combine mileage on a single line, so click Options.

4 Select the “Combine activities with the same service items and rate” option.

If you are not using a Premier or Enterprise Solutions edition, this option will not 
reference rates.

5 Click OK.
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6 Click OK to transfer the mileage to the invoice.

The invoice should now look like the following image.

7 Click Save & Close to record the invoice.

Creating an invoice from a list of time and expenses

You can invoice for time and expenses using the procedure described in the previous 
exercise, in which you start by creating an invoice for a customer and then choosing 
which time and expenses for that customer to add to the invoice.

QuickBooks also provides a list of all billable time and expenses by customer and job 
that you can use as the starting point for billing customers.

To display a list of time and expenses for all customers:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the list on the left, and then click the Company 
Preferences tab.
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3 Click to select the “Create invoices from a list of time and expenses” checkbox.

4 Click OK.

When you turn on this preference, QuickBooks adds a new item to the Customers 
menu and a drop-down menu next to the Invoice icon on the Home page. You can 
use either option to open the Invoice for Time & Expenses window.
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To invoice from a list of time and expenses:
1 From the Customers menu, choose Invoice for Time & Expenses.

QuickBooks displays a list of all billable time and expenses for all customers and 
jobs. Amounts are broken down by category: time, expenses, mileage, and items.

2 Select Abercrombie, Kristy: Remodel Bathroom.

3 Click Create Invoice to invoice Kristy for all outstanding billable items for this job.

QuickBooks creates an invoice that includes all billable items for the bathroom 
remodel job for Kristy Abercrombie.
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If you wanted to include only some of the items on the invoice, you would select the 
“Let me select specific billables for this Customer: Job” checkbox. This would allow 
you to add items to the invoice from the Choose Billable Time & Costs window as 
you did for Johnny Melton in the previous exercise.

4 Make sure that Intuit Service Invoice is selected in the Template menu.

5 Click Save & Close.

Note that QuickBooks has removed the bathroom remodel job from the Time & 
Expenses list because there no billable items open for that job.

6 Close the Invoice for Time & Expenses window.

Displaying project reports for time 
tracking
QuickBooks provides four reports on time, as described in the following table. You can 
create these reports by choosing Jobs, Time, & Mileage from the Reports menu.

Project report Description

Time by Job 
Summary

Shows hours worked subtotaled first by customer or job and 
then by service item.

Time by Job Detail Lists each time activity (that is, work done by one person for 
a particular customer or job on a specific date), and shows 
whether the work is billed, unbilled, or not billable. The 
report groups and subtotals the activities first by customer 
and job and then by service item.

Time by Name Shows hours worked (or tracked as sick or vacation time), 
subtotaled first by the name of the person who performed 
the work and then by the customer or job the person 
performed the work for.

Time by Item Shows the hours worked, subtotaled first by service item and 
then by customer or job.
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Displaying the time by job report

The time by job summary report summarizes the total hours for each job, and the time 
by job detail report breaks down those summary figures into hours for each service item 
and hours for each customer:job.

To create a time by job report:
1 From the Reports menu, choose Jobs, Time & Mileage.

2 From the submenu, choose Time by Job Summary.

QuickBooks displays the time by job summary report.

3 In the To field, change the date to 12/18/2015 and click Tab.

4 Scroll the report until you see the time worked for the 
Melton, Johnny:Dental office job.

The report shows the 24 hours for Installation work performed by Gregg Schneider.
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Viewing time data in more detail

Like all QuickBooks reports, you can QuickZoom any of the numbers in a report to see 
more detail. Suppose you want to see who worked the 24 hours on installation for 
Johnny Melton. You can point to that number in the report and double-click to get 
more information.

To view time data details:
1 Position your mouse pointer over the 24 hours for Installation on the 

Melton, Johnny:Dental office job, and then double-click.

When you position your mouse pointer over the number, the pointer changes into 
a magnifying glass with a Z in it. After you double-click, QuickBooks displays a time 
by job detail report for the time data you selected. (This functionality is called 
QuickZoom.)

You can see that Gregg Schneider did the work and the time has already been billed 
to the customer.

2 Close the Time by Job Detail report.

When QuickBooks asks if you want to memorize the report, click No.

3 Close the time by job summary report.

When QuickBooks asks if you want to memorize the report, click No.
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Paying nonemployees for time worked
When the company file has time data for a person who is not on your payroll, you can 
write checks based on the time worked. QuickBooks can transfer time data for a 
specified date range to a check. QuickBooks prefills the Items tab of a check with 
information from the time data, including hours worked and rate.

You can pay a subcontractor, owner, or partner for time worked. The person must be on 
one of the following lists:

 Vendor (appropriate for subcontractors, especially if you must report payments to 
them on Form 1099-MISC)

 Other Names (appropriate for owners and partners)

 Employees set up as type “Owner”

To set an owner up on the Employee list, choose Employee Center on the icon bar. 
Edit the employee record. On the Employment Info tab, choose Owner from the 
Type drop-down list. Employees set up as “Owner” do not use payroll.

Note: To pay an ordinary employee for time worked, use the payroll feature to write a 
paycheck.

Creating service items for subcontractors, owners, or 
partners

When you use service items for subcontractors, QuickBooks records expenses and 
income for the work in separate accounts. You can use such items on both purchase 
forms and sales forms.

In this section, you learn how to do the following:

 Set up a service item to use to track work performed by an owner or partner

 Enter time worked for an owner or partner

 Prepare a check to pay an owner or partner for time worked

To set up a service item for owners or partners:
1 From the Lists menu, choose Item List.

2 Click the Item menu button, and choose New.

3 If the New Feature window for Add/Edit Multiple List Entries appears, mark the box 
next to “Do not display this message in the future” and click OK.

4 In the Type field of the New Item window, choose Service from the drop-down list.

5 In the Item Name/Number field, type Planning.
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6 Select the “This service is used in assemblies or is performed by a subcontractor, 
owner, or partner” checkbox.

QuickBooks changes the window to display fields for sales and purchase 
information.

7 In the Description on Purchase Transactions field, type Job Planning and press Tab.

QuickBooks copies the text into the Description on Sales Transactions field.

8 In the Cost field, type 50 and press Tab.

9 From the drop-down list in the Expense Account field, choose the equity 
subaccount called Owner’s Draw.

If you pay owners (or partners) for time worked, you need a service item that records 
the cost of the work as a draw against equity, rather than an expense.

10 In the Sales Price field, type 90.

11 In the Tax Code drop-down list, select Non.

12 In the Income Account field, type Planning and press Tab.

13 When QuickBooks tells you that Planning is not on the Account list, click Set Up.
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14 In the Add New Account window, make sure Income is selected in the Type drop-
down list and click Save & Close.

Your screen should now look like this.

15 Click OK to close the New Item window.

16 Press Esc to close the Item list.

In the next section, you learn how to use the Planning item you’ve just created to track 
time performed by the owner of Rock Castle Construction.
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Recording nonemployee time worked

You record data for time worked by nonemployees the same way you enter it for 
employees.

To enter time for nonemployee time worked:
1 From the Employees menu, choose Enter Time. Then choose Time/Enter Single 

Activity.

QuickBooks displays the Time/Enter Single Activity window.

2 In the Name field, choose Tom Ferguson from the drop-down list.

Note: When you selected the owner’s name, QuickBooks removed the Payroll Item 
field from the window. (When class tracking is on, this field is replaced with the 
class field.) Owners and partners should be set up on the Other Names list, or on the 
Employee List with the Type set to “Owner” because they are not paid with payroll 
checks.

3 In the Customer:Job field, choose Abercrombie, Kristy:Family Room.

4 In the Service Item field, select Planning from the drop-down list and press Tab.

5 Type 8 in the Duration field and press Tab.
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Your screen should resemble the following.

6 Click Save & Close.
415



T r a c k i n g  t i m e
Preparing a check to pay for nonemployee time 
worked

In this section, you’ll learn how to create a check to reimburse an owner for time worked 
on a specific job.

1 On the Home page, click Write Checks.

QuickBooks displays the Write Checks window.

2 Make sure that Checking is selected in the Bank Account field.

3 Click to put a checkmark in the “To be printed” checkbox.

4 In the Pay to the Order of field, choose Tom Ferguson from the drop-down list.

5 Click Yes at the message QuickBooks displays asking if you want this check to pay 
for time worked.

6 Type 12/10/15 in the Start Date field and press Tab.

7 Type 12/16/15 in the End Date field and click OK.
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QuickBooks prefills the Items tab of the check with information from the time data, 
including hours worked and rate.

8 Click Save & Close in the Write Checks window.

Notice that time activity is marked unbillable so that it is not billed twice—as a time 
activity and an item.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the check.

Account Title Debit Credit

Checking $400.00

Owner’s Draw $400.00
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Lesson objectives
 To learn how to modify a preset invoice form

 To design a custom invoice form

 To see how to print invoices

 To learn how to prepare a collection letter for overdue customers

 To learn how to edit a prewritten letter in QuickBooks

Supporting materials
 PowerPoint file: Lesson 15

 Video tutorial: Customize sales forms 

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 15 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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About QuickBooks forms
Each form you use in QuickBooks has its own layout—that is, its own arrangement of 
fields and columns for entering information. If the layout of a particular form doesn’t 
meet your needs, you can create your own custom layout and use your version instead 
of the QuickBooks version.

In Lesson 6, you learned about the preset formats for invoices that are included with 
QuickBooks. If these formats don’t precisely meet your needs, you can create your own 
invoice templates. You can also create templates for other sales and purchase forms.

For each form, you can decide which fields and columns to include, what they are 
called, and where to place them. Once you have created your forms, you can save the 
new layouts as templates—to use whenever you wish, and to modify whenever you 
want. The forms you can customize in QuickBooks are the invoice, sales receipt, credit 
memo, statement, purchase order, estimate, and sales order (QuickBooks Premier and 
higher editions only).

Customizing invoices
QuickBooks lets you customize an invoice form to suit the needs of your business, but 
there may be times when you want to design a completely different invoice form. 
QuickBooks lets you do that, too. You can use the Layout Designer to create a new form 
design for your business. In the Layout Designer, you can move, resize, or change the 
width of columns, turn on or off borders around fields, and control font type and size 
for each field.

In the following exercises, you’ll use both the customize forms and Layout Designer 
features in QuickBooks to create a custom invoice.

Note that these features affect only the printed forms; you cannot customize the 
onscreen version of QuickBooks forms.
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Creating new templates

To create a new invoice template:
1 From the Lists menu, choose Templates.

QuickBooks displays the Templates list.

2 Click the Templates menu button, and then choose New.

QuickBooks displays the Select Template Type window.
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3 Click OK to select the invoice form.

QuickBooks displays the Basic Customization window.

4 Click the Manage Templates button to give the template a name.

5 In the Template Name field, type My Invoice and click OK.

This is the name you’ll use for the new template. 

6 Look at the options in the Logo & Fonts section of the Basic Customization window.

Use this section to change the fonts for various textual elements on the form and to 
choose a color scheme. 

If you wanted to add your company logo to the form, you would select the Use Logo 
checkbox and tell QuickBooks which file to use. QuickBooks supports BMP, JPEG, 
TIFF, PNG, WMF, EMF, and GIF graphic formats.

7 In the Company & Transaction section, select the Phone Number checkbox. 

Use this section of the window to specify which pieces of company information to 
include on your sales and purchase forms.

QuickBooks displays a message that you can use the Layout Designer to change the 
layout of your form. You’ll learn how to use the Layout Designer later in this lesson.
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8 Select the “Do not display this message in the future” checkbox, and then click OK.

Your window should look like the following graphic.

If you don’t want QuickBooks to print the status stamp (paid, pending, etc.) on 
forms, clear the Print Status Stamp checkbox on this tab.

9 Leave the Basic Customization window open. You’ll use it in the next exercise.
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Customizing fields on forms

You can further customize your invoice template by setting formatting options and 
changing how fields display. 

To customize fields on a template:
1 Click the Additional Customization button at the bottom of the window.

QuickBooks displays the Additional Customization window, which uses multiple 
tabs to display several sets of formatting options. Each area of the form is 
represented by a tab. To display the available formatting options, click the tab for 
the area of the form you want to change. QuickBooks shows you a preview of the 
invoice as you make selections on the tabs.

Notice that the Header tab is currently selected. The Header tab is where you select 
which fields you want to appear onscreen, on paper, both, or neither. You can 
specify your own title (label) for each field. You can enter a new title by highlighting 
the current title text and typing your new one.

If you want to track information about a particular invoice, but don’t want your 
customer to see this information, select the Screen checkbox and clear the Print 
checkbox.

Suppose you want to remind customers of payment due dates at the time you send 
the invoice. You can customize the invoice form to display the Due Date field.

2 To have the Due Date field display both on screen and on the printed form, click the 
Screen checkbox for Due Date to select it. 
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3 Click the Print checkbox for Due Date. 

Checkmarks appear in both checkboxes.

4 Clear the Screen and Print checkboxes for the P.O. No. field to remove the field from 
the form. 

Notice that the invoice preview shows the changes you’ve made.

Changing field order on forms

The lower half of the standard QuickBooks invoice form is where you enter details about 
the items or services purchased by the customer. You can change the order of these 
fields as they appear on your invoices.

The Order column shows you how fields display from left to right on the invoice form. 
Currently, Item is the first column and Amount is the last column. Suppose you want 
the Qty field to appear after the Item field, and before the Description field.

To change the order of fields on a form:
1 Click the Columns tab.

2 Double-click the Order column in the Quantity row to select the number.

3 Type 2.

4 Double-click the Order column in the Description row to select it.
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5 If it has not changed to 3 automatically, type 3.

Your screen should look like the following figure.

If you use progress invoices or sales orders, use the Prog Cols tab to customize the 
columns on those forms.

6 Click the Footer tab.

The Footer tab contains information that you usually find at the bottom of the 
form. It also provides a place for you to enter free-form text, such as a disclaimer, on 
your form. In the next exercise, you’ll learn how to move fields on forms.
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7 Click the Print tab.

Use the Print tab to associate print settings with individual form templates. For 
example, if you print most forms in Portrait mode, but have one form that you print 
in Landscape, you can associate the Landscape print setting with that form’s 
template. When you send the form to the printer, QuickBooks knows to print it in 
Landscape. 

If your forms print on multiple pages, select whether or not you want to print page 
numbers.

8 Click OK to record the changes.

9 Click OK again and then close the Templates window.
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Displaying your customized form

Now display the customized form to see the changes you made in the previous exercise.

To display the custom form:
1 From the Customers menu, choose Create Invoices.

2 In the Template field, choose My Invoice from the drop-down list.

Notice how this form reflects the changes you made in the Customize Invoice 
window. The Due Date field now displays onscreen and the Qty column appears in 
its new order before the Description field.

The phone number field that you added to the form only shows on the printed 
form, so you do not see it onscreen.

3 Leave the Create Invoices window open, you’ll use it in the next exercise.
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Designing custom layouts for forms
With the QuickBooks Layout Designer, you can change the design or layout of a form. 
In the Layout Designer, you can move, resize, change the width of columns, turn on or 
off borders around fields, add colored backgrounds, and control the font type and size 
for each field.

Here are a few examples of what you can do with a custom layout:

 Give your company name, address, and logo special treatment on the form. For 
example, you could center your logo at the top of the form and put your company 
name and address in a special font immediately below the logo.

 Enlarge a custom field so that it can display more information.

 Position the customer’s billing address so that it coincides with the address window 
in the envelopes you use.

 Change the borders on fields, add background colors, and add extra text fields.

 Add multiple graphics to a form.

Changing the position of fields on forms

Next, you’ll use the Layout Designer to move the Phone # and Bill To fields, and to 
decrease the width of the Quantity column.

To move fields on forms:
1 In the Create Invoices window, click the customize icon (the icon with the pencil 

and ruler), or click the arrow next to the icon and choose “Customize Design and 
Layout” from the menu.
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2 Click Customize Data Layout.

QuickBooks displays the Additional Customization window that you used to 
customize the form.

Now, you’ll use the Layout Designer to change the design of the form.
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3 Click Layout Designer.

QuickBooks displays the Layout Designer window.

By clicking the Zoom buttons, you can zoom out to see an overall view of the form 
or zoom in for a closer look at a small section of the form.

4 Click the Bill To field.

5 Press and hold the Shift key.

Holding down the Shift key when clicking on an object allows you to select multiple 
fields at the same time. Having multiple fields selected lets you move the fields 
together.
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6 Click the field directly below the Bill To field (the field containing the words “This 
is sample text”).

Notice the four-directional arrow that appears when you move the cursor over the 
selected fields. The selected fields on your screen should look like this.

7 Release the Shift key.

8 With the cursor over the selected fields, press and hold the left mouse button.

9 Drag the selected fields down about one inch.

Note: If you see that the fields are too wide to fit, deselect both fields by clicking 
outside the fields. Select each field separately. Move the mouse over the dark square 
along the right edges of the fields. Hold the mouse button and drag to the left to 
reduce the width of each field. 

10 Release the mouse button.

Your screen should now look like this.

11 Select the field containing Rock Castle’s address.

12 Move the mouse over one of the dark squares on the bottom of the field and then 
hold the mouse button while you drag the bottom of the field up to a point just 
below the address—the goal being to get rid of the extra space below the address so 
you can place the phone number directly beneath it.
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13 Scroll to the bottom of the screen and select the Phone # field.

14 Click Remove.

15 Select the field containing the numbers 555-555-5555.

16 Holding down the mouse button, drag the field so that it sits just below Rock 
Castle’s address.

Changing field widths

In the next exercise, you’ll change the font size for Rock Castle’s phone number to make 
it match the address, but first you want to make the field wider so that the phone 
number isn’t cut off.

To change the width of a field:
1 Select the field containing the telephone number and drag the right border further 

to the right while holding down the mouse button.

The fields should resemble the figure below.

Rock Castle Construction rarely enters a quantity greater than two characters, so 
you want to make the QTY column smaller. Decreasing the width of the QTY 
column also increases the width of the Description column.

2 In the Layout Designer window, scroll until the Qty column is visible.

3 Click the Qty column to select it.

Your screen should resemble the figure below.

Notice that when the cursor is positioned between the QTY and DESCRIPTION 
columns, it turns into a two-directional arrow.
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4 Click and hold the left mouse button on the line separating the Qty and Description 
columns.

5 While holding down the mouse button, drag the column line to the left (to the one-
inch mark on the ruler).

6 Release the mouse button.

The forms area on your screen should resemble the figure below.

Changing fonts, borders, and colors

Using the Properties window in the Layout Designer, you can change font size and style, 
text justification. You can also add, remove, or change the borders around fields.

To change fonts, borders, and colors:

1 With the phone number field selected, click Properties.

QuickBooks displays the Properties window.

2 On the Text tab, select Left for horizontal justification.

3 Click Font.

4 In the Size list, select 12, and then click OK.

5 Click the Border tab.

6 Click to clear the Top, Bottom, Right, and Left checkboxes.
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7 Click OK to save your changes in the Properties window.

8 Click OK to save the changes in the Layout Designer.

9 Click OK to close the Additional Customization window.

This exercise covers only a portion of the changes you can make with the customization 
and layout tools. For example, you could use the Add button to add empty fields into 
which you can enter your own text—or to add data fields that you forgot to select in the 
Customize window. If you want a field to appear on a form more than once, select the 
field and click Copy.

We encourage you to experiment with the tools available to create your own custom 
forms. For examples of what you can achieve, visit the forms library at: 
http://community.intuit.com/library/forms.

You can download templates from the forms library to use in your own business.

Previewing new forms

Notice that the invoice form displayed by QuickBooks doesn’t show the changes you 
just made in the Layout Designer. This is because changes made in the Layout Designer 
only affect the printed invoice and not the invoice QuickBooks displays onscreen for 
data entry.
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To preview the invoice:
1 To see how the printed invoice form will look, click the Print Preview button (above 

the Template drop-down list).

QuickBooks displays the Print Preview window.

The invoice displayed in the Print Preview window shows exactly how the printed 
invoice will look. Notice that the changes you made in the Layout Designer are 
reflected in this preview.

2 When you are finished looking at the preview, click Close.

Leave the Create Invoices window open. You will use it for the next exercise.
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Customizing the design for all your forms
You can create a new design that reflects your business identity, or brand and use if for 
all your QuickBooks forms to give them a consistent professional look. 

To customize the design of your forms:
1 In the Create Invoices window, click the customize icon.

2 Click Create New Design.

A new window opens and connects to the Intuit QuickBooks Forms Customization 
web page. (Internet access is required. Additional fees, terms, and conditions apply.)

3 Follow the onscreen instructions to customize the design of your forms.
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4 In the Apply Design window, select the QuickBooks forms that you want to use your 
new design.

5 Click Apply.

6 Click OK in the confirmation screen.

7 If you want, give the design a name and click Save to save it online. Then you will be 
able to use it to customize Intuit products like checks, or to use it again for 
additional forms.

8 Close the Form Designer window.

9 Close the Create Invoices window.

Using QuickBooks Letters
From time to time, you may need to send a letter to a customer or vendor (or someone 
on your employee list or other names list), or to another list of people. With 
QuickBooks, you can easily add the pertinent QuickBooks data (such as name, address, 
and balance information) to a letter without having to re-type it.

QuickBooks provides a number of business letters focusing on collections, news, and 
announcements. You can edit these letters as needed to suit your business and style of 
communication.

Note: To proceed with this lesson, you must be using Microsoft Word 2000, 2002, 2003, 
2007, or 2010.
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Preparing collection letters

In this exercise, you’ll learn how to prepare a collection letter to send to customers with 
overdue payments.

To prepare a collection letter:
1 From the Company menu, choose Prepare Letters with Envelopes, and then choose 

Collection Letters.

2 If QuickBooks prompts you to find letters, click Copy. QuickBooks will copy the 
QuickBooks letters from your installation directory to your QBtrain folder.

QuickBooks opens the Letters and Envelopes wizard.

3 When QuickBooks prompts you to choose who you want to write to, make the 
following selections:

 For number 1, choose Active.

 For number 2, choose Customer.

 For number 3, choose 1-30 days.

Your screen should look like this.
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4 Click Next.

QuickBooks displays a list of all active customers with payments due.

5 Leave Lew Plumbing selected and click Next.

6 When QuickBooks prompts you to choose the letter you want to use, click “Friendly 
collection” and click Next.
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7 In the Name field of the next screen, type Tom Ferguson. In the Title field, type 
President.

8 Click Next.

9 If QuickBooks displays a message about missing information, click OK.

QuickBooks starts Microsoft Word (if it’s not running already) and displays the 
collection letter for the customer.

Notice that QuickBooks entered Tom Ferguson’s name and title at the end of the 
letter.
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10 Close the Microsoft Word file without saving the letter.

When you do save letters you’ve created using QuickBooks Letters, don’t save them 
to the QuickBooks Letter Templates folder. The QuickBooks Letter Templates folder 
should only be used to store the original QuickBooks Letters installed with the 
QuickBooks software program and any templates you’ve created and want to access 
through the Letters and Envelopes wizard.

To print the letter, you would choose Print from the Microsoft Word File menu.

11 Return to QuickBooks and click Cancel in the Letters and Envelopes window.

Editing QuickBooks Letters

You can make changes to individual letters using Microsoft Word, or you can make 
global changes by editing the QuickBooks Letter used to generate a specific letter.

In this exercise, you’ll edit the collection letter you prepared in the last exercise 
(Friendly collection). However, instead of working with completed letters with 
customer information already filled in, you’ll work with the underlying QuickBooks 
Letter used to create the letters.

To edit a QuickBooks Letter:
1 From the Company menu, choose Prepare Letters with Envelopes, then select 

Customize Letter Templates.

2 Click “View or Edit Existing Letter Templates.”

3 Click Next.
443



C u s t o m i z i n g  f o r m s  a n d  w r i t i n g  Q u i c k B o o k s  L e t t e r s
4 When QuickBooks prompts you to choose the letter template you want to view or 
edit, click Collection, and then select “Friendly collection” from the list of available 
letters.
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5 Click Next.

QuickBooks opens Microsoft Word (if it’s not running already) and displays the 
letter (Friendly collection) and a toolbar (QuickBooks Collection Letter Fields) that 
you’ll use to add information from QuickBooks to the letter in Word.

Note that you can move the toolbar by clicking it with your mouse pointer and 
dragging it to a new location.

Now, you’ll enter more text and use the toolbar to insert data from QuickBooks into 
the “Friendly collection” letter.

6 Click your mouse pointer after the period at the end of the first sentence and the 
press the Space bar once. (You’ll insert a sentence into the paragraph.)

7 Type Our records show that your balance is past due.

8 Click your mouse pointer after the word is in the sentence you just typed, and press 
the Space bar again.
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9 From the Insert Collection Info. Fields drop-down list on the QuickBooks 
Collection Letter Fields toolbar, select Range(days) of Overdue Invoices.

QuickBooks adds the <<OverdueRange>> field to the sentence you just typed.

When you create letters using this modified QuickBooks letter, QuickBooks will 
replace the <<OverdueRange>> field with the number of days each customer you 
create a letter for is past due.

10 From the Word File menu, choose Save As.
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11 Enter a new filename and click Save.

If you save the file to this folder without changing the filename, you will overwrite 
the original QuickBooks Letter.

12 To see how this change affects the final letter output, close the letter file in Microsoft 
Word, click Use Template in QuickBooks, and go through the wizard again (all of 
your previous choices should still be selected).

13 When you get to the “Choose a Letter Template” screen, select the name of the file 
you just saved, and then click Next.

When you’re done, your letters should resemble the following.

14 Close Microsoft Word.

15 Click Cancel in QuickBooks.
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Lesson objectives
 To set up a QuickBooks company file to use multiple currencies

 To perform a transaction using multiple currencies

Supporting materials
 PowerPoint file: Lesson 16

 Video tutorial: Working with multiple currencies

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field, type lesson 16 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Using multiple currencies with 
QuickBooks
With QuickBooks in multicurrency mode, you can track transactions in more than one 
currency. Working with multiple currencies affects many accounts and balances in 
your company file. You can assign a currency to:

 Customers

 Vendors

 Price levels

 Bank accounts

 Credit card accounts

 Accounts receivable accounts

 Accounts payable accounts

Setting up multiple currencies
To use multiple currencies in QuickBooks, you select the multicurrency preference and 
load exchange rates either manually or automatically.

Note: When working with your own company data, you should back up your company 
file before turning on this preference. The preference can't be turned off once it's been 
turned on.

To use multiple currencies in QuickBooks:
1 Go to the Edit menu and choose Preferences. 

2 Click Multiple Currencies on the left side of the Preferences window. 

3 Click the Company Preferences tab. 

4 Click Yes, I use more than one currency.

5 Click Yes in the message informing you that you cannot turn this preference off.
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6 Leave US Dollar selected for your home currency and click OK.

In most cases, the home currency is the US dollar (USD). Your home currency is the 
currency of the country where your business is physically located. 

If you choose to set a home currency other than the US dollar, Intuit services such 
as payroll and online banking will not be available as these services are only 
available in US dollars. 

Note: Some QuickBooks information—such as income and expense accounts—
always use your home currency.

7 Click OK when you are notified that the company file will close and be reopened.

8 Go to the Company menu, click Manage Currency, then choose Currency List.

This is a list of all the currencies that QuickBooks supports with an X next to the 
ones that are not being used.
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9 Click to uncheck the box next to Include inactive.

10 Click the Activities menu button and select Download Latest Exchange Rates.

11 Click OK when notified that the exchange rates were updated successfully.

You can also enter exchange rates manually. For instructions, type “enter exchange 
rates manually” in the online help Search field.

12 Close the currency list.

Buying and selling items in multiple 
currencies
This example shows some of the steps involved in buying an item from a vendor who 
uses a different currency and then selling the item to a customer who uses your home 
currency. 

Setting up a vendor who uses a different currency

You can assign one currency to each of your customers and vendors. 

Note: If you have an existing customer or vendor with transactions associated with 
them, you cannot change the currency associated with them. You should create a new 
customer or vendor instead.
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To create a new vendor and assign a currency to them:
1 Click Vendor Center in the icon bar.

2 Click New Vendor.

3 If the New Feature window for Add/Edit Multiple List Entries appears, click “Do not 
display this message in the future” and click OK.

4 Enter the following information for the vendor:

 Vendor Name: Deruta Ceramiche

 Address: Piazza dei Consoli 4, 06053 Deruta PG, Italy 

 Phone: 075-123-4567

5 In the Currency list, select Euro.

Your screen should resemble the following figure.

6 Click OK.
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7 In the Vendor Center, notice that EUR is listed next to Deruta Ceramiche.

8 Close the Vendor Center.
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Creating a purchase order in a foreign currency

To create a purchase order:
1 Click Purchase Orders on the Home page.

2 For the Vendor, choose Deruta Ceramiche.

3 Click in the Item column and type Hand-painted Tiles, then click Tab.

4 Click Yes to add Hand-painted Tiles to the Item List.

5 In the New Item window, enter the following:

 Type: Inventory Part

 Item Name/Number: Hand-painted Tiles

 Cost: 5 (in US dollars)

 Sales Price: 8 (in US dollars)

 Preferred Vendor: Deruta Ceramiche

 Income Account: Construction Materials

6 Click OK.
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7 Enter the following on the Purchase Order:

 Description: Blue hand-painted 4cm tile

 Qty: 100

 Customer: Abercrombie, Kristen Kitchen

8 Notice that the value of the purchase order appears in both dollars and Euros.

9 Click Save & Close.

Receiving inventory and entering a bill from a foreign 
vendor

To receive inventory and enter a bill:
1 On the Home page, click Receive Inventory and select Receive Inventory with Bill.

2 On the Enter Bills screen, choose Deruta Ceramiche for the Vendor.

3 Click Yes when asked if you want to receive against an open purchase order.

4 Click the column next to PO 40 and click OK.
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5 Review the Enter Bills window.

6 Click Save & Close.

Creating an invoice for a multicurrency transaction

The process for creating an invoice for a customer that includes an item from a foreign 
vendor is the same as creating a standard invoice. When you create an invoice for your 
customer, all information appears in the currency that you have assigned to them.

To create an invoice for an item from a foreign vendor:
1 Click Create Invoices.

2 For Customer: Job, select Abercrombie, Kristen: Kitchen.

3 Click Cancel to close the Available Estimates window.
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4 Enter the following information on the Invoice:

 Quantity: 100

 Item Code: Hand painted tiles

 Description: Special order tile for backsplash

5 Click Save & Close.
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Restoring the demo data file

The following demonstration is meant to be presented by the instructor with the class 
observing. It gives students an introduction to the major QuickBooks features, and lets 
them see how QuickBooks automates day-to-day bookkeeping.

Before you start the demonstration, restore the file “qblesson.qbb” in the QBtrain folder 
you set up using the instructions in the introduction to this guide.

To restore the data file:
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 Select Local Backup and click Next.

4 In the Open window, navigate to the c:\QBtrain directory you set up following the 
instructions in the introduction of the guide.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Where do you want to restore the file” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field , type demo and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

10 If you are not starting the demonstration now, exit QuickBooks.

Explain to students that later they’ll be learning how to create their own QuickBooks 
company. For most of the course, however, they’ll be using a sample file for a fictitious 
construction company called Rock Castle Construction.

Entering sales

One of a business’s primary concerns is revenue, so let’s begin with that. Suppose your 
business has made a sale and you need to invoice the customer. To do that in 
QuickBooks, you fill out an invoice that looks just like a paper form.

Creating an invoice

You can choose any QuickBooks task from the QuickBooks menu bar located on the top 
of the screen. The menu bar is organized by business areas (for example, customers, 
vendors, employees).

You can also choose tasks from the Home page. The Home page includes icons for 
common tasks.
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To create an invoice:
1 From the Customers menu, choose Create Invoices.

The Create Invoices window looks just like a paper invoice form. The upper part of 
the form is where you enter customer information; the bottom part of the form is 
where you enter the items or services you’ve sold.

You can move from field to field by pressing Tab, or you can use the mouse to point 
to the field you want, and then click the mouse button.

2 Click the drop-down list next to the Customer:Job field.

If you see this arrow next to a field, it means there’s a QuickBooks list where you can 
choose an entry.

3 Choose Kitchen under Jacobsen, Doug from the Customer list. (Press “J” to move to 
that part of the list.)

Notice how QuickBooks automatically fills in other information about the 
customer.

Point out the address and payment terms and the customer summary.

4 Press Tab three times to move to the Date Field.

QuickBooks automatically displays today’s date here (the sample data file is set up 
with December 15, 2015 as today’s date). If you want to change it, all you have to do 
is press the Plus key (+) or Minus key (-). Now change the date to December 17.

5 Press the Plus key (+) twice to display 12/17/2015.

When you’re finished, this is how the top half of the invoice should look.

Now you’re ready to fill out the bottom half of the invoice form.
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Filling in the details

The bottom part of the invoice is where you list the items the customer has purchased. 
You list each service or product you’re selling on its own line of the invoice, along with 
the amount the customer owes for each item. The lines on this part of the invoice are 
called line items, because each individual item is on its own line.

All the information about your line items is in the QuickBooks Item list. The Item list 
stores information about each service you render and each product you sell. It also 
stores information about other types of line items you’ll want to put on invoices, like 
discounts, sales taxes, and subtotals. You’ll be learning more about the Item list later in 
the course.

To fill in details:
1 Click in the Item Code column. Then click the arrow next to the field to display the 

drop-down list.

When you click in the Item Code column, QuickBooks displays a drop-down list 
where you can choose the items you want to invoice the customer for.

Suppose you’ve done nine hours of installation for Doug’s kitchen remodelling 
project.

2 Choose Installation from the drop-down list.

This item is already entered in Rock Castle Construction’s Item list, so QuickBooks 
can automatically fill in the item description and a rate ($35.00). It also knows that 
this is not a taxable item.

Point out the 0.00 for sales tax below the Amount column.

Now you just need to enter a quantity.

3 Click in the Quantity field, and type 9. Then press Tab.

When you enter the quantity, QuickBooks calculates the amount for the nine hours 
of work.

4 Click Save & Close to record the invoice.
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Viewing the customer’s register

The money owed to your business, by customers or from other sources, is your accounts 
receivable. When you fill out and save an invoice form, QuickBooks automatically 
makes an entry for you in your customer’s accounts receivable register. 

To display the register:
1 In the icon bar, click Customer Center.

2 In the customer list, right-click Jacobsen, Doug, and then choose Use Register.

The customer accounts receivable register looks similar to a paper check register. 
The register shows every transaction for this customer that affects your company’s 
receivables. The invoice you just recorded is in the register in order of its date. The 
second column shows the invoice number and the type of transaction it is (invoice). 
When you wrote the invoice, QuickBooks automatically updated the register and 
account balance.

3 Close the register and then close the Customer Center.

Receiving a customer payment

When you receive a payment from a customer for outstanding invoices, you want to 
record receipt of the payment and indicate which invoices are being paid. Suppose 
you’ve received a check in the mail from Pretell Real Estate, a customer that has several 
outstanding invoices for different jobs. This check is for the job at 155 Wilks Blvd.

To receive a payment:
1 On the Home page, click Receive Payments.

2 If a Payment Interview web browser window opens, close it.

3 From the drop-down list in the Received From field, choose the 155 Wilks Blvd. job 
under Pretell Real Estate.
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QuickBooks lists all the outstanding invoices for the job you entered.

4 In the Amount field, type 2239 and press Tab twice.

5 In the Pmt. Method drop-down list, select Check, then press Tab.

You might want to point out that QuickBooks changed the name of the Reference # 
field when you selected “Check” as the payment method.

6 Type 659 in the Check # field.

QuickBooks applies the amount to the oldest outstanding invoice, followed by the 
next oldest invoice. If you want to apply the payment differently, QuickBooks is 
flexible—you can choose to apply payments to the invoices of your choice. You’ll 
see how to do that later in the course.
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7 Click Save & Close.

When you record a customer payment, you have a choice of where to put the payment. If 
you want to deposit several payments at once, the best way to handle the deposit in 
QuickBooks is to have QuickBooks hold the payment in an account called 
“Undeposited Funds” until you deposit the payments in a bank account. The 
Undeposited Funds account is like a cash drawer. Using the Undeposited Funds account 
makes it easier to reconcile the bank account because the deposits match those made in 
at the bank.

There is a preference that allows you to set “Undeposited Funds” as the default deposit 
to account. That preference is turned on in this file. When the preference is not turned 
on, a “Deposit to” field displays in the Receive Payments and Enter Sales Receipts 
windows. This field allows you to select into which account you want to deposit the 
funds. If you are depositing a payment in a bank account by itself, you can click 
“Deposit to” and choose the bank account. Then QuickBooks records the deposit in the 
bank account automatically.

Making a deposit

When you group deposits into the Undeposited Funds account, QuickBooks keeps 
customer payments in the account until you’re ready to go to the bank. Then you just 
tell QuickBooks you’re ready to make a deposit.

To record a deposit:
1 From the Banking menu, choose Make Deposits.

The Payments to Deposit window shows all the payments you have in 
Undeposited Funds waiting to be deposited.
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2 Click Select All to place a checkmark next to all the undeposited payments.

3 Click OK

4 In the Make Deposits window, be sure you are set to record the deposit in the 
checking account, and click Save & Close.

If you click Print in the Make Deposits window before recording the deposit, 
QuickBooks prints a deposit summary that lists each payment you are depositing.

QuickBooks enters the deposit transaction in the Checking account.

You can show students the register if you have time.

Entering and paying bills

Accounts payable is the record of outstanding bills your business owes. By tracking your 
accounts payable, you’ll know exactly how much you owe and when. This is the only 
way you can get an accurate picture of your business’s finances.

Using accounts payable in QuickBooks is easy: When you’re billed for an expense, just 
enter the bill in QuickBooks when it arrives. This lets QuickBooks track the money you 
owe vendors in the accounts payable account.
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Entering a bill

Suppose you receive a bill from Sergeant Insurance for an insurance premium and want 
to enter it in QuickBooks but pay it later.

To enter a bill:
1 On the Home page, click Enter Bills.

2 In the Vendor field, type se for Sergeant Insurance and press Tab.

QuickBooks fills in the full name, using the feature called QuickFill, since Sergeant 
Insurance is the only vendor name that begins with “se.”

QuickBooks assigns a due date for the bill based on the payment terms you’ve 
entered for this vendor. If you don’t have specific payment terms assigned, 
QuickBooks assumes bills are due 10 days from the date of receipt. You can change 
the due date if you wish.

3 In the Amount Due field, enter 2000.

4 Click in the Account column of the Expenses tab, and then click the arrow to 
display the list of expense accounts.

This part of the form lets you track exactly what you spend your money on. The 
Expenses tab lets you assign the bill amount to one of your expense accounts; the 
Items tab is for entering details about service or product items you are purchasing. 
When you assign a bill to one of your expense accounts, you can later create reports 
that show how much you’ve spent in specific areas.

5 Choose Liability Insurance (under Insurance) from the list.

You can also assign expenses to a particular customer or job, in the Customer:Job 
field. This lets you keep track of your costs for a specific project.
469



I n s t r u c t o r  d e m o n s t r a t i o n  o f  Q u i c k B o o k s
6 Click Save & Close.

When you record a bill, QuickBooks automatically adds the amount due to the 
vendor’s balance.

7 In the icon bar, click Vendor Center.

QuickBooks displays the Vendor Center, which shows outstanding balances for all 
your vendors.

8 Scroll down and select Sergeant Insurance. Notice the balance is 2000.

9 Close the Vendor Center.

Using QuickBooks to remind you when to pay

QuickBooks has a reminder system that can tell you when you have transactions due. 
You can set up QuickBooks to display a Reminders window that lists the due dates for 
each transaction coming due. You can decide whether you want QuickBooks to remind 
you, and choose exactly which transactions you want to be reminded of.

Any time you want to change the behavior of QuickBooks in a particular area, you go to 
the Preferences window.

To change preferences:
1 From the Edit menu, choose Preferences.

2 Click Reminders in the left panel.

Tell students that the Preferences window is where you customize QuickBooks to 
work the way you want.

The My Preferences tab for reminders allows you to select whether to display the 
Reminders window every time you start QuickBooks.
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3 Click the Company Preferences tab.

If you share a company file with others, the company preferences are in effect for 
everyone who uses this file. The Company Preferences tab for reminders lists all the 
ways QuickBooks can remind you of transactions. For each type of reminder, 
QuickBooks can give you a detailed list of transactions due, a summary only, or not 
remind you at all.

4 Click Cancel to close the window.

Any time you want to see the Reminders window, you can choose Reminders from 
the Company menu.

5 From the Company menu, choose Reminders.

The Reminders window gives you a summary of the transactions coming due. If you 
want to see a detailed list, you can click the Expand All button.

6 In the Reminders window, click Expand All.

If you had any bills due, they would appear in the Reminders window. 

7 Close the Enter Bills window; then close the Reminders window.

You’ll explore the preferences in more detail as you go through the course.

Paying bills

When QuickBooks reminds you that bill payments are due, you can decide which bills 
you want to pay and even have QuickBooks print the checks for you.

To record a bill:
1 From the Vendors menu, choose Pay Bills.

QuickBooks displays a list of all pending bills. Just click to select the ones you want 
to pay, or click Pay All Bills to select all the bills in the window.

Suppose you want to pay by check from your Checking account.
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2 Under Payment Method, choose Check and select “To be printed.” Be sure that 
“Checking” is selected as the account under Payment Account.

3 Select the bills for Sergeant Insurance on the list. To select a bill, click the checkbox 
in the left-hand column.

QuickBooks writes the checks for you automatically. It also enters a transaction for 
them in your checking account. At the same time, it enters a transaction in your 
accounts payable register, to reduce the total of your amounts payable by the 
amount of your checks.

If you select “To be printed,” you can print the checks from QuickBooks. If you 
select “Assign check no.,” QuickBooks enters the checks in your register with 
numbers. (You can edit the numbers if they are incorrect.)
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4 Click Pay Selected Bills.

QuickBooks provides a summary of the bills you paid.

5 Click Done.

Now look at the checks QuickBooks wrote for you.

6 From the Banking menu, choose Write Checks.

7 In the Write Checks window, be sure the Checking account is in the Bank Account 
field.
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8 Click Previous to see the check dated 12/15/2015 that QuickBooks wrote to Hopkins 
Construction for $700.00. (Notice that QuickBooks wrote one check to cover both 
bills—one for $550 and $150.)

The window now says Bill Payments (Check) instead of Write Checks to indicate 
this is a check that QuickBooks wrote to pay a bill.

The lower part of the window lists the bill that this check paid.

Intuit has checks you can purchase that are made to work with QuickBooks. You can 
have QuickBooks print all your checks at once, and save yourself from writing 
checks by hand.

9 Close the Bill Payments (Check) window.
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Now, open the accounts payable register to see how the payments affect your accounts 
payable. You can open the register of any balance sheet account by starting from the 
chart of accounts.

To display the accounts payable register:
1 From the Lists menu, choose Chart of Accounts.

You could select the Accounts Payable account, click the Activities menu button at 
the bottom of the window, and then choose Use Register. But you can use another 
shortcut: Just double-click any account to open its register.

2 Double-click the Accounts Payable account.

Here’s the register with the 12/15/2015 bill payment QuickBooks entered for 
Hopkins Construction Rentals.

3 Close the Accounts Payable register and the chart of accounts.

Handling purchases you pay for on the spot

When you pay for a purchase on the spot, you don’t need to enter a bill first. You can 
write a check at the Write Checks window for a manually written check or a check you 
want to print. (You can even set up a QuickBooks “bank” account for petty cash and 
record “checks” for payments made from petty cash.)

Suppose Kershaw Computer Services sends over a technician to improve the network 
for your office, and you want to write and print a check.

To record a check:
1 From the Banking menu, choose Write Checks.

2 In the Write Checks window, be sure Checking account is in the Bank Account field.

Now, fill out the check the same way you would a paper check.

3 In the “Pay to the Order of” field, select Kershaw Computer Services.
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4 Type 253.45 as the amount, and press Tab.

QuickBooks automatically writes the amount for you on the next line.

5 Click in the Account column of the Expenses tab and assign the check to the Office 
Supplies expense account.

6 To print the check right now, click Print.

QuickBooks keeps track of two separate check numbers: the number of the last 
check you printed and the number of the last check you wrote by hand and 
recorded later. It tells you the number it expects to be the next number for a printed 
check.

If you plan to print the check later, click the “To be printed” checkbox to select it.

7 Click Save & Close to record the check and close the window.

Be sure to click Save & Close or Save & New. If you click Clear or close the window, 
QuickBooks does not record the check.

QuickBooks enters the check in the register of your checking account.

When you’ve written a handwritten check (for example, you stop at the office supply 
store and purchase a box of laser printer paper), just enter the transaction directly in the 
Write Checks window when you get back to the office.
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Managing inventory

If your business has inventory items to resell, you can use QuickBooks to keep track of 
ordering items, receiving items, paying for items, and selling items.

Ordering inventory

The first step is to order some inventory items. Now, create a purchase order for doors 
from Perry Windows & Doors.

To create a purchase order:
1 From the Vendors menu, choose Create Purchase Orders.

2 In the Vendor field, start typing pe and let QuickFill fill in the rest of the vendor 
name. Press Tab.

3 Click in the Item column and choose Interior under Wood Door from the Item list.

4 In the Qty field, type 35. Then press Tab.

QuickBooks multiplies the quantity by the cost to calculate the amount.

5 Click Save & Close to record the purchase order.
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Receiving inventory items

Receiving items is the second step. A few days after you order the doors, they are 
delivered, and you want to receive the shipment to update your inventory records (the 
amount of the item you have on hand). Suppose you’ve received the inventory items, 
but you haven’t received a bill with the items. (This is a very common occurrence.)

To record the receipt of inventory items:
1 From the Vendors menu, choose Receive Items.

2 In the Vendor field, type pe. When QuickFill completes the entry for you, press Tab.

You’ll see a message letting you know that open purchase orders exist for Perry, and 
asking if you want to receive the items against one of the outstanding purchase 
orders.

3 In the Open PO’s Exist window, click Yes.

Now you need to choose the purchase orders filled by the shipment.

QuickBooks lets you receive shipments against multiple purchase orders at one 
time. That’s important, because it’s very common for vendors to ship items from 
different purchase orders in the same shipment.

4 Select purchase order number 24 and number 40.

5 Click OK.

QuickBooks looks up the purchase orders you’ve selected and tells you which items, 
and how many, you should be receiving. All you have to do is make sure that 
everything has been shipped in the proper quantities.

Suppose you’ve received only one of the two windows.
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6 Change the 2 in the Qty field for Windows to 1.

QuickBooks keeps track of the missing window, and lets you know it is still due.

7 Click Save & Close to record the item receipt.

Receiving bills after receiving items

The third step is to deal with the final bill for the items you ordered. Perhaps two weeks 
go by, and you get the bill from Perry. QuickBooks makes it painless to reflect any 
changes that appear on the final bill. As it turns out, there’s one change you need to 
record when you pay this bill: Perry charged you $32 for shipping.
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To record a bill:
1 From the Vendors menu, choose Enter Bill for Received Items.

2 Select Perry Windows & Doors from the Vendor drop-down list, and select the 
12/15/2015 item receipt (the one you recorded today).

3 Click OK, and you’ll see the Enter Bills window with the items already filled in.

4 Click the Expenses tab and type Postage and Delivery in the Account field and press 
Tab.

5 At the message telling you that QuickBooks could not find the account, click Set Up.

6 In the Add New Account window, make sure Expense is selected and click Continue.

7 Leave the Account Name field “Postage and Delivery” and click Save & Close.

8 Enter the $32 shipping charge in the Amount field to assign it to the Postage and 
Delivery account.

9 Press Tab.
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10 Click Recalculate.

11 Click Save & Close to record the bill.

12 If QuickBooks displays a message asking if you want to change the transaction, click 
Yes.

Selling items

You can sell inventory items by creating an invoice the same way you did earlier. 
QuickBooks automatically keeps track of the items sold and updates your financial 
reports. If you sell three doors, QuickBooks automatically reduces the number of doors 
on hand by three, and adds both the revenue and the cost of goods sold associated with 
these doors to your financial reports.

Generating inventory reports

QuickBooks has a variety of inventory reports to tell you everything you might want to 
know about your inventory. Now that you’ve entered the bill, you can generate an 
inventory stock status by item report to make sure that all the items you’ve received are 
accounted for.
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To generate an inventory report:
1 From the Reports menu, choose Inventory, and then choose Inventory Stock Status 

by Item from the submenu.

For each inventory item, this report shows quantity on hand, quantity on order, 
date of next order receipt, and the average quantity sold per week.

If you want to see the transactions that make up any amount in a report, you can use 
the QuickZoom feature. Whenever you see the mouse pointer change from an 
arrow to a magnifying glass with a Z inside, double-click the amount you want to 
investigate.

2 Double-click the line for Cabinet Pulls on the report.

QuickBooks creates a QuickReport that shows more detail on that specific inventory 
item. You can also use QuickZoom from here.

3 On the QuickReport, double-click the Item Receipt transaction.

Now you see the Item Receipt recording the receipt of cabinet pulls.

4 From the Window menu, choose Close All to close all the windows you have open.
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Creating reports and graphs

The Reports menu has a wide variety of preset reports. You can customize any of the 
preset reports to show the exact data you need. To create a report, you choose the report 
you want from the QuickBooks Reports menu.

To generate a report of overdue customers and balances:
1 From the Reports menu, choose Customers & Receivables, and then choose A/R 

Aging Summary.

The report lists the jobs with open balances for each customer. The columns show 
which amounts are current (not yet due) and which are overdue. Notice that Brian 
Cook is more than 30 days overdue on his kitchen job.

2 To see whether anyone is more than 60 days overdue, change the “Through (days 
past due)” field at the top of the report from 90 to 60. Press Tab.

QuickBooks makes a column for >60. Since all the amounts in that column are 0.00, 
you can see that no one is more than 60 days overdue.

3 Close the report window.

4 Click No at the message asking if you would like to memorize the report.

If you want to see a visual display of how much you’re owed by customers, you can 
create an accounts receivable graph.

To create an accounts receivable graph:
1 From the Reports menu, choose Customers & Receivables and then choose 

Accounts Receivable Graph.

2 When you finish viewing the graph, close the graph window.
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Using the course handouts

In this section, you’ll find copies of all the handouts referenced in this course. The 
handouts are available for download in Portable Document Format (PDF) from the 
Instructors’ Resource Center. 
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Handout 1: Balance sheet accounts

The following table describes the use of each of the balance sheet account types 
available in QuickBooks.

This account type Tracks

Bank Checking, savings, and money market accounts. 
Add one bank account for every account your 
company has at a bank or other financial 
institution. (You should also use this account 
type to track petty cash.)

Accounts receivable (A/R) Transactions related to the customers who owe 
you money, including invoices, payments, 
deposits of payments, refunds, and credit 
memos. Most companies have only one A/R 
account.

Other current asset Assets likely to be converted to cash or used up 
within one year, such as notes receivable due 
within a year, prepaid expenses, and security 
deposits.

Fixed asset Long-term notes receivable and depreciable 
assets your company owns that aren’t likely to 
be converted into cash within a year, such as 
equipment or furniture.

Accounts payable (A/P) Transactions related to the vendors to whom 
you owe money, including your company’s 
outstanding bills, bill payments, and any credit 
you have with vendors.

Credit card Credit card purchases, bills, payments, and 
credits.

Current liability Liabilities scheduled to be paid within one year, 
such as sales tax, payroll taxes, accrued or 
deferred salaries, and short-term loans.

Long-term liability Liabilities such as loans or mortgages 
scheduled to be paid over periods longer than 
one year.

Equity Owner’s equity, including capital investment, 
drawings, and retained earnings.
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Handout 2: Accounts created automatically

The following is a list of the accounts that QuickBooks creates automatically.

 Accounts Receivable. QuickBooks creates this account during the EasyStep 
Interview, or the first time you create an invoice.

 Inventory Asset. When the first inventory item is created in a company data file, 
QuickBooks creates the Inventory Asset account.

 Undeposited Funds. QuickBooks adds this account to the chart of accounts the 
first time you record a payment from an invoice or a sales receipt. QuickBooks uses 
this account to hold money you’ve collected until you deposit it in a bank account. 

 Accounts Payable. QuickBooks creates this account during the EasyStep Interview, 
or the first time you enter a bill.

 Payroll Liabilities. QuickBooks adds this account to the chart of accounts 
automatically when you turn on the payroll feature in a company file. QuickBooks 
initially maps all payroll items that create liabilities to this account.

 Sales Tax Payable. QuickBooks creates this account when you turn on the sales tax 
feature.

 Opening Bal Equity. This account is created the first time you enter the opening 
balance for a balance sheet account. Every time you add a new account with an 
opening balance, QuickBooks records the second half of the entry in the Opening 
Bal Equity account. This means that total equity is the net balance of the assets 
minus the liabilities entered into QuickBooks. Once you’ve entered all of the 
accounts and balances, you may use a journal entry to allocate Opening Balance 
Equity to the proper equity accounts.

 Retained Earnings. This account is unique because there is no register associated 
with it. Each time you run a balance sheet, you assign the date of the report. 
QuickBooks then calculates the net income from all transactions from the earliest 
date in the company file to the end of the fiscal year prior to the current year. 
QuickBooks displays the results as retained earnings. Because of this feature, you 
don’t need to make the traditional closing entries at the end of the year.

 Uncategorized Income. QuickBooks creates this account the first time you enter 
an opening balance for a customer.

 COGS. When the inventory feature is turned on and the first inventory item is 
created in a company file, QuickBooks creates a Cost of Good Sold (COGS) account.

 Payroll Expenses. This account is created when you turn on payroll in a company 
data file. All payroll expense items are initially mapped to this account.

 Uncategorized Expenses. QuickBooks creates this account the first time you enter 
an opening balance for a vendor.

 Reconciliation Discrepancies. QuickBooks creates this expense account when you 
enter an adjustment to reconcile small accounting discrepancies. QuickBooks uses 
this account to track all reconciliation differences.

 Purchase Orders. QuickBooks creates this account the first time you create a 
purchase order. This is a non-posting account that does not affect your balance 
sheet or income statement.
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A P P E N D I X  B
Handout 3: Registers associated with 
QuickBooks windows

You can open the register associated with a window by choosing Use Register from the 
Edit menu when the window is displayed.

You can also open the register for any balance sheet account (except Retained Earnings) 
by double-clicking the account name in the chart of accounts.

While you have this 
window displayed...

You can display the register for this 
account...

Create Invoices Accounts Receivable

Enter Bills Accounts Payable

Write Checks The account you have displayed in the Bank Account 
field on the check form.

Receive Payments Accounts Receivable

Make Deposits The account you have displayed in the Deposit To field, 
or Undeposited Funds if that option is selected.

Enter Sales Receipts The account you have displayed in the Deposit To field.

Create Credit Memos/Refunds Accounts Receivable

Enter Credit Card Charges The account you have displayed in the Credit Card 
field.
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C o u r s e  h a n d o u t s
Handout 4: QuickBooks item types

Items for things you buy and sell

Items that calculate

Type Use to enter

Service Services you charge for or services you purchase.
EXAMPLES: Professional fees, labor

Inventory Part Items you purchase, track as inventory, and then resell.
EXAMPLES: Electrical outlets, t-shirts

Inventory Assembly
(Premier)

Items you produce or buy, track as inventory, and then resell.
EXAMPLES: Pre-assembled door kits, custom bicycles

Non-Inventory Part Items you sell but do not purchase; items you purchase but do 
not resell; items you purchase and resell, but do not track as 
inventory.
EXAMPLES: Custom-made slipcovers, pizza, office supplies

Other Charge Other charges on a sale or purchase.
EXAMPLES: Shipping charges, delivery charges

Group A group of individual items already on the item list.
EXAMPLES: A group of services and lab fees for office visits, a 
group of services and food items provided by a caterer

Type Use to 

Subtotal Calculate a subtotal before calculating a discount or charge 
that covers several items.

Discount Calculate an amount to be subtracted from the total.
(To discount several items, use a subtotal item before the 
discount item.)

Payment Record a payment received at the time of invoicing so that the 
amount owed on the invoice is reduced.

Sales tax Calculate a single sales tax for a sale.

Sales Tax Group Calculate two or more sales taxes grouped together and 
applied to the same sale.
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A P P E N D I X  B
Handout 5: Inventory workflow

The following graphic provides an overview of how to track inventory information in 
QuickBooks.
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C o u r s e  h a n d o u t s
Handout 6: Group vs. inventory assembly 
items

The following table compares group and assembly items to help you decide which item 
type is appropriate for a given situation.

Group item Inventory assembly item

Can include combinations of different item 
types, such as inventory and service items

Can contain only inventory parts or other 
inventory assembly items
To combine a service item with an 
assembly item, create a group and include 
both the assembly item and the service 
item in the group.

Allows you to print individual items 
contained in the group on sales forms

Prints only the assembly name, not 
component part names, on sales forms

No reports available specifically for groups Will appear after inventory part items on 
standard inventory reports; pending build 
report will list builds in the pending state

Quantity on hand of each item included in 
the group is adjusted in inventory at the 
time of sale

Quantity on hand of component items is 
adjusted in inventory when the assembly is 
built
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A P P E N D I X  B
Handout 7: Sales tax

The following graphic provides an overview of how to track sales tax information in 
QuickBooks.
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C o u r s e  h a n d o u t s
Handout 8: Employer payroll responsibilities

The following is a list of payroll activities for which the employer is responsible.

1 Calculate gross pay for employees.

2 Calculate federal withholding.

3 Calculate state withholding.

4 Calculate FICA.

5 Calculate Medicare.

6 Calculate federal unemployment.

7 Calculate state unemployment.

8 Add any other deductions.

9 Withhold taxes and deductions from employee’s paycheck.

10 Write a check for the net pay to the employee.

11 Submit tax reports and pay taxes to the government.

12 Pay any other withheld deductions.
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A P P E N D I X  B
Handout 9: Payroll item types

A payroll item is anything that affects the amount on a paycheck. QuickBooks has six 
types of payroll items.

The following table provides the name and description of each payroll item type.

Type Description Examples

Compensation Hourly wage, salary, bonus Straight time, salary, overtime
Sales commission, piece rate, 
tips, awards

Insurance benefits Deductions for medical 
insurance and other insurance

Health, dental, and vision 
insurance, group term life 
insurance, health savings 
account

Retirement 
benefits

Deductions for retirement plans 401(k), Simple IRA, 403(b), 
408(k)(6) SEP

Paid time off Employee time off Vacation, sick, PTO

Miscellaneous Additions and deductions Cash advance, mileage 
reimbursement, wage 
garnishment, union dues

Custom State taxes and other taxes State tax, local tax, job training 
tax
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C o u r s e  h a n d o u t s
Handout 10: List of payroll expenses 
and liabilities

Payroll expenses
 Employee’s gross pay

 Employer payroll taxes:

- Social Security (FICA)

- Federal Unemployment Insurance (FUTA)

- Medicare

- State Unemployment Insurance (SUI)—if paid by employer

- State Disability (SDI)—if paid by employer

Payroll liabilities

Taxes you’ve withheld from paychecks for the following:

 Social Security (FICA)

 Federal Unemployment Insurance (FUTA)

 Medicare

 State Unemployment Insurance (SUI)

 State Disability (SDI)

 State income tax

 Federal income tax
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1099-MISC forms 411

A
A/P. See accounts payable
A/R. See accounts receivable
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adding 66
adding subaccounts 76
adding to chart of accounts 76
asset 137, 146
credit card 137
described 60
editing 75
equity 137
liability 137, 154
pre-fill for vendors 119
purchase order 286
registers for 121, 122
transferring money between 125

accounts payable 14, 227
accounts receivable 173
accrual basis bookkeeping 33
adjusting inventory 292
assembly items 

about 295
adding labor to 298
building finished goods 303
creating 300
entering build point 302

assets
accounts, described 146
depreciation 149
described 31
fixed 157

automatic recall of transactions, turning off 118

B
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current availability of items 197
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tracking on purchase orders 204
tracking on sales orders 202

balance sheet accounts, described 66
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balances, opening 58
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batch invoice 176
bill of materials

adding labor to 299
editing 301

billing customers
using invoices 170
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bills

due 232
entering 229
inventory, entering for 290
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paying credit card 142
recording payments 235
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C
cash back, from deposits 222
cash basis bookkeeping 32
cash flow forecast reports 229
cash sales receipts

displaying 167
price levels on 186
saving in PDF 169
when to use 167

Centers
described 18
Report 249

charges, entering credit card 137
chart of accounts

adding subaccounts 76
automatically created accounts 57
described 30, 74
editing 74
purchase orders 286
setting up 57

checks
assigning to expense accounts 119
handwritten, entering 122
payroll, writing 359
preparing for nonemployee time worked 416
writing 117

clients. See customers
Collections Center 189
columns, reports 246
company

described 42
sample data file 6
setting up 43

converting units of measure 318
credit cards

entering charges 137
paying bills 142
reconciling 140
reimbursable expenses 139

credit memos
price levels on 186
saving in PDF 169

currencies, multiple 451
current assets, examples of 146
current liabilities, examples of 154
custom fields

adding to lists 93
for items 97
uses for 93

Customer Center, described 20, 78
customer types, described 66

customers
adding 61
adding new 78
described 60
down payments 214
generating statements for 168, 191
invoicing based on time 401
list of 78
opening balances 61
prepayments 214
price levels 185
taxable 326

Customers & Jobs list
described 78
expanding 102

customizing
forms 421
graphs 273, 277
invoices 421
layouts 430
lists 93
reports 252

D
debit and credit columns, viewing 34
deposits

cash back 222
handling 220
making 218
payroll taxes 367
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entering transaction 153
tracking 149
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double-entry accounting 34
down payments 214
duplicating, estimates 383

E
EasyStep Interview 43
e-mail, sales forms 81
Employee Center, described 22, 84
employees

adding 85, 355
assigning to pay schedules 354
default information for payroll 347
list of 84, 344
paying 359
payroll information for 343
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estimates
creating invoices from 385
described 375
duplicating 383
finding 382
making inactive 390
reports on 388
saving in PDF 169
status of 389
turning on 375
writing 380

exercise file 6
exiting QuickBooks 39
expense accounts

described 66
payroll 363

F
fields

adding to lists 93
custom for items 97
moving 430
order of 426
width of 434

finding, transactions 382
finished goods

building 303
effects on inventory 304
selling 305
setting up to track 299
tracking 295

fixed asset item list 157
fixed assets, described 149
foreign currencies 451
forms

changing field order 426
customizing 421
described 14, 421
displaying customized 429
e-mailing 81
sales 165
saving in PDF 169

G
GIF 423
graphic formats supported for logos 423
graphs

creating 270
customizing 273, 277
described 270
details, viewing 274
income and expense 270
types of 270

group items 295

H
handwritten checks, entering 122
help, onscreen 36
hiding

details on invoices 425
Open Window list 17

Home page
described 26
icons on 26
workflow diagram 27

I
icon bar, described 18
income accounts, described 66
income and expense, graphs 270
income statement, described 34
installing, sample data file 6
inventory

adjusting 292
bills for 290
converting units of measure 318
creating assembly items 300
current availability 197
entering products into 282
finished goods 304
parts 282
pending builds 305
receiving 288
tracking finished goods 295
using assembly items 296
using group items 295

inventory assemblies
adding labor to 298
building finished goods 303
disassembling 305
entering build point 302
pending builds 305

invoice
batch 176

invoice letters 190
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invoices 170
creating 170
creating from estimates 385
creating from sales order 196
creating from sales orders 194
customizing 421
displaying 166
entering mileage on 401
entering time on 401
price levels on 186
printing 172
progress billing 385
saving in PDF 169
saving recurring 175
templates for 169
when to use 165

item list 180
items

adding 67
assigning units of measure 317
choosing between group and assembly 295
creating 180
deleting 106
described 60, 67, 171
fixed assets 157
inventory, entering 282
making inactive 106
nonemployee 411
payroll, adding 341
received, bills for 290
receiving inventory 288
sales tax 322
service 180
showing current availability 197
tracking time 411
using inventory assembly 296

J
jobs

adding 62, 377
status of 63, 389

journal entries, viewing 34
JPEG 423
justifying accounts. See reconciling

L
labor, adding to assembly items 298
Layout Designer, described 421, 430
layouts, customizing 430
letters

editing 443
invoice 190
sample 439
writing 440

liabilities, described 31
liability accounts

adding 154
described 154

line items
creating 180
described 171
entering 171

lists
chart of accounts 74
combining 103
customers & jobs 78
customizing 93
deleting items 106
described 15, 73
employee 84, 344
inactive items on 106
items 180
managing 99
memorized transaction 176
merging items on 103
Payroll Item 342
Payroll Schedule 351
printing 109
renaming items 105
sales tax codes 325
sorting 99
vendors 89

loans
payments, recording 160
tracking 154

logos, graphic formats supported 423
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M
manufacturer’s part numbers, described 98, 283
markup, entering default percentage 296
measure sets

assigning to items 317
described 317

memorized sales, recalling 176
memorizing

reports 258
sales forms 175

menu bar, described 18
merging, list items 103
Microsoft Excel 263
mileage

entering into QuickBooks 400
transferring to invoices 401

money, transferring between accounts 125
moving, fields on forms 430
multiple currencies 451
multiple price levels 183
multiple shipping addresses 80
multiple units of measure

mode, described 309
setting up 309

N
nonemployees

paying for time worked 411
preparing checks for time worked 416
recording time worked 414

O
onscreen, help 36
open windows, managing 17
opening balance equity account 162
opening balances, entering 58
ordering products 285
other current asset accounts, setting up 147
overpayments, entering 212
owners, paying for time worked 411

P
partial payments on invoices 209
partners, paying for time worked 411
payables. See accounts payable
paychecks

printing stubs 363
writing 359

payments
down payments 214
in full, recording 207
loan 160
overpayments, entering 212
partial, entering 209
payroll taxes 366
prepayments 214
receiving 167, 207
recording bill 235
sales tax 334

payroll
depositing taxes 367
described 339
employee information 343
expenses, reports on 364
how QuickBooks calculates 340
items, adding 341
liability, reports 366
paying taxes 366
schedules, setting up 350
turning on 341
writing checks 359

Payroll center, described 19
Payroll Item list 342
payroll items, adding 342
Payroll Schedule List 351
payroll schedules

assigning to employees 354
described 350
running 359
setting up 350

pending builds in inventory 305
Portable Document Format (PDF)

saving forms in 169
saving reports in 254

preferences
described 49
estimates 375
payroll 341
progress invoicing 375
sales tax 52
setting up 49

prepayments 214
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price levels
associating with customers 185
entering new 183
on sales forms 186
using multiple 183

prices, rounding 184
printing

lists 109
paycheck stubs 363
reports 261
status stamps on forms 424

products
bills for 290
damaged 292
entering 282
ordering 285
receiving 288
samples 292

profit and loss statement, described 34
progress invoicing

described 385
preferences for 375
reports on 388

projects. See jobs
proposals. See estimates
purchase orders

creating 285
reports on 287
saving in PDF 169
tracking backorders 204

Q
QuickBooks

described 13
sample data 6

QuickReports
customizing 245
when to use 242

quitting QuickBooks 39
quotes. See estimates

R
receipt for cash sales. See cash sales receipts
receivables. See accounts receivable
reconciling

accounts 127
credit card accounts 140
described 127
locating discrepancies 131
undoing previous reconciliations 131

recording bill payments 235
registers

accounts payable 228
accounts receivable 173
bank account 121
described 16, 122
editing transactions in 122
how they work 122
opening 121
sales tax payable 333

reminder statements 191
Reminders window 232
renaming, list items 105
reorder point, described 284
Report Center 249
report columns

adding 245
moving 246

reports
balance sheet comparison 251
columns 245, 246
customizing 245, 252
described 241
details, viewing 256
estimates 388
memorizing 258
payroll expenses 364
payroll liabilities 366
preset 248
printing 261
progress invoices 388
purchase orders 287
QuickReports 242
sales 254
sales tax liability 331
sales tax revenue 333
saving in PDF 254
sending to Microsoft Excel 263
templates for 258
time by job 409
time tracking 408
types of 248

restoring company data 73
retained earnings account 162
revenue, sales tax 333
rounding prices 184
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I n d e x
S
salaries

employee 411
nonemployee 411
preparing checks 416

sales forms
choosing a format 169
described 165
filling in 169
memorizing 175
price levels on 186
recalling memorized 176
saving in PDF 169
types of 169
when to use 165

sales orders 54
creating 194
creating invoices from 196
invoicing against 194
saving in PDF 169
tracking backorders 202

sales receipts. See cash sales receipts
sales reports 254
sales tax

applying to sales 328
assigning to customers 326
code list 325
described 321
grouping 323
how QuickBooks handles 321
items, setting up 322
liability reports 331
paying 334
rates 322
register for payables 333
revenue reports 333
setting up default 325
tracking 52, 321
turning on 52
what you owe 331

sample data file
installing 6
restoring 73

service items
creating 180
creating for subcontractors or owners 411

setting up
chart of accounts 57
QuickBooks. See EasyStep Interview
your business 43

shipping addresses, multiple 80
showing Open Window list 17
single unit of measure mode, described 307
sorting lists 99
start date, choosing 56

statements 168, 191
status stamp, suppressing printing 424
stock (inventory)

entering 282
ordering 285
receiving 288
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adding to chart of accounts 76
creating 76

subcontractors, paying for time worked 411
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tax

liabilities, tracking 363
paying 366
rates, setting up 322

tax agencies
paying 334
setting up 322

templates
for sales forms 169
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sales and purchase forms 421, 422

TIFF 423
time

data, entering 396
data, viewing 410
invoicing for 401
recording employee 398
recording nonemployee 414
tracking 395

time by job report 409
time tracking

described 395
entering time data 396
invoicing customers 401
nonemployees 411, 414, 416
options for tracking 396
reports 408
turning on 395
uses for 395
using timesheets 398

Timer (Pro and Premier), using 397
timesheets

filling out 398
recording employee time on 398
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tracking
assets 146
backorders 196
bills 228
credit card transactions 137
debts 154
depreciation 149
fixed assets 157
loans 154
other expenses 147
payroll 339
payroll expenses 363
payroll liabilities 363
sales tax 52, 321
time 395

transactions
credit card 137
depreciation 153
editing in registers 122
entering past 70
historical 70
marking as cleared 128

Transactions tab, described 19
transferring money 125
turning off, automatic recall 118
turning on

payroll 341
sales tax 52
units of measure (multiple) 310
units of measure (single) 308

U
undeposited funds, account for 220
unit of measure set, described 309
units of measure

assigning to items 317
base unit 309
converting 318
described 306
measure sets 309
modes 306
on sales forms 318
setting up multiple mode 309
setting up single mode 307

unpaid bills 227

V
Vendor Center, described 21
vendor types, described 66
vendors

adding 64, 89
auto-recall expense account 119
described 60
opening balances 64

W
width of fields, changing 434
windows, viewing multiple 17
writing

checks 117
payroll checks 359
504



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




